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Note: When you use the instrument, follow generally accepted procedures for quality 
control and methods development.

If you observe a change in the retention of a particular compound, in the resolution 
between two compounds, or in peak shape, immediately determine the reason for the 
changes. Until you determine the cause of a change, do not rely on the separation results.

Note: The Installation Category (Overvoltage Category) for this instrument is Level II. The 
Level II Category pertains to equipment that receives its electrical power from a local level, 
such as an electrical wall outlet.

����
Attention: Changes or modifications to this unit not expressly approved by the party 
responsible for compliance could void the user’s authority to operate the equipment.

Important : Toute modification sur cette unité n’ayant pas été expressément approuvée 
par l’autorité responsable de la conformité à la réglementation peut annuler le droit de 
l’utilisateur à exploiter l’équipement.

Achtung: Jedwede Änderungen oder Modifikationen an dem Gerät ohne die 
ausdrückliche Genehmigung der für die ordnungsgemäße Funktionstüchtigkeit 
verantwortlichen Personen kann zum Entzug der Bedienungsbefugnis des Systems 
führen.

Avvertenza: eventuali modifiche o alterazioni apportate a questa unità e non 
espressamente approvate da un ente responsabile per la conformità annulleranno 
l’autorità dell’utente ad operare l’apparecchiatura.

Atención: cualquier cambio o modificación efectuado en esta unidad que no haya sido 
expresamente aprobado por la parte responsable del cumplimiento puede anular la 
autorización del usuario para utilizar el equipo.



Caution: Use caution when working with any polymer tubing under pressure:
• Always wear eye protection when near pressurized polymer tubing.

• Extinguish all nearby flames.

• Do not use tubing that has been severely stressed or kinked.

• Do not use nonmetallic tubing with tetrahydrofuran (THF) or concentrated nitric or 
sulfuric acids.

• Be aware that methylene chloride and dimethyl sulfoxide cause nonmetallic tubing 
to swell, which greatly reduces the rupture pressure of the tubing.

Attention : Manipulez les tubes en polymère sous pression avec precaution:
• Portez systématiquement des lunettes de protection lorsque vous vous trouvez à 

proximité de tubes en polymère pressurisés.

• Eteignez toute flamme se trouvant à proximité de l’instrument.

• Evitez d'utiliser des tubes sévèrement déformés ou endommagés.

• Evitez d'utiliser des tubes non métalliques avec du tétrahydrofurane (THF) ou de 
l'acide sulfurique ou nitrique concentré.

• Sachez que le chlorure de méthylène et le diméthylesulfoxyde entraînent le 
gonflement des tuyaux non métalliques, ce qui réduit considérablement leur 
pression de rupture.

Vorsicht: Bei der Arbeit mit Polymerschläuchen unter Druck ist besondere Vorsicht 
angebracht:

• In der Nähe von unter Druck stehenden Polymerschläuchen stets Schutzbrille 
tragen.

• Alle offenen Flammen in der Nähe löschen.

• Keine Schläuche verwenden, die stark geknickt oder überbeansprucht sind.

• Nichtmetallische Schläuche nicht für Tetrahydrofuran (THF) oder konzentrierte 
Salpeter- oder Schwefelsäure verwenden.

• Durch Methylenchlorid und Dimethylsulfoxid können nichtmetallische Schläuche 
quellen; dadurch wird der Berstdruck des Schlauches erheblich reduziert.



Attenzione: prestare attenzione durante l’utilizzo dei tubi di polimero pressurizzati:
• Indossare sempre occhiali da lavoro protettivi nei pressi di tubi di polimero 

pressurizzati.

• Estinguere ogni fonte di ignizione circostante.

• Non utilizzare tubi soggetti che hanno subito sollecitazioni eccessive o son stati 
incurvati.

• Non utilizzare tubi non metallici con tetraidrofurano (THF) o acido solforico o nitrico 
concentrato.

• Tenere presente che il cloruro di metilene e il dimetilsolfossido provocano 
rigonfiamento nei tubi non metallici, riducendo notevolmente la resistenza alla 
rottura dei tubi stessi.

Advertencia: se recomienda precaución cuando se trabaje con tubos de polímero 
sometidos a presión:

• El usuario deberá protegerse siempre los ojos cuando trabaje cerca de tubos de 
polímero sometidos a presión.

• Si hubiera alguna llama las proximidades.

• No se debe trabajar con tubos que se hayan doblado o sometido a altas 
presiones.

• Es necesario utilizar tubos de metal cuando se trabaje con tetrahidrofurano (THF) 
o ácidos nítrico o sulfúrico concentrados.

• Hay que tener en cuenta que el cloruro de metileno y el sulfóxido de dimetilo 
dilatan los tubos no metálicos, lo que reduce la presión de ruptura de los tubos.





Caution: The user shall be made aware that if the equipment is used in a manner not 
specified by the manufacturer, the protection provided by the equipment may be 
impaired.

Attention : L’utilisateur doit être informé que si le matériel est utilisé d’une façon non 
spécifiée par le fabricant, la protection assurée par le matériel risque d’être défectueuses.

Vorsicht: Der Benutzer wird darauf aufmerksam gemacht, dass bei unsachgemäßer 
Verwenddung des Gerätes unter Umständen nicht ordnungsgemäß funktionieren.

Attenzione: l’utente deve essere al corrente del fatto che, se l’apparecchiatura viene 
usta in un modo specificato dal produttore, la protezione fornita dall’apparecchiatura 
potrà essere invalidata.

Advertencia: el usuario deberá saber que si el equipo se utiliza de forma distinta a la 
especificada por el fabricante, las medidas de protección del equipo podrían ser 
insuficientes.



Caution: To protect against fire hazard, replace fuses with those of the same type and 
rating.

Attention : Remplacez toujours les fusibles par d’autres du même type et de la même 
puissance afin d’éviter tout risque d’incendie.

Vorsicht: Zum Schutz gegen Feuergefahr die Sicherungen nur mit Sicherungen des 
gleichen Typs und Nennwertes ersetzen.

Attenzione: per una buona protezione contro i rischi di incendio, sostituire i fusibili con 
altri dello stesso tipo e amperaggio.

Advertencia: sustituya los fusibles por otros del mismo tipo y características para evitar 
el riesgo de incendio.



Caution: To avoid possible electrical shock, disconnect the power cord before servicing 
the instrument.

Attention : Afin d’éviter toute possibilité de commotion électrique, débranchez le cordon 
d’alimentation de la prise avant d’effectuer la maintenance de l’instrument.

Vorsicht: Zur Vermeidung von Stromschlägen sollte das Gerät vor der Wartung vom 
Netz getrennt werden.

Attenzione: per evitare il rischio di scossa elettrica, scollegare il cavo di alimentazione 
prima di svolgere la manutenzione dello strumento.

Precaución: para evitar descargas eléctricas, desenchufe el cable de alimentación del 
instrumento antes de realizar cualquier reparación.



Commonly Used Symbols

Direct current

Courant continu

Gleichstrom

Corrente continua

Corriente continua

Alternating current

Courant alternatif

Wechselstrom

Corrente alternata

Corriente alterna

Protective conductor terminal

Borne du conducteur de protection

Schutzleiteranschluss

Terminale di conduttore con protezione

Borne del conductor de tierra



Frame or chassis terminal

Borne du cadre ou du châssis

Rahmen- oder Chassisanschluss

Terminale di struttura o telaio

Borne de la estructura o del chasis

 

Caution or refer to manual

Attention ou reportez-vous au guide

Vorsicht, oder lesen Sie das Handbuch

Prestare attenzione o fare riferimento alla guida

Actúe con precaución o consulte la guía

Caution, hot surface or high temperature

Attention, surface chaude ou température élevée

Vorsicht, heiße Oberfläche oder hohe Temperatur

Attenzione, superficie calda o elevata temperatura

Precaución, superficie caliente o temperatura elevada

Commonly Used Symbols (Continued)



Caution, risk of electric shock (high voltage)

Attention, risque de commotion électrique (haute tension)

Vorsicht, Elektroschockgefahr (Hochspannung)

Attenzione, rischio di scossa elettrica (alta tensione)

Precaución, peligro de descarga eléctrica (alta tensión)

Caution, risk of needle-stick puncture

Attention, risques de perforation de la taille d’une aiguille

Vorsicht, Gefahr einer Spritzenpunktierung

Attenzione, rischio di puntura con ago

Precaución, riesgo de punción con aguja

Caution, ultraviolet light

Attention, rayonnement ultrviolet

Vorsicht, Ultraviolettes Licht

Attenzione, luce ultravioletta

Precaución, emisiones de luz ultravioleta

Commonly Used Symbols (Continued)

UV



Fuse

Fusible

Sicherung

Fusibile

Fusible

Electrical power on

Sous tension

Netzschalter ein

Alimentazione elettrica attivata

Alimentación eléctrica conectada

Electrical power off

Hors tension

Netzschalter aus

Alimentazione elettrica disattivata

Alimentación eléctrica desconectada

Commonly Used Symbols (Continued)

1

0



United States – FCC Emissions Notes

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) this device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation.

Changes or modifications to this unit not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause 
harmful interference in which case the user will be required to correct the interference at 
his own expense.

Shielded cables must be used with this unit to ensure compliance with the Class A FCC 
limits.

Canada – Spectrum Management Emissions Notes

Cet appareil numérique de la classe A est conforme à la norme NMB-003.

This Class A digital apparatus complies with Canadian ICES-003.



Waters Alliance GPC 2000 Information

Intended Use

The Waters® Alliance® GPC 2000 Series systems are a fully integrated series of 
instruments that offers new levels of safety and performance in molecular weight 
characterization for the polymer technologist. They are designed for gel permeation 
chromatography (GPC) for use by polymer chemists who are working in R&D, QA/QC, 
technical or manufacturing support, and/or applications and methods development, and 
need to characterize the molecular weights and molecular weight distribution of polymers.

Calibration

Follow acceptable methods of calibration with pure standards to calibrate methods. Use a 
minimum of five standards to generate a standard curve. The concentration range should 
cover the entire range of quality-control samples, typical specimens, and atypical 
specimens.

Quality Control

Routinely run three quality-control samples. Quality-control samples should represent 
subnormal, normal, and above-normal levels of a compound. Ensure that quality-control 
sample results are within an acceptable range, and evaluate precision from day to day and 
run to run. Data collected when quality-control samples are out of range may not be valid. 
Do not report this data until you ensure that chromatographic system performance is 
acceptable.
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Preface

This guide provides procedures for unpacking, installing, preparing, maintaining, and 
troubleshooting the Waters® Alliance® GPC 2000 Series system. Its appendixes address 
specifications, spare parts, and solvent considerations.

This guide is for those who must install, operate, maintain, and/or troubleshoot the 
Alliance GPC 2000 Series system.

Organization

Chapter 1 describes the system, including its features, theory of system operation, and 
options.

Chapter 2 describes how to unpack and install the system and how to make tubing, signal, 
and electrical connections.

Chapter 3 describes how to start the system, prepare it for operation, prepare and run 
samples, and shut it down.

Chapter 4 describes routine and as-needed maintenance procedures for hardware and 
software components.

Chapter 5 describes troubleshooting methods and diagnostic tests, and includes 
troubleshooting tables.

Appendix A lists system specifications.

Appendix B lists required and optional spare parts that are recommended for replacement 
by the customer.

Appendix C provides solvent information.

Appendix D provides related documentation and reference material, and includes a 
procedure to contact Waters corporation.
xxiii



Documentation Conventions

The following conventions might appear in this guide:

Notes

Notes call out information that is helpful to the operator. For example:

Note: Record your result before you proceed to the next step.

Attentions

Attentions provide information about preventing damage to the system or equipment. For 
example:

Convention Usage

Italic Italic indicates information that you supply such as variables. It also 
indicates emphasis and document titles. For example, “Replace 
file_name with the actual name of your file.”

Courier Courier indicates examples of source code and system output. For 
example, “The SVRMGR> prompt appears.”

Courier Bold Courier bold indicates characters that you type or keys you press in 
examples of source code. For example, “At the LSNRCTL> prompt, 
enter set password oracle to access Oracle.”

Keys The word key refers to a computer key on the keypad or keyboard. 
Screen keys refer to the keys on the instrument located immediately 
below the screen. For example, “The A/B screen key on the 2414 
Detector displays the selected channel.”

… Three periods indicate that more of the same type of item can 
optionally follow. For example, “You can store filename1, 
filename2, … in each folder.”

> A right arrow between menu options indicates you should choose 
each option in sequence. For example, “Select File > Exit” means 
you should select File from the menu bar, then select Exit from the 
File menu.

����
Attention: To avoid damaging the detector flow cell, do not touch the flow cell 
window.
xxiv



Cautions

Cautions provide information essential to the safety of the operator. For example:

Caution: To avoid burns, turn off the lamp at least 30 minutes before removing it for 
replacement or adjustment.

Caution: To avoid electrical shock and injury, turn off the detector and unplug the 
power cord before performing maintenance procedures.

Caution: To avoid chemical or electrical hazards, observe safe laboratory practices 
when operating the system.
xxv
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Chapter 1
Introduction

The Waters® Alliance® GPC 2000 Series system is a fully integrated liquid 
chromatography system. Designed for use with many gel permeation chromatography 
(GPC) applications, the system incorporates an advanced differential refractive index (RI) 
detector, or refractometer. As the Alliance GPCV 2000 system, it also incorporates a 
multicapillary viscometry detector, or viscometer. Finally, the Alliance GPC 2000 Series 
software (version 2.0 and later) permits light scattering analysis and supports the 
PD2040-series Light Scattering Detectors of Precision Detectors, Inc.

The Alliance GPC 2000 Series system separates polymers that are detected through 
refractive index and viscometry measurements. The refractometer uses optical refraction 
to monitor the concentrations of sample components after column separation. In an 
Alliance GPCV 2000 system, the viscometer provides molecular structure information in 
addition to molecular weight values. That system also applies universal calibration 
techniques to determine branching index and frequency information as well as molecular 
weights. Light scattering data provide molecular weight values, the sample’s rayleigh ratio 
and, if you acquire more than one channel of LS data, the radius of gyration – all of which 
determine the size and shape of macromolecules. Empower™ GPC, GPCV, and LS 
software processes the data, which yield the polymers’ molecular weight distribution, in a 
single report.

The systems’ sample and analysis compartments share an integrated, 
temperature-controlled and insulated environment. Three levels of independent thermal 
monitoring ensure the system maintains a programmed temperature and initiates 
shut-down routines should malfunctions occur.

The system operates with typical GPC solvents like tetrahydrofuran (THF), toluene, 
1,2,4-trichlorobenzene (TCB), and dimethylformamide (DMF). It can also accommodate 
stronger solvents like hexafluoroisopropanol (HFIP). 

Note: Vapor sensors alert the operator to a potentially problematic increase in vapor 
levels within the analysis and sample compartments.
1



Figure 1-1  Alliance GPC 2000 Series System (Front View)

Figure 1-1 shows a full-face view of an Alliance GPC 2000 Series system.

Table 1-1 describes the system’s major components. 

Table 1-1  Major System Components

Component Description

Solvent manage-
ment system

Degasses, selects, and filters solvent. The system manages 
solvents isocratically.

Sample manage-
ment system

Preheats, mix/spins, and filter/injects samples. An internal wash 
station washes the needle, eliminating sample carryover.

Columns A diverse selection of Styragel (polystyrene divinylbenzene) 
columns for organic-soluble polymers, HSPgel columns for 
high-speed GPC analysis, or water and Ultrahydrogel (hydroxy-
lated methacrylate) columns for aqueous-soluble polymers can be 
installed. Column lengths range from 150 mm up to 500 mm; 
widths range from 4.6 mm-ID (narrow bore) to 6.0 mm (high 
speed) to 7.8 mm-ID (regular bore).

Status LEDs

Syringe 
Compartment

Sample Compartment
Door Light

Sample
Compartment

Solvent
Compartment

Electrical
Connector

Analysis Compartment
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1.1  Solvent Management System

The solvent management system includes all components that degas and pump solvent 
(Figure 1-2).

Figure 1-2  Components of the Solvent Manager in the Solvent Compartment

Detectors The systems each incorporate a differential refractometer. The 
GPCV 2000 system in addition includes the patented multicapil-
lary viscometer.

System software • The Microsoft Windows 2000 operating system allows 
networking capabilities.

• The system software controls all system components, runs 
sample sets, and acquires data.

• Empower software with GPC, GPC/V, or GPCV-LS processing 
options allow data processing and report generation.

Table 1-1  Major System Components (Continued)

Component Description

Solvent Select
Valve

Degasser

Accumulator Piston
Chamber

Inlet Check
Valves

Primary Piston
Chamber

Solvent Inline Filter

Door
Solvent Compartment

Purge Valve
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Components

Table 1-2 describes functions of the solvent management system’s major components.

Table 1-2  Solvent Management System Components

Component Function

Primary piston chamber Draws solvent, transferring it to the accumulator piston as 
part of the serial flow design.

Accumulator piston 
chamber

Draws solvent from the primary piston and delivers it to 
the solvent inline filter.

Purge valve Allows purging, priming, and venting of the solvent 
management system via a priming syringe.

Solvent inline filter Filters the solvent that flows from the solvent manage-
ment system to the analysis compartment.

Solvent select valve Selects the choice of solvent specifying it in the Instru-
ment Method Editor’s Solvent Manager page from 
reservoir A or B. Available choices are based on the 
solvents listed in the Instrument Configuration Editor’s 
Mobile Phase A and Mobile Phase B pages.

Inline vacuum degasser Removes dissolved gasses from the solvents and exhausts 
them and any condensates through waste tubing. Selec-
tion of solvent degassing is user programmable.

Primary inlet check valve Maintains flow direction into the primary piston chamber 
by opening in one direction only (opens on the piston 
intake stroke; closes on the delivery stroke).

Accumulator inlet check 
valve

Maintains flow direction into the accumulator piston 
chamber by opening in one direction only (opens on the 
piston intake stroke; closes on the delivery stroke).

Primary transducer Detects and produces a signal proportional to the back-
pressure developed by resistance to solvent flow in the 
primary piston chamber.

System transducer Detects and produces a signal proportional to the back-
pressure developed by resistance to solvent flow in the 
system.
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Piston Seal-Wash System (Optional)

The seal-wash system lubricates and washes the seals of the primary and accumulator 
pistons. It flushes away solvents or precipitated salts that slip by the piston seal from the 
high-pressure side of each piston chamber. As the solvent management system delivers 
mobile phase, the seal-wash pump intermittently delivers seal-wash solvent according to a 
programmable time interval.

The seal-wash solvent flows from the wash reservoir to the wash pump, which forces it to 
a cavity behind the piston seal in the primary piston chamber. From there it flows to the 
cavity behind the piston seal in the accumulator piston chamber and, finally, to a waste 
container.

The piston seal wash system, installed by a Waters field engineer, includes a reservoir, 
pump, seal-wash body, and tubing. To connect the reservoir and tubing, see Section 2.3.4. 
To activate the wash, see Section 3.2.1. For details, see “Mobile Phase A Tab” or “Mobile 
Phase B Tab” in the Alliance GPC 2000 Series System Help.

Solvent Flow Path

Figure 1-3 shows solvent flow through the system.
Solvent Management System 5



Figure 1-3  Solvent Flow Path

The following sequence references Figure 1-3: 

1. The programmable inline solvent degasser applies a vacuum to Solvents A and B.

2. Solvent flows through an inlet check valve and then to the solvent manager’s 
primary piston chamber. Simultaneously, the accumulator piston forces solvent to 
the system pressure transducer (Figure 1-4).
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Figure 1-4  Solvent Flow Path Through the Solvent Manager

3. Seconds before the accumulator piston chamber empties, the primary piston 
compresses solvent to the pressure sensed by the pressure transducer.

4. When the accumulator piston chamber empties, the primary piston forces solvent to 
the primary pressure transducer. From there it flows through the check valve and 
into the accumulator piston chamber. The cycle then repeats, beginning at step 2.

5. The system pressure transducer measures the system pressure, comparing it with the 
primary pressure. It then adjusts the primary pressure to equal the system pressure.

6. Solvent continues from the system pressure transducer through the purge valve and 
solvent inline filter.

1.2  Sample Management System

The sample management system includes a removable sample carousel housed in a 
thermally controlled compartment and components that control sample, mixing, heating, 
filtering, and injection.

Solvent Inline Filter

System Pressure
Transducer

Primary Pressure
Transducer

Accumulator
Piston

Inlet Check Valve 

Purge Valve
Solvent

Inlet Check Valve

Primary
Piston
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Components

Table 1-3 lists and describes the function of the sample management system’s major 
components.

Sample Flow Path

The following sequence describes the route the sample follows through the system: 

1. Sample loading and preparation – Sample vials are loaded into the carousel’s sample 
compartment. The carousel rotates clockwise as the system surveys its contents. 
Each vial moves, in turn, to the mix/spin station and then to the filter/inject station. 
The instrument method controls the mixing and filtering operation (Figure 1-5).

2. Sample withdrawal and aspiration – The injection valve switches to the load 
position. With the vial at the filter/inject station, the needle poises above it, pierces 
its septum, and lowers inside it. The syringe plunger retracts, drawing sample into 
the loop and the storing extra sample in the overfill loop so that the sample overfills 
the sample loop without entering the syringe. The system can make multiple 
injections per vial, depending on the sample loop and vial sizes (Figure 1-5).

Table 1-3  Sample Management System Components

Component Function

Carousel Holds and advances sample vials clockwise, toward the 
mix/spin and filter/inject stations.

Sample needle and 
filter ram

Lowers the needle into the sample vial, the filter ram pushing 
on the sample filter vial to filter the sample. The needle pierces 
the cap seal and draws sample from the vial.

Wash station Washes the needle by forcing solvent through and around it.

Syringe Draws solvent from a reservoir or sample from a vial. When it 
draws from a reservoir, the sample loop is offline. The syringe 
then dispenses solvent to the needle (during a wash cycle) or to 
the solvent dispenser.

When the syringe draws sample from a vial, the loop is inline 
and receives the sample.

Vent Needle Allows air to replace solvent.

Injection valve Holds the sample and introduces it to the columns.

Sample loop Holds a fixed volume of sample to inject into the flow path.

Bypass valve 
(optional)

Depends on plumbing connections. Typically used to bypass 
the light scattering detector.
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Figure 1-5  Filling the Sample Loop

3. Sample injection – The injection valve switches to the inject position. Solvent from 
the injector preheater loop flows into injection valve port 3 and out port 4, picking 
up sample and depositing it onto the column. After the final injection, excess sample 
returns to the vial or the wash station (Figure 1-6) depending what you specify in the 
Instrument Method.

Tubing Description Specifications
T1 Waste manifold to viscometer 0.8 clear tubing
T2 Viscometer to RI detector 0.009 (green* from RI) and 0.040 (yellow* to viscometer)
T3 Sample Inject 0.012 (black) and 0.009 (green*)
T4 Sample out 0.012 (yellow*)
T5 Reference in 0.02 (blue*)
T6 Reference out 0.04 (red*)
T7 RI purge valve to waste manifold 0.04 (red*)
T8 Solvent inlet 0.125 Tefzel
T9 Intercolumn 0.014 (blue*) teflon
T10 Preheater sample loop to injection 0.009 (green*)
T11 From port 6 inject to needle wash 0.02 (yellow*)
T12 Solvent select valve 0.04 (red*)
T13 Column to injection valve 0.2 (green*) teflon

*Indicates that tubing is sleeved with a color coded covering.
Note: To replace the T3,T9, and T13 tubing, use the GPC high molecular weight tubing kit (700002468).
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Figure 1-6  Injecting the Sample

4. Separation – The sample flows from the injection valve through the column set, 
directly to the detectors.

5. Detection – The sample flows through the refractometer and the viscometer 
(Alliance GPCV 2000 system only). From there it passes through the waste 
manifold, exiting the system. 

6. Needle wash – When the run time for the final injection from a vial has elapsed, the 
needle returns to the wash station. While there, solvent washes its internal and 
external surfaces and then flows to a waste container. The syringe returns to the 
home position when the wash sequence ends.
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1.3  Columns

Column types are Styragel, for organic-soluble polymers, Ultrahydrogel for 
aqueous-soluble polymers, and HSPgel for high-speed GPC analysis of organic- or 
aqueous-soluble polymers.

The column rack, in the analysis compartment, can accommodate up to six 300-mm 
columns or three 500-mm columns of up to 7.8-mm ID. The compartment’s high efficacy 
heaters maintain stable temperatures. You can program a limit for the rate of temperature 
increase in the compartment to ensure column integrity.

Styragel Columns

For organic GPC separations, three types of Styragel columns are available (see 
Table B-3):

• Styragel HMW (20-µm particle size) – Use with shear-sensitive, ultra-high 
molecular weight polymer samples at temperatures between ambient and 180 °C. 
High-porosity, 10-µm frits accompany these columns.

• Styragel HT (10-µm particle size) – Use with mid-molecular to high-molecular 
weight samples at temperatures between ambient and 180 °C.

• Styragel HR (5-µm particle size) – Use with low-molecular to mid-molecular 
weight samples. These columns afford high resolution at temperatures between 
ambient and 80 °C.

Ultrahydrogel Columns

Use 300 mm × 7.8 mm ID columns for aqueous GPC separations. These include 
Ultrahydrogel 120, 250, 500, 1000, 2000, linear, and DP columns, which perform with up 
to 20% organic solvent. Use them with a pH range from 2 through 12 and at temperatures 
between ambient and 80 °C (Table B-4).

HSPgel Columns

Use HSPgel columns for high-speed GPC analysis (see Table B-5). They are 150 mm × 
6.0 mm ID (Table B-5) and are packed in THF, ODCB, or water. Table B-5. The HT series 

����
Attention: Use LS-compatible or preconditioned column(s) for optimal 
results in LS or viscometry. This minimizes detector contamination by 
particulates that manifest themselves as signal noise.
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columns may be used for temperatures up to 180 °C and can withstand multiple solvent 
switches.

1.4  Differential Refractometer

The differential refractive index (RI) detector, or refractometer, uses optical refraction to 
detect sample components in the post-column solvent flow. The Alliance GPC control 
software collects the RI data, and the Empower software performs molecular weight 
analyses. 

The refractometer, set in the analysis compartment, comprises these components:

• A 10–µL flow cell with sample side and reference side

• Long-life, pulsed, light-emitting diode (LED) light source 

• Collimating lens

• Mirror

• Dual-element photodiode

• Purge valve, which protects the flow cell by opening when pressure exceeds 35 psi 
(2.4 bar)

• User-programmable autozero and purge capabilities

1.4.1  Optical Refraction and RI Measurement

The extent to which a solution refracts light is its refractive index (RI), the ratio of light 
velocity in a vacuum to light velocity in a solution. A physical property of the solution, the 
RI is expressed by the dimensionless value n.

Light passes through the refractometer as follows (Figure 1-7):

1. The aperture and collimating lens focus light from the LED, forming a beam.

2. The beam passes through the sample and reference sides of the flow cell to the 
mirror.

3. The mirror reflects the light beam through both sides of the flow cell, through the 
collimating lens and, finally, onto the dual-element photodiode. The difference in 
the amount of light striking each element of the photodiode (because of sample 
refraction) results in a deflection from the chromatogram’s baseline. 
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Figure 1-7  Light Path Through the Refractometer

The RI depends on how fast light travels through a solution, a constant rate at a specific 
temperature and pressure. Density also affects RI, and the density-RI relation is not 
necessarily linear at a given wavelength, temperature, and pressure. The refractometer 
exploits the solution’s physical characteristics by maintaining a constant wavelength, 
temperature, and pressure so that only changes in density can cause changes in RI. Thus 
the higher the concentration of sample in a solution, the greater the change in the its RI. 
The refractometer detects even slight changes in RI by comparing a sample solution with a 
reference solution. It then expresses the difference in RI (∆ n) as refractive index units 
(RIU).

1.4.2  Flow Path During Normal Operation

Two fused, hollow, quartz prisms, each with an inlet and outlet, compose the 
refractometer’s flow cell. During an analysis, solvent flows through the cell’s sample side. 
The reference side, which holds pure solvent supplied during the purge operation, remains 
sealed during normal operation. Thus the reference solvent is stationary.
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High Temperature Area Temperature Controlled Area
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Figure 1-8  Flow Paths Through Refractometer Flow Cell

The following sequence refers to Figure 1-8:

1. Solvent flows through the sample side of the flow cell.

Note: In Alliance GPCV 2000 systems, solvent flows from the flow cell to the 
viscometer. In Alliance GPC 2000 systems, solvent flows from the flow cells to 
waste. 

2. Refraction of light in the flow cell’s sample solution alters the proportion of light 
that strikes each of the two photodiodes. This causes the photodiode signal to differ 
from the reference signal, which results from refraction in pure solvent.

3. The photodiode signal creates an output voltage that shows n as a deflection from 
the chromatogram’s baseline.

Note: Deflections, or peaks, can be positive or negative.

1.4.3  Flow Path During Purging 

When the refractometer is purged, the purge/vent valve opens, allowing solvent to flow 
from the sample side of the flow cell to the reference side and then to waste (Figure 1-8).

The purge/vent valve opens automatically when the pressure exceeds 35 psi (2.4 bar). This 
protects the refractometer flow cell and viscometer from pressure damage.

See Table A-8 for detailed refractometer specifications.
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1.5  Multicapillary Viscometer

The multicapillary viscometry detector, or viscometer, provides viscometry data for 
calculating molecular weight distributions, viscosity law plots, and branching information 
(index and frequency). See Table A-9 for viscometer specifications. 

The viscometer comprises these elements:

• Three capillaries

• Two differential pressure transducers

• Two delay volumes

Viscometer types are named for their flow paths: sense-line and flow-through.

1.5.1  Sense Line Viscometer Flow Paths

In the sense-line type, flow from the refractometer enters the viscometer and splits into 
two paths (Figure 1-9): 

• In one path, solution flows through the first capillary to the first delay volume. It 
then flows through the third capillary and, finally, to waste.

• In the other path, solution flows through a second delay volume to the second 
capillary and then to a waste vessel.
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Figure 1-9  Viscometer Flow Path, Sense Line Type

The first and second transducers measure pressures in the first and second capillaries and 
other fluidic elements. The first and second purge valves (normally closed) allow purging 
of their associated transducers.

For each capillary, the drop in pressure is proportional to the solution’s flow rate and 
viscosity. Poiseuille’s law states pressure (P) is the product of a constant (R), the viscosity 
(η), and the flow rate (Q) thus

P = R × η × Q

where R = capillary length (L), pressure (P), and radius (r) according to the equation

R = (8 × L) / (P × r4)

Pressure signals from the viscometer are sent to the Alliance GPCV 2000 Series system 
software, which calculates the relative viscosity and relative flow of the solution.
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1.5.2  Flow-Through Viscometer Flow Paths

Flow enters the flow-through viscometer (Figure 1-10) and splits into two paths:

• In one path, the solvent flows through the first capillary, through the first transducer, 
to the first delay volume, through the third capillary, and finally to waste.

• In the other path, solvent flows from the first transducer to the second delay volume. 
It then goes to the second transducer, second capillary, and back to the second 
transducer before exiting to a waste vessel.

The first transducer measures pressure in the first capillary and in its associated plumbing. 
The second tranducer measures pressure in the second capillary. The flow-through design 
requires no purge valves.

Figure 1-10  Viscometer Flow Path, Flow-Through Type

+
-

To Waste

Third Capillary

First Delay Volume

First Transducer

First Capillary

Second Delay Volume

Second Capillary

Second Transducer
Multicapillary Viscometer 17



1.6  Alliance GPC 2000 Software 

The system software controls all system hardware components, runs sample sets, and 
acquires data. Empower software with the GPC and/or GPCV options process the data and 
report results. 

The system software runs on the following hardware:

• Onboard, PC-based central processor; color monitor, keyboard, and mouse

• Built-in disk drive for 3.5-in. disks

• Built-in CD R/W drive

• Onboard I/O card for configuring electrical inputs and outputs

• Onboard USB port

• Onboard Ethernet connection

• Onboard video and audio drivers

• Onboard serial card for controlling external PD2040 Series light scattering detector.

For details about the system software, see “Alliance GPC 2000 Series System Overview” 
in the Alliance GPC 2000 Series System Help. 

1.6.1  User Interface

Specify information in the Main, Editor, and Status windows to control the system, 
configure and troubleshoot it, and monitor its operation.

Main Windows

The Alliance GPC 2000 Series window appears in four modes: Interactive, Sample Set, 
Carousel, and Diagnostic, which allow access to functions and system information.

Table 1-4 describes the functions of buttons in the button bar of the four main windows.

Table 1-4  Interactive Mode Buttons in the Button Bar

Button Name Function

Interactive Mode Prepares the system and shows dual plots. 
(Figure 1-11).

Sample Set Mode Runs sample sets, showing dual plots 
(Figure 1-12).
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Carousel Mode Runs sample sets, graphically showing run 
progress (Figure 1-13).

Diagnostics Mode Displays a fluidic schematic and lets you 
monitor the operating status of system 
components (Figure 1-14).

Viewer Displays Analytical Instruments Associa-
tion (AIA) files as graphs in a separate 
window (Figure 1-21).

Sample Set Method Editor Defines and edits sample set methods.

Instrument Configuration 
Editor

Defines and edits instrument configuration.

Sample Set Mover Moves sample sets from local control soft-
ware to the Empower database.

Message Board Opens the Message Board to display a list 
of system messages (Figure 1-19).

Log Book Tells you accumulated run time and shows 
maintenance and repair entries. 

Help Activates context-sensitive Help.

(Emergency) Stops all solvent flow.

Table 1-4  Interactive Mode Buttons in the Button Bar (Continued)

Button Name Function
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Interactive Mode Window

This window lets you define instrument setup, configuration, and equilibration. It also 
allows access to other modes in which you define, run, and view sample sets, monitor 
carousel operation, and monitor instrument diagnostics (Figure 1-11). 

Figure 1-11  Interactive Mode Window (new screen shot)

For Interactive mode details, see “Alliance GPC 2000 Series Window” in the Alliance 
GPC 2000 Series System Help. Also see these subtopics:

• “Procedures and Reference in Setting Up the Alliance GPC 2000 Series System”

• “Running the System in Interactive Mode” 
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Mode 

Functions
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Sample Set Mode Window

Figure 1-12  Sample Set Mode Window

This window lets you to define, run, and view sample sets (Figure 1-12). For details, see 
these topics in the Alliance GPC 2000 Series System Help:

• “Sample Set Method and Sample Set Overview”

• “Sample Set”

• “Sample Set Mode” 

Also see “Procedures” and “Reference,” which appear as subtopics under “Acquiring a 
Sample Set.” 

Sample Set Mode Button
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Operations Buttons

Sample Set Method Table
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Carousel Mode Window

Figure 1-13  Carousel Mode Window

This window lets you define, run, verify, and monitor sample set status for samples on the 
carousel (Figure 1-13). Sample positions are color-coded. 

For details, see “Carousel View” in the Alliance GPC 2000 Series System Help. 
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Diagnostics Mode Window

This window lets you determine the current status of system components, monitor 
diagnostics, and access maintenance wizards (Figure 1-14). For details, see “Alliance 
GPC 2000 Series System Diagnostics Mode” in the Alliance GPC 2000 Series System 
Help.

Figure 1-14  Diagnostics Mode Window

The major system components appear in the Diagnostics Mode window as four 
areas (clockwise from upper left): Solvent Management, Sample Management, 
Detection, and Columns.
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Service Diagnostics

Diagnostics Mode Button
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Most areas contain a warning LED, status text, and one or more real-time numeric 
displays. The More button in each area allows access to diagnostic LEDs for the 
section components.

The Diagnostics button opens the User Maintenance and Service Diagnostics dialog 
box (Figure 1-15), which allows access to three maintenance wizards and a 
diagnostic test. Waters field service engineers also access Service Diagnostics from 
this dialog box. 

Figure 1-15  User Maintenance and Service Diagnostics Dialog Box

Editor Windows

The Instrument Configuration Editor window, the Instrument Method Editor window, and 
the Sample Set Method Editor window let you define and edit system parameters.

Instrument Configuration Editor Window

This window lets you define and edit the instrument configuration. It includes the seven 
tabs (Figure 1-16) described in Section 3.2. For details, see “Defining Instrument 
Configuration Parameters” in the Alliance GPC 2000 Series System Help. 

Figure 1-16  Instrument Configuration Editor Tabs
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Instrument Method Editor Window

This window lets you define and edit instrument methods. It includes five tabs 
(Figure 1-17), which are described in Section 3.3. For details, see these topics in the 
Alliance GPC 2000 Series System Help:

• “Creating/Modifying an Instrument Method for Interactive Mode Operation” 

• “Creating/Modifying an Instrument Method for Sample Set Mode”

Figure 1-17  Instrument Method Editor Tabs

Sample Set Method Editor Window

This window (Figure 1-18) lets you edit the sample set methods explained in Section 3.7. 
For details, see “Sample Set Method Editor” in the Alliance GPC 2000 Series System 
Help. 

Figure 1-18  Sample Set Method Editor Window
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Status Windows

The Message Board, Status, and Viewer windows provide status information.

Message Board Window

This window displays messages describing significant system events (Figure 1-19). The 
messages, which constitute information, warning, and error alerts, appear in chronological 
order. For details, see “GPC 2000 Message Board” in the Alliance GPC 2000 Series 
System Help. 

Figure 1-19  Message Board Window
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Status Window 

This window lets you monitor the current system and injection status (Figure 1-20). To 
open it, select View > Status Window from one of the four main window modes.

 

Figure 1-20  Status Window

Viewer Window

Use the Viewer to display and compare acquired channels of data for one or more previous 
injections (AIA files). For details on using the Viewer, see “Viewer,” “Viewer Menus,” 
“Viewer Toolbar,” and “Alliance GPC 2000 Series Data File Extensions” in the Alliance 
GPC 2000 Series System Help.

To display chromatograms and data channels

1. Select Tools > Viewer to open the Viewer window (Figure 1-21).
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Figure 1-21  Viewer Window with Two Data Channels

2. Click  (Overlay Mode) if you want to display up to eight data channels or 
chromatograms at one time, each in a different color. 

Note: You can also overlay AIA data channels in Empower. 

3. Click  (Percent Full Scale) if you want to display different types of data on one 
vertical axis with values from 0 to 100%.

4. Select File > Open.

5. Select a chromatogram or data channel to display in the Viewer.

6. Repeat steps 2 through 5 for each chromatogram and data channel you want to 
display.

7. Compare the plots and look for unexpected changes and/or differences.

8. If you need to gather more information, see Section 5.1.2, Checking the Message 
Board and Logs.
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9. Depending on your findings, you can perform diagnostics tests for noise and drift 
(Section 5.2.1) and/or temperature control (Section 5.2.2), investigate baselines (see 
Section 5.3) or peaks (Section 5.4), and/or consult troubleshooting tables to solve 
hardware-based problems (Section 5.5 to Section 5.8).

1.6.2  Data Management Options

The Alliance GPC control software collects data from the detector(s). You can send the 
data to these places:

• Empower GPC, GPCV, or GPC/V-LS (for processing and reporting)

• To a third-party data system (for processing and reporting) via the I/O card

You can use the Viewer button to display a sample set’s chromatograms after it is 
complete.

Using Empower GPC or GPCV Software

Waters Empower GPC, GPCV, and GPCV-LS software options add GPC, GPCV, and 
GPCV-LS acquisition and processing capabilities to the base liquid chromatography 
software.

GPC software includes these capabilities:

• Sample Loading – Lets you define narrow standards, broad standards, and 
unknowns.

• Component Loading – Lets you specify these items:

– Molecular weight.

– Molecular weight averages.

– Cumulative percent-molecular weight pairs.

– Mark-Houwink (k and alpha) values for standards and unknowns.

– Named distributions for standards.

– Component names for system suitability.

• Calibration Options – Lets you specify narrow standards, broad standards, or 
combined narrow/broad standards.

• Calibration Techniques – Lets you specify relative or universal (Benoit’s protocol) 
calibration.

• Calibration Curve Fit Types – Lets you specify 1st-, 2nd-, 3rd-, 4th-, or 5th-order, 
bounded, cubic-spline, and point-to-point curve-fitting techniques.
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• Review and Compare Tools – Lets you specify these actions:

– Display calibration curves and molecular weight distributions.

– Compare calibration curves from multiple runs.

– Compare molecular weight distributions from multiple runs.

• Axial Dispersion Correction – Corrects for band-broadening during separations. 
This is especially helpful with large-particle (20-µm) columns.

GPCV software offers all the capabilites of GPC software plus these:

• Channel Set – Lets you combine the refractometer and viscometer data channels 
into a one-channel set that yields a single result.

• Sample Loading – Lets you define these parameters for each sample vial:

– Concentrations (for standards and unknowns) 

– RI sensitivity

• Component Loading – Lets you define concentrations and dn/dc values for 
standards and unknowns.

• GPCV Calibration Technique – Lets you apply Benoit’s protocol to perform a 
universal calibration.

• GPCV Processing Options – Lets you specify an intrinsic viscosity curve fit for the 
observed viscosity data. Zimm-Stockmayer fit types calculate the branching 
frequency of branched polymers. You can also calculate the viscosity law plot 
(log(n) vs. log MW) and the branching index (g') curve.

• Viscosity law plot – Lets you display these as plots:

– Theoretical linear viscosity law (extrapolated or manually entered k and alpha).

– Observed viscosity.

– Fitted viscosity (polynominal or modified Zimm-Stockmeyer fit).

– Branching index (g').

– Molecular weight distribution.

– Cumulative area percent.

• Branching Index (g') – Lets you perform these functions:

– Calculate a sample’s long- and short-chain branching index (g'LCB and g'SCB).

– Display the g' value at each slice in the distribution and for each molecular 
weight average.

– Display the overall g' value of the polymer.
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– Plot the theoretical linear viscosity (extrapolated or manually entered K and 
alpha) used to calculate g'.

• Branching Frequency and Probabilities – Lets you calculate the branching 
probability (λ) for long-chain branching and the number of branches per 1000 
carbon atoms in the polymer chain (B).

• Compare – Lets you overlay the calibration curves of multiple runs with their 
corresponding viscosity plots and molecular weight distributions with Viscosity 
Law plots. 

• Reporting – Lets you overlay the two channels of data, plot the viscosity law plot, 
and overlay the viscosity plots with a distribution for an unknown sample. 

Use the Empower Light Scattering software option in addition to either Empower GPC or 
Empower GPCV software to process GPC-LS or GPCV-LS (triple detection) data into a 
single result:

• Light Scattering – Lets you display these plots:

– Conformation plot.

– Calibration plot.

– LS data plot.

• Branching Index (g) – Lets you perform these functions:

– Calculate a sample’s long-chain and short-chain branching index (gLCB and 
gSCB).

– Display the g value at each point in the distribution and for each average 
molecular weight.

– Display the overall g value of the polymer.

– Plot the theoretical linear conformation plot (extrapolated or manually entered k 
and alpha) and fitted Rg used to calculate g.

Empower software allows scale-up from an Empower Personal system to corporate-wide, 
large-scale, multi-user client/server systems. Empower Enterprise systems use distributed 
acquisition and processing technologies to distribute the workload to all computers in the 
client/server system. For details, see these topics in the Alliance GPC 2000 Series System 
Help:

• “Empower Software Overview”

• “Empower GPC, GPCV, and LS Overview”
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Using the I/O Card

The I/O card provides these signal input and output connections to data systems and 
equipment that Empower does not control:

• Two user-programmable event inputs.

• Two user-programmable event outputs.

• Four analog outputs (channels 1 through 4) with voltages proportional to a variety 
of internally measured parameters.

Consult Section 2.4.5 when connecting other devices and Section 3.3 to configure the I/O 
card. See “I/O Card” in the Alliance GPC 2000 Series System Help for details. 

1.7  Temperature Control

The system maintains each of these areas at different temperatures (Figure 1-22):

• Analysis compartment (contains columns, detectors, and injection valve) – Ambient 
plus 5 °C (up to 180 °C). 

• Sample compartment (contains the carousel, injection valve, sample preheat station, 
mix/spin station, and filter/inject station) – Ambient plus 5 °C (up to 180 °C). 

Caution: To avoid burn injuries, allow enough time for the system to cool before you 
perform maintenance or troubleshooting procedures. Also, wear protective clothing 
whenever you open the sample or analysis compartment.
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Figure 1-22  System Control in Each Compartment

For details, see these topics in the Alliance GPC 2000 Series System Help:

• “Temperature Control”

• “Temperature Shutdown Limit”

These things affect temperature control: 

• Compartment and system insulation to keep external surfaces safe to touch.

• Temperature limits that solvent characteristics influence. 

• Automatic shutdown protocol: When a compartment’s temperature exceeds the 
high-temperature limit, the system software does the following:

– Shuts down the compartment

– Ramps down the solvent management system

– Activates the red status indicator

• A ventilation system that draws air from vents on the front and right sides, and 
exhausts the air out the top and rear ports. 

Analysis 
Compartment 

Small Air Flow, Closed Compartment; 
Up to 180 °C; Vapor Sensor

Syringe Compartment
Air Flow and Venting;
Ambient Temperature

Sample 
Compartment

Venting;
Up to 180 °C;
Vapor Sensor
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The system embodies three levels of overheat protection based on temperature limits that 
you set in the software and fixed limit thermal fuses:

• Level 1 – The software uses these limits to discern whether temperatures exceed the 
allowed settings.

• Level 2 – An independent hardware system monitors these limits during initial 
setup, normal operation, and system failures.

• Level 3 – Fixed-limit thermal fuses (for example, a thermal fuse in the column area 
or a thermal fuse in the SMS area) that open at temperatures above approximately 
250 °C and shut down the heaters.

For additional ventilation control, you can place the system in a fume hood. The monitor, 
keyboard, and mouse can be located up to 5 feet (1.5 meters) from the system with the 
cables provided in the startup kit. You can use longer cables to install the workstation 
farther from the system. 

1.8  Safety Features

Vapor Detection and Venting

Vapor sensors monitor vapor levels in three areas:

• Detector compartment 

• Sample management (carousel) compartment 

• Ambient air space in the lab 

The sensors compare vapor levels to those at startup or initialization. Vapor detection is 
programmable. If vapor levels inside the system exceed the programmed shutdown limit, 
the red LED lights, and the system shuts down. (You can program the system to alert you 
during these events.) For details, see “Vapor Sensors” in the Alliance GPC 2000 Series 
System Help. 

You should determine shutdown limits experimentally at each installation by introducing 
small amounts of the solvent to generate a signal that indicates acceptable limits. Too low 
a limit can induce false triggering; too high a limit can defeat leak detection. Test vapor 
sensors regularly to ensure limits are working properly and replace them when necessary. 
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Spill Control and Waste Fluids

Waste fluids drain to a waste container placed below the level of the system.

• Drip trays provide spill control for all compartments. Fluid drains through a waste 
port on the left side of the system to a waste container (Chapter 5, Troubleshooting 
the System). 

• Waste solvents from detectors exit the system through a waste port on the upper-left 
side. 

• Waste solvents from the needle wash apparatus exit the system through a waste port 
on the lower-left side. 
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Chapter 2
Installing the System

2.1  Installation Site Requirements

Choose a location for your system that meets the specifications in Table 2-1.

Table 2-1  Installation Site Requirements

Factor Requirement

Ambient temperature 10 to 32 °C (50 to 90 °F) 

Room temperature variation Less than 1.5 °C/hr. (long term) or 0.25 °C/min (short 
term) for best results.

Relative humidity 20 to 80%, noncondensing 

Bench space: 

Main system without 
monitor and keyboard

User interface (monitor, 
keyboard, and mouse)

Width – 37 in. (94 cm)
Depth – 22 in. (56 cm)
Height – 24 in. (61 cm) 

Width – 24 in. (61 cm) 

Clearances for ventilation, 
cable connections, opening 
doors, and service

Rear – approximately 0.5 in. (1 cm)
Front – approximately 16 in. (41 cm)
Left side – approximately 16 in. (41 cm)
Right side – approximately 6 in. (15 cm)
Top – at least 9 in. (23 cm)

Ventilation Access to a large fume hood or to a 4-in. (10-cm) 
exhaust vent with 4 to 8 m/sec air flow (70 to 140 feet3 
per minute or 2 to 4 meters3 per minute); no exposure 
to direct sunlight, other sources of heating, or air 
conditioning vents. If needed, an optional hookup kit, 
part number 200000120, comprising a 10-foot length 
of 4-inch diameter exhaust hose with a sliding, adjust-
able flow dampener and clamps is available.
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2.2  Unpacking, Inspecting, and Setting Up

The major components and their associated parts arrive in three cartons: one for the 
monitor, one for a GPC column, and one for the following items:

• Alliance GPC 2000 system or Alliance GPCV 2000 system with pre-installed 
software

Block instrument support Five round instrument support blocks 3 (height) x 3 in. 
(diameter).

Bench top Stable, flat, clean surface; level or slightly tilted (up to 
2°) toward the front and left (for proper drainage of 
the drip trays); capable of supporting 400 lb. (181 kg); 
with wheels if possible.

Aluminum feet The startup kit contains five aluminum feet (3 in. in 
diameter and height) to position underneath the Alli-
ance GPC 2000. Place the feet on the bench top in an 
X pattern.

Power requirements Two grounded power outlets on separate circuits: one 
for the main system, the other for the monitor. A dedi-
cated electrical circuit is recommended for this 
instrument. The monitor and any additional devices 
such as printers or light scattering detectors should 
draws current from another circuit (or circuits that all 
share a common ground).

The main system outlet must provide 10 A at 
240 VAC and 50/60 Hz. The monitor outlet must 
provide 120 or 240 VAC and 50/60 Hz. The light scat-
tering detector requires 120 VAC and a grounded 
power outlet.

Electromagnetic fields No nearby source of electromagnetic noise such as 
arcing relays or electric motors

Static electricity Negligible

Vibration Negligible

Table 2-1  Installation Site Requirements (Continued)

Factor Requirement
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• Startup Kit

– Mouse 

– Keyboard 

– Power cord

– Windows 2000 software and documentation 

– Empower software and documentation 

– Alliance GPC 2000 Series system software and documentation

Required Materials

• Phillips screwdriver, medium

• Slotted screwdriver

• Open-end wrench, 5/16-in.

• Scissors or knife

• Tubing cutter (for stainless steel tubing)

• Heat-protective gloves and safety goggles

• Spirit level

• Small container for fluids

• Flashlight (optional)

• Flowmeter (when installed on a bench top)

Procedure

1. Inspect the shipping containers for damage or evidence of mishandling. If you 
observe damage, see the accompanying document, Waters Licenses, Warranties, 
and Support, for instructions on reporting it.

2. Remove the outer container:

a. Cut and remove the straps.

b. Open the top of the carton, and remove the Startup and Accessories Kits from the 
inner box.

����
Attention: To prevent damage and preserve access, do not place any items 
on top of the system.
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c. Remove the inner box and foam packing, and then lift the corrugated outer shell 
from the system.

d. Remove the four pieces of wood (with two bolts each) that surround the bottom 
of the system.

e. Use a pallet jack to move the system to the installation site. The system, which is 
less than 28 in. (70 cm) deep, fits through most doorways.

Note: Be careful not to damage the recessed waste ports on the left side. 

f. Remove the plastic wrap. 

3. Verify that the serial number matches that on the Certificate of Validation in the 
Startup Kit. Find the serial number in one of two places: 

• Near the power switch, on the right panel

• Inside the sample compartment, at the lower-left rear corner

Note: Retain the Certificate of Validation for future reference. 

4. Prepare to install the system at either well-ventilated location:

• In a fume hood – The five aluminum blocks that accompany the system raise its 
height by 3 in. 

• On a bench top with access to an external exhaust vent – See step 6. You will 
need the Ventilation Option Kit (see Table B-7).

5. Remove the five aluminum feet from the startup kit. Arrange four of them on the 
bench top so that they each receive one of the system’s four corners. Set the fifth 
foot precisely in the center of the rectangle formed by the other feet. 

Note: The system is 22 in. (56 cm) deep and 37 in. (94 cm) wide.

Caution: To avoid solvent vapors exposure, install the system inside a 
suitable fume hood, or vent it mechanically, ensuring a draw rate of 4 - 8 
meters per second (70 to 140 feet3 per minute or 2 to 4 meters3 per minute). 
If needed, an optional hookup kit, part number 200000120, comprising a 
10-foot length of 4-inch diameter exhaust hose with a sliding, adjustable flow 
dampener and clamps is available.

Ascertain the requirements for venting solvent vapors in your local building 
and health codes.

Caution: To avoid personal injury and system damage, at least four people 
should lift the system from the pallet using the four, slide-out, lift bars stored 
beneath it. The empty system weighs about 365 lb. (166 kg).
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6. With four people on the four lift bars (two in front and two at the rear), lift the 
system from the upper skid, and carefully set it in its final location.

7. If the system is on a bench top, connect it to an exhaust vent (Figure 2-1):

a. If available, connect the vent gate (from the Ventilation Option Kit) to a 4-in. 
(10-cm) diameter exhaust vent (see Table B-7). 

Figure 2-1  Connecting the Vent Gate

b. Connect one end of the exhaust hose to the vent gate. Secure it with a clamp. 

c. Connect the other end of the exhaust hose to the vent adapter (top-left rear corner 
of the system). Secure it with a clamp (Figure 2-2). 

����
Attention: To provide for proper drainage of solvents and waste, the system 
must be level or inclined to the front and left (however, no greater than 2o).

Vent Gate (Open)

Exhaust Hose

Exhaust Vent

Clamp
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Figure 2-2  Connecting to an Exhaust Vent

8. If the system is in a fume hood, ensure the hood’s air flow is sufficient to draw any 
vapors the system’s operation might produce.

9. Contact a Waters field service engineer to perform the required service installation 
tasks. 

2.3  Connecting Flow System Components

Installing the system involves connecting these flow system components: 

• Solvent reservoir (see Section 2.3.1)

• Waste container (see Section 2.3.2)

• Columns (see Section 2.3.3)

• Piston seal wash (optional; see Section 2.3.4)

Clamp

Exhaust Hose

Vent Adapter
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• Syringe (see Section 4.5.3)

• Sample loop (see Section 4.5.4)

2.3.1  Connecting the Solvent Reservoir

Required Materials 

• Solvent tubing with filters (startup kit):

• Solvent reservoir and its cap

• HPLC-grade solvents, prefiltered through a 0.5-µm filter membrane

• 0.5-µm filters and filtration apparatus

• Phillips screwdriver, medium

• Magnetic stirbar and stir plate (optional)

• Reserve solvent bottle (optional)

• Solvent safety trays

Procedure

1. Connect tubing from the left side of the system to the reservoir as follows 
(Figure 2-3):

• Solvent A tubing (yellow) and solvent C tubing (red) to solvent reservoir A.

• Solvent B tubing (blue) and solvent D tubing (green) to solvent reservoir B. 

Note: The tubing that enters the top-left side connects internally to the isolation 
valves, and that which enters the lower left connects internally to the degasser. The 
colors refer to identification sleeves at the end of the tubing.

����
Attention: To prevent damaging the system, as well as permit physical access to it, do 
not place any items on the system components.
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Figure 2-3  Connecting Solvent Reservoirs to the System

Note: Be sure to filter solvents and cover them afterward (see Appendix C). 

Note: The solvents must be higher than the solvent management system (pump). 
For THF and less viscous solvents (chloroform, methylene chloride), set the bottles 
on top of the instrument or on a jack 18 inches higher than the solvent management 
system. Place aqueous buffers on a jack 12 to 18 inches higher than the solvent 
management system; the height depends upon the solvent used. Waters 
recommends the use of solvent safety trays which are not depicted in Figure 2-3. 

2. Fill solvent reservoirs with prefiltered HPLC-grade solvents.

3. Insert the free end of each solvent inlet line through a hole in the reservoir cap. 
Connect the solvent filter to the end of each solvent line. The filters should descend 
to the reservoir bottoms

4. Install reservoir caps on the reservoirs.

5. When a solvent serves many samples, you can continually replenish its reservoir by 
connecting a reserve bottle to it (Figure 2-3). When you add fresh solvent to the 
reserve bottle, the solvent is slowly siphoned into the solvent supply bottle. This 
allows any differences in solvent composition to be gradually introduced into the 
solvent supply, ensuring a stable RI baseline. 

a. Install solvent tubing from the bottom of a large reserve solvent bottle to the 
solvent reservoir. 

Stir plate

Reserve Bottle Solvent
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b. Use a priming syringe to remove all air bubbles from the tubing and thus start a 
free solvent flow from the reserve bottle to the solvent reservoir. 

c. Ensure all connections are airtight. 

d. Set the solvent reservoir on a stir plate. With a magnetic stirrer and stirring bar, 
gently and continuously mix the solvent. 

e. Place all solvents in safety trays.

6. After installing all parts, configure the mobile phase (see Section 3.4.6). For details, 
see “Mobile Phase A or B” in the Alliance GPC 2000 Series System Help.

2.3.2  Installing a Waste Container 

Required Materials 

• Startup kit:

– Waste tubing, 0.25 in. ID × 60 in. (3) 

– Hose clamps (6)

• Waste container (6L to 8L) with solvent-compatible and sample-compatible covers

• Phillips screwdriver, medium

• Tape measure

• Small pliers

Caution:  Ensure electrical power is off, and avoid touching electronic components.
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Procedure

1. Place the waste container below the system, in a well-vented space (Figure 2-4). 

Figure 2-4  Installing the Waste Container 

2. Remove the six screws from the left panel, and then remove the panel (Figure 2-5).

TP01690

Detector Waste 
Port

Needle Wash 
Waste Port

Drip Tray 
Waste Port

Waste Container in Tray
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Figure 2-5  Removing the Left Panel

3. Place a spring clamp on the straight end of each length of tubing. Use a small pair of 
pliers to open the clamps.

4. Remove the protective cap from each waste port.

5. Connect a piece of tubing to each waste port, and secure it with a clamp. Insert the 
free ends of the tubing through the waste container cap.

6. If the waste container is not in a fume hood, connect a piece of tubing from the 
waste container cap to an exhaust vent. 

7. Reinstall the left panel without pinching tubing or cables. Place the waste tubing 
through the slots in the left panel. 

8. Fit the top edge of the side panel under the top panel. Secure it with the six screws.

9. Tighten the waste container cap. 

10. Arrange the ends of the tubing against the inside wall of the waste container to 
facilitate drainage and eliminate dripping. 

2.3.3  Installing Columns

Note: One column is shipped with the system; however, you can install as many as six. 

For information on the kinds of columns available for the system, see Section 1.3 and 
Table B-3 and Table B-4. Refer to the Styragel Column Care and Use Manual for details 
on Styragel columns. Refer to the Ultrahydrogel Column Care and Use Manual for details 
on Ultrahydrogel columns. Refer to the HSPgel Columns for High Speed GPC Analysis 
Column Care and Use manual for details on the HSPgel columns.

Solvent 
A

Solvent 
B

Needle Wash 
Waste Port

Detector 
Waste 
Port

Screws

A (Yellow)

A (Red)

B (Blue)

B (Green)

Pump Inject

Needle Wash
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Required Materials 

• Columns for your applications (see Appendix B)

Note: One column, Styragel HT6E packed in toluene (part number WAT044218), 
and a stainless steel intercolumn tube are shipped with the system. 

• Startup kit (includes ferrules, compression screws, and stainless intercolumn steel 
tubing, 0.009 in. ID × 10 ft. (3.0 m)

• Open-end wrenches, 5/16-in. and 5/8-in.

Procedure

1. Arrange the column(s) on a bench top so that directional arrows point in the 
direction of solvent flow. 

2. When assembling two or more types of columns, arrange them in order of 
decreasing pore size.

Note: Remove and save the column end-plugs for future use.

3. Connect the columns with the U-shaped intercolumn tubing, ferrules, and 
compression screws (see Figure 1-5, the T9 connection.)

4. Open the analysis compartment door by sliding the latch to the left, and then lift the 
door from its bottom edge with gloved hands (Figure 2-6).

����
Attention: To prevent column damage, use extreme care whenever you change any 
system parameter, including temperature, pressure, flow rate, solvent type, and/or 
solvent concentration.

Caution: To avoid injury from burns, allow the system enough time to cool before you 
perform maintenance or troubleshooting procedures. Wear protective clothing whenever 
you open the sample or analysis compartment.

����
Attention: If the analysis compartment is warmed, allow it to cool before you install or 
replace a column unless your applications require high temperatures. 

If the system is fitted with columns, see Section 4.6 for details on how to prepare it.
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Figure 2-6  Opening the Analysis Compartment Door

5. Place the bank of columns on the left and right column holders (Figure 2-7).

Figure 2-7  Installing the Columns in the Analysis Compartment

6. Connect the tubing from port 2 of the injection valve to the inlet of the first column 
(Figure 2-8).

TP01682

To open and 
unlock, slide 
the latch to 
the left.

To close and lock, slide 
latch to the right.

Latch on Analysis 

Compartment Door

TP01655Left 
Column 
Holder

Right 
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Figure 2-8  Connecting the Columns to the Injection Valve

7. Connect the tubing from the refractometer inlet to last column in the series’ outlet 
(Figure 2-8).

8. Close and lock the analysis compartment door, pushing the latch to the right.

9. After installing the hardware, identify the columns by labeling them in the software 
(see Section 3.2.4). For details, see “Columns” in the Alliance GPC 2000 Series 
System Help. 

10. Equilibrate the system until the baseline stabilizes (see Section 3.6.1). Choose the 
maximum ramp rate, 0.2 mL/min/min. 

����
Attention: To prevent column damage, start the system carefully. Maintain a solvent flow 
rate of 0.2 mL/min or less until the specified operating temperature is reached. 

5

4

3
2

6

1

 Bypass Valve

Injection Valve To Columns
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Preheater

To Needle

To Syringe
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2.3.4  Connecting the Piston Seal Wash (Optional) 

If you use strong organic solvents like DMF with salts, or buffered aqueous ones at 
ambient temperature, Waters suggests you also use the piston seal wash. The seal wash 
extends the life of the piston seal by lubricating the piston and flushing away solvent or 
precipitated salts. 

To connect the piston seal wash, follow the instructions in the Seal Wash Option Kit (see 
Appendix B). Figure 2-9 shows the seal-wash flow path. 

Figure 2-9  Flow of the Piston Seal Wash

After you install the hardware, configure the seal wash (see Section 3.2.1). For details, see 
“Mobile Phase A or B” in the Alliance GPC 2000 Series System Help. 

2.4  Connecting Signal Wires to External Devices

The system requires digital signal connections to a monitor, keyboard, and mouse. 
Optional connections include these:

• A printer (Section 2.4.2)

• A serial card (Section 2.4.3)

• A network (via an Ethernet network cable) (Section 2.4.4)

• An I/O card in the communication panel (Section 2.4.5)

����
Attention: To avoid damaging the system, use a seal-wash solvent that mixes with your 
mobile phase, one that is also compatible with the seal-wash seals (see Table C-2). 

To prevent immiscibility and/or precipitation when switching between mobile phases, use 
an intermediate solvent that mixes with both mobile phases (see Appendix C).

Seal-
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InletPrimary 
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 To Waste
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Figure 2-10 outlines the steps that making signal connections to the system can involve.

Figure 2-10  Making Signal Connections

You can install the monitor, keyboard, and mouse as far as 5 ft. (1.5 m) from the system 
with the cables in the Startup Kit. Use longer cables for greater distances. The monitor 
requires a separate AC power outlet.

����
Attention: Waters recommends you install on the onboard CPU only the software it 
supplies. Installation of other software can cause your system to operate improperly.
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2.4.1  Connecting the Monitor, Keyboard, and Mouse

1. Unpack the monitor, and place it in its permanent position.

2. Open the solvent compartment door to access the communication panel.

3. Connect the monitor cable to the communication panel’s 15-pin connector 
(Figure 2-11).

Figure 2-11  Connecting to the Communication Panel

4. Connect the monitor’s power cord to an AC outlet.

5. Connect the keyboard cable to the keyboard connector (Figure 2-11). 

6. Connect the mouse cable to the mouse connector (Figure 2-11). 

����
Attention: To avoid electrical shock, shut down the system, and disconnect its power 
cord before you perform the following procedures.

Mouse Connector
Keyboard Connector
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Printer

Monitor Connector

I/O Card

Inner Power Button

CD R/W Drive (E:)

Floppy
Disk Drive (A:)

USB Connector 

Serial Card
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2.4.2  Connecting a Printer

Required Materials

• Printer

• Printer cable

• Printer power cord

• Windows 2000 printer driver for the model of the printer 

Procedure

1. Connect one end of the printer cable to the printer. 

2. Open the solvent compartment door, and connect the other end of the printer cable 
to the communication panel’s printer (Figure 2-11). 

3. Connect one end of the power cord to the printer and the other end to a grounded 
power outlet.

4. To configure the printer, see the Windows 2000 Help and the manufacturer’s 
documentation. Configure the printer in the Printer Setup dialog box (open it from 
the File menu in the Windows 2000 software). You can install the printer icon in the 
Windows 2000 Control Panel.

2.4.3  Connecting to a Serial Device

To connect to the serial device, use a RS-232 cable to connect the optional 
Waters-approved device to the serial port on the serial card (Figure 2-11). 

2.4.4  Connecting to a Network

Required Material 

Ethernet cable

Procedure

1. Open the solvent compartment door. 

2. Connect an Ethernet cable from your network to the communication panel’s RJ45 
network port (Figure 2-11). 

3. Close the solvent compartment door. Avoid pinching the cables.

Note: To configure communication from GPC 2000 to an Empower Enterprise, refer to the 
GPC 2000 Software Installation Instructions.
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2.4.5  Connecting to the I/O Card

The I/O card contains these signal channels: 

• Four for analog output (see Section 2.4.5.1)

• Two for event input (see Section 2.4.5.2)

• Two for event output (see Section 2.4.5.3)

For a description of each I/O card port, see Table A-10.

Required Materials

• Four I/O cables (Startup Kit)

• I/O screwdriver (Startup Kit)

To configure software to recognize the I/O connections, see Section 3.2.6, Configuring the 
I/O Card.

2.4.5.1  Sending Analog Output Signals

The system can send up to four analog output signals, including refractometer and 
viscometer data, and LS to another data system or to a chart recorder using I/O card 
channels 1, 2, 3, and/or 4. It can also send signals that represent these operating 
parameters:

• Flow rate

• Pressure

• Temperature

• Vapor sensor readings 

1. Connect one end of an I/O cable to these pins on the I/O card (Figure 2-12):

• Analog Out (+) 

• Analog Out (Ground)

Note: If you use a shielded cable, connect the shield wire to the grounding clip 
located on the front of the computer. 
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Figure 2-12  Analog Out Signal Connections on the I/O Card

2. Follow the other system manufacturer’s instructions to connect the opposite end of 
the I/O cable to that system’s data acquisition board. 

3. Repeat steps 1 and 2 for each output signal you send. 

4. To configure the signals, see Section 3.2.6. Select the analog channels that 
correspond to the pin connectors (Analog Out 1 to 4) on the I/O card. 

2.4.5.2  Receiving Event Input Signals 

The system can receive up to two event input signals through the I/O card, regardless of 
which data system you connect it to. External events trigger the input signals used for 
starting events, like an injection sequence or stopping solvent flow. 

Note: You must configure I/O card inputs.

1. Connect one end of an I/O cable to the I/O card’s Event In pin and one of its Event 
In ground pins (Figure 2-13). 
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Figure 2-13  Event Input Signal Connections on the I/O Card

2. Connect the output device to the I/O card according to its manufacturer’s 
instructions.

3. Repeat steps 1 and 2 for a second Event In signal, if any.

4. Select the event controls that correspond to the pin connectors (Event In 1 + or 2 +) 
on I/O card. See Section 3.2.6 to configure the signals.

2.4.5.3  Sending Event Output Signals 

The system can send one or two event output signals through the I/O card, regardless of its 
associated data system.

Note: You must configure I/O card outputs.

1. Connect one end of an I/O cable to an event output pin and chassis ground pin on 
the I/O card (Figure 2-14). 
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Figure 2-14  Event Output Signal Connections on the I/O Card

2. Connect the I/O cable’s other end to the device receiving the signal. Follow the 
device manufacturer’s instructions.

3. Repeat steps 1 and 2 for a second event, if needed.

4. Select the event outputs that correspond to the pin connectors (Event Output 1 or 2) 
on the I/O card. To configure the signals, see Section 3.2.6.

2.5  Connecting to the Electrical Power Supply 

Required Material

Power cord

Note: The startup kit contains two power supply cables: one rated for north American use, 
the other for international use, and both can be used with 100–240 VAC. Install the cable 
prescribed for use in your geographic location. Keep in mind that the instrument is rated 
up to 20 amps and requires a non fluctuating input voltage of 100–240 VAC. To address 
this need, Waters recommends a dedicated circuit, receptacle, and line conditioner or 
uninterruptible power supply (UPS). The cords are not equipped with plugs, because 
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receptacle configurations vary. After selecting the correct cable to install, fit it with a plug 
that matches your receptacle’s configuration. (The startup kit does not contain plugs.)

Procedure

Refer to Figure 2-15.

1. Ensure the on/off switch on the right side panel is Off (O).

2. Insert one end of the power cord into the connector on the right panel. 

3. Insert the opposite end into a grounded power outlet. The GPCV2000 instrument 
power input is rated for 100-240 VAC, 50/60 Hz, and 20 A. 

Figure 2-15  Connecting the Power Cord

����
Attention: A dedicated electrical circuit is recommended for this instrument. 
The monitor and any additional devices such as printers or light scattering 
detectors should draws current from another circuit (or circuits that all share 
a common ground). The GPCV2000 instrument, and any peripheral devices 
or instruments connected to it, must be connected to a properly grounded 
power outlet. The ground connection in all these outlets must be the same, 
and connect to a common point near the service panel and the system. 
Finally, consider using a line conditioner or an uninterruptible power supply 
(UPS) for optimum long-term input voltage stability.

Power Switch

Power Cord Connector

On (I)

Off (O)

AC Power Cord
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Chapter 3
Preparing for Operation

This chapter details how to prepare the system for operation, how to run a sample set, and 
how to shut down the system. 

Figure 3-1 summarizes the tasks involved in operating the system.

Figure 3-1  Operating the System
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Note: System heating and equilibration requires considerable time. You should therefore 
complete all preparations such as hardware and solvent changes, software configurations, 
and maintenance tasks before letting the system warm to desired operational 
temperatures. 

3.1  Starting the System

1. Start all peripheral devices, including the monitor and the PD Light Scattering 
detector, if purchased. 

Note: If the LS detector was on before you powered on the GPC 2000 instrument, 
power off the LS detector for 30 seconds, and then power it back on to re-initialize 
the LS detector.

2. Start the system by setting the power switch to I (On).

Note: If the computer does not automatically start, open the solvent compartment 
door, press and release the inner power button on the communication panel, and 
then close the door.

The status LEDs on the front panel flash, showing current system condition 
(Table 3-1). The instrument requires several minutes to initialize. It signals 
completion when the LEDs stop flashing. 

Table 3-1  Status LEDs

LED Description System Condition Action

Top, Red, Flashing Starting. Or a system-level 
fault exists and the system is 
in shut-down mode.

Troubleshoot (Chapter 5).

Middle, Yellow, 
Steady

Starting. Or has not yet 
reached specified conditions.

Allow enough time for the 
system to start. If the condi-
tion persists, begin 
troubleshooting (Chapter 5).

Bottom, Green, Steady Conditions specified in the 
startup method reached. 

Ready for operation. 

All Flashing Starting. Wait until one LED lights.

All LEDs Off Shut down. Start and wait until one LED 
lights.
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3. When the Log On dialog box appears, simultaneously press the Control, Alt, and 
Delete keys to log in to the Windows 2000 operating system.

4. Enter your user name and password. The default account name is “Administrator,” 
and the password is “gpc2000,” these confer administrator privileges, and then click 
OK.

Note: Passwords are case sensitive.

5. Wait for the status LEDs to stop flashing, indicating that initialization is complete. 

6. The user interface starts, and the Alliance GPC 2000 Series Login window appears 
(Figure 3-2). 

Figure 3-2  Alliance GPC 2000 Series Login Window

If the Alliance GPC 2000 Series Login window fails to appear after a few 
minutes, select Start > Programs > GPC2000 > Chromatography > GPC2000 
Console. 

When connecting to a remote Alliance GPC 2000 Series system, enter the name of 
the GPC 2000 node you want to connect to or Browse to locate a specific system. 
When operating the system as a standalone system, leave this field blank (normal 
operation).

Note: You can create a desktop shortcut to start the Console Login window.
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7. Click OK.

When startup is complete, the Message Board appears and minimizes. Then the Interactive 
Mode window appears (Figure 3-3). The status indicator (lower right) shows the current 
system status, reproducing the function of the status LED on the front panel. If a problem 
occurs, or if the status indicator is red, see Chapter 5. 

For details, see the “Starting Up the Alliance GPC 2000 Series System” in the 
Alliance GPC 2000 Series System Help. 

Figure 3-3  Interactive Mode Window

3.2  Setting Up and Configuring the System

Setting up and configuring the system entails specifying parameters for basic operation. 

Note: See Windows 2000 documentation for tasks involving initial setup and configuration 
settings in Windows 2000 software.

 Interactive 
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Interactive 
Mode 
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Specify generic settings. These reflect how you use the system and determine how it 
operates:

1. If you connected a printer to the system, install its driver. Then refer to the Windows 
2000 Help, and the printer manufacturer’s documentation to configure the printer. 

2. If you connected the system to an Ethernet network, set the Ethernet port. 

3. Specify these parameters in the Instrument Configuration Editor dialog box. Click 
OK to close the dialog box.

• Mobile phase (Section 3.2.1)

• Temperature ramp rate (Section 3.2.2)

• Injector (Section 3.2.3)

• Columns (Section 3.2.4)

• Detector (Section 3.2.5)

• I/O card (Section 3.2.6)

3.2.1  Configuring the Mobile Phases

See Section 3.4 to prepare the flow path. See Appendix C and also “Mobile Phase A Tab” 
in the Alliance GPC 2000 Series System Help for solvent information. 

Configuring Mobile Phase A

1. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3).

2. Select Setup > Instrument Configuration. The Instrument Configuration Editor 
dialog box appears, displaying the Mobile Phase A page (Figure 3-4).
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Figure 3-4  Mobile Phase Page

3. Select the Reservoir A’s solvent from the Solvent list, noting its suggested operating 
range, boiling point, and recommended temperature shutdown limits. 

4. Specify the ramp rate and the maximum operating flow rate:

a. Select Limit Ramp Rate to control the rate of flow increase.

b. Select a Ramp Rate value from 0.05 to 1.00 mL/min/min. (default = 1.00 
mL/min/min).

c. Specify the maximum flow rate by entering an Operating Max Flow rate 
(mL/min). 

Note: Flow should not saturate columns or viscometer pressure transducers. 
Waters suggests a flow rate value of no greater than 1.5 mL/min (1.0 mL/min is a 
typical flow rate for most analytical GPC columns). Nevertheless, you may specify a 
greater flow rate. For viscous solvents with a flow rate of 0.5 mL/min, the pressure 
relief valve may open earlier. If it does, it will divert part of the flow stream through 
the reference side of the RI detector.

Caution: Whenever you select Other from the Solvent list, record the 
solvent, its operating range, and its boiling point. 
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5. Specify the Stop Flow method:

a. Select Immediately when you want solvent flow to stop simultaneously with 
entering the Stop Flow command. This is the default setting.

b. Select With Ramp when you want solvent flow to decrease at the ramp rate 
specified when you enter a Stop Flow command. 

6. Specify Pressure Shutdown Limits: 

a. Enter the High Pressure, from 100 to 5000 psi. Default = 2000 psi.

b. Enter the Low Pressure, from 0 to 4900 psi. Default = 0 psi. If you specify 0 as 
the default limit, the system does not monitor for low-pressure occurrence. The 
recommended value is 50 psi.

7. Select solvent options. See Appendix C for the options that apply to your solvent.

a. Select Degasser to vacuum-degas the solvent. 

b. If the seal-wash option is installed, select Seal Wash to wash the piston seals. 

Note: The seal-wash option must be installed and connected to a seal-wash 
reservoir. See Section 2.3.4.

8. Continue with Section 3.2.2, or click OK to save the changes.

3.2.2  Limiting the Temperature Ramp Rate

You can limit the rate of temperature increase in the analysis compartment (Temperature 
Ramp Rate Limit).

1. Click the Temperature Control tab in the Instrument Configuration Editor to open 
the Temperature Control page. 

2. Select Enable Temperature Ramp Rate Limit to limit the rate of temperature 
increase in the analysis compartment.

3. In the Temperature Ramp Rate list, select a temperature ramp rate limit from 0.25 to 
5.00 oC/min. No default setting. 

����
Attention:  Excessively high flows can damage columns. The appropriate 
flow rate depends on solvent viscosity and temperature. 

Caution: To avoid damaging columns because the flow pressure exceeds 
their design limits, specify a shutdown limit when using viscous solvents. If 
the main oven’s temperature decreases, the columns will be protected from 
the resultant high pressures.
Setting Up and Configuring the System 67



4. Continue with Section 3.2.3, or click OK to save the changes.

3.2.3  Configuring the Injector

Note: Perform this procedure when you install different-sized sample loops or syringes. 

To configure the injector, you must specify the exact sample loop volume, syringe size, 
draw rate, and dispense rate.

1. Click the Injector tab in the Instrument Configuration Editor to open the Injector 
page (Figure 3-5).

Figure 3-5  Injector Page

2. If you replace the sample loop with one of a different size, enter the loop volume 
(labeled on the loop) in the Injector Loop Volume field. 

Note: You may enter an injection volume as low as 5 uL. If you are using 4 mL vials 
and enter a loop volume greater than 310.0 uL, you can only perform one injection 
per vial. This restriction does not apply to 10 mL vials or filter vial use.

3. If you replace the 5-mL syringe the system was shipped with, select the 
2.5 mL-syringe size from the Syringe Size list. Default = 5.0 mL.

4. Select from the Syringe Dispense Rate list a dispense rate from 0.1 to 10.0 mL/min. 
Default = 1.0 mL/min. The dispense rate determines how fast solvent is dispensed to 
wash the needle.
68 Preparing for Operation



Note: Highly viscous samples and solvents require low dispense rates and draw 
rates. 

5. Select from the Syringe Solvent Draw Rate list a solvent draw rate from 0.1 to 10.0 
mL/min. Default = 1.0 mL/min. The draw rate determines how fast fresh solvent is 
drawn from the solvent reservoir.

Note: The the instrument method defines the draw rate for aspirating a sample from 
its vial (see Section 3.3).

6. Continue with Section 3.2.4, or click OK to save the changes.

3.2.4  Labeling Columns

The Instrument Configuration Editor dialog box’s Columns page lets you identify the 
columns in the analysis compartment. 

1. Click the Columns tab in the Instrument Configuration Editor dialog box 
(Figure 3-6) to open the Columns page.

Figure 3-6  Columns Page

2. Select a column position, 1 through 6.

3. Select an appropriate column from the Column Style list.

Note: Select no column if the list does not include an appropriate one.

4. You can enter the column’s serial number and description (up to 250 alphanumeric 
characters) in the Column Serial Number field. 

5. Repeat steps 2 through 4 for each column.

6. Continue with Section 3.2.6, or click OK to save the changes.
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3.2.5  Configuring the Detector

If you installed a Precision Detector light scattering detector and want to enable the light 
scattering option, select the Detector tab in the Instrument Configuration Editor dialog box 
(Figure 3-7), and select the PDI LS Installed? check box.

Figure 3-7  Detector Page

3.2.6  Configuring the I/O Card 

When you connect external devices through the I/O card, you must configure the software 
to recognize the card’s connections (Section 2.4.5). These connections, and their intended 
functions, can require configuring these channels:

• Analog output

• Event input

• Event output

Note: You might also need to create a timed event list.

Consult these topics in the Alliance GPC 2000 Series System Help when configuring 
channels:

• “I/O Card” for the I/O card and analog output channels

• “Event Input/Output Control Dialog Box” for the event input and output channels

Note: See Appendix A for electrical specifications of signals transmitted through the I/O 
card. 

1. Click the I/O Card tab in the Instrument Configuration Editor (Figure 3-8) to open 
the I/O Card page. 
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Figure 3-8  I/O Card Page

2. To configure an analog output channel, select these items:

a. A physical parameter.

b. Channel scale. See Table 3-2 for the output values and scale for the parameters.

c. Channel offset. Valid entries are from –2.0 to +2.0 V. Default = 0.0 V.

Table 3-2  Output Scale

Parameter Output Values (per Volt)

RI 25, 50, 100, 500, 1000, 2500 µRIU/V

Viscometer, Visc. Rel. Flow 1.0 relative viscosity unit/V

Viscometer P1
Viscometer P2

5.5 kPa/V
55 kPa/V

LS 15 Deg.
LS 90 Deg.

1000, 10,000, 1,000,000, 10,000,000 
LSU/volt

Device and Ambient Temperatures 25 °C/V

Solvent Temperature 25 °C/V

Column, Injector, and Carousel Temperatures 100 °C/V

Pump Pressure
Degas Pressure

1000 or 2500 psi/V
10 psi/V
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3. Repeat step 2 for each additional analog output. 

4. Configure an event input channel:

a. Click Input #1 or Input #2, whichever corresponds to the external device’s 
connection to the I/O card.

b. Select an event type from the Event Type list (Figure 3-9). 

Figure 3-9  Selecting the Event Input Type

c. Select an activated state, Open or Closed.

Figure 3-10  Selecting the Event Input Activated State Type

d. Click OK to close the Event Input dialog box.

5. Repeat step 4, if necessary, for a second event input channel. 

6. Configure an event output channel for any event type except a timed list:

a. Click Output #1 or Output #2, whichever corresponds to the external device’s 
connection to the I/O card. 

b. Select an event type from the Event Type list (Figure 3-11).

Pump Flow 1 or 5 mL/min/V

Ambient, Detector, or Carousel Vapor 100, 500, or 1000 relative vapor 
units/V

Table 3-2  Output Scale (Continued)

Parameter Output Values (per Volt)
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Figure 3-11  Selecting the Event Output Type

c. Select an activated state from the Activated State list (Figure 3-12).

Figure 3-12  Selecting the Activated State of an Event Output

d. If you selected a pulse state from the Activated State list, select a pulse width 
(Figure 3-13). Available choices are from 0.01 to 10.0 min. Default = 1.0 min.

Figure 3-13  Selecting the Pulse Width

e. Click OK to close the Event Output dialog box. 

7. To create a timed event list in an event output channel:

a. Click Output #1 or Output #2, whichever corresponds to the external device’s 
connection to the I/O card. 

b. Select Timed from the Event Type list (Figure 3-14).
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Figure 3-14  Creating a Timed Events List

c. Click Add Time. The Event Time dialog box appears (Figure 3-15).

Figure 3-15  Specifying a Timed Event

d. Enter the event time, in seconds.

e. Select an activated state from the Activated State list (Figure 3-16).

Figure 3-16  Selecting the Activated State of a Timed Event

f. If you select a pulse state from the Activated State list, select a pulse width from 
the Pulse Width list. Choices range from 0.01 to 10.0 min. Default = 0.01 min.
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g. Click OK to close the Event Time dialog box. 

8. Click OK to enable the changes and to close the Instrument Configuration Editor.

3.3  Creating the Current Instrument Method

The instrument method specifies operating parameters for the solvent manager, sample 
manager, vapor sensors, and detectors. 

Create a current instrument method by setting parameters in these pages of the Instrument 
Method Editor dialog box:

• Storage Server (Section 3.3.1)

• Solvent Manager (Section 3.3.3)

• Vapor Sensors (Section 3.3.4)

• Sample Manager (Section 3.3.5)

• Detector (Section 3.3.6)

Note: Refer to these pages in the Alliance GPC 2000 Series System Help for details.

3.3.1  Creating a New Instrument Method

1. From the Interactive Mode window (Figure 3-3), select Tools > Instrument Method 
Editor. The Storage Server page of the Instrument Method Editor dialog box appears 
(Figure 3-17).
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Figure 3-17  Storage Server Page

2. Click New to create a new instrument method modeled on the default instrument 
method. Modify it, if necessary, by selecting or entering parameter values in each 
page of the current instrument method (Section 3.3.3 through Section 3.3.6).

3. When you finish creating the instrument method, click Save As. Enter a unique 
name, and then click OK.

4. Click OK to close the Instrument Method Editor and add the new values to the 
current instrument method.

3.3.2  Modifying an Instrument Method

1. Select Setup > Current Instrument Method from the Interactive Mode window 
(Figure 3-3). The Instrument Method Editor dialog box appears (Figure 3-17). Click 
the Storage Server tab.

2. Select an instrument method from the list.

3. Open each page of the current instrument method to modify it, selecting or entering 
parameter values as described in Section 3.3.3 through Section 3.3.6.

4. Click Save As. Enter a new name for the method, and then click OK.

5. Click OK to close the Instrument Method Editor and activate the current instrument 
method.
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3.3.3  Specifying Solvent Manager Settings

1. Click the Solvent Manager tab in the Instrument Method Editor dialog box 
(Figure 3-18).

Figure 3-18  Solvent Manager Page

2. Click A or B in the Solvent Source area to select the solvent. 

3. Specify a flow rate from 0 to 10.0 mL/min. Default = 0 mL/min.

4. Continue with Section 3.3.4, or click OK to save the changes.

3.3.4  Specifying Vapor Sensor Settings

Vapor sensors monitor vapor levels in three areas:

• Detector compartment 

• Sample management (carousel) compartment 

• Ambient air space in the lab 

The sensors compare the levels to those at startup or initialization. Vapor detection is 
programmable. If vapor levels inside the system exceed the programmed shutdown limit, 
the red LED lights, and the system shuts down. 

To determine shutdown limits experimentally, at each installation by introducing small 
amounts of the solvent to generate a signal that indicates suitable limits at each 
installation. Too low a limit can induce false triggering; too high a limit can defeat leak 
detection. Check vapor sensors regularly to ensure limits are working properly and replace 
sensors if needed (Section 4.4.5). 

Note: Vapors in your laboratory will affect the ambient vapor sensor reading. 
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Use the Vapor Sensors page to enable or disable the vapor sensors, change the vapor 
shutdown or warning limit, and monitor current vapor sensor readings. 

1. Click the Vapor Sensors tab in the Instrument Method Editor dialog box 
(Figure 3-19).

Figure 3-19  Vapor Sensors Page

2. Select Enable in the Ambient Vapor, Carousel Vapor, and/or Detector Vapor area(s). 

3. Specify a shutdown or warning limit:

• Ambient Vapor (near the right side vents).

• Carousel Vapor (in the sample compartment near the carousel). 

• Detector Vapor (on the back wall of the analysis compartment).

4. Continue with Section 3.3.5, or click OK to save the changes.

Determining a Vapor Sensor Reading 

1. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3).

2. Right-click one of the plots, and select Channel.

3. Select Ambient Vapor, Carousel Vapor, or Detector Vapor. The resultant plot 
displays the selected sensor’s relative reading.

3.3.5  Specifying Sample Manager Settings

The Sample Manager page includes fields for setting these parameters:

• Mixer rate and duration

• Carousel temperature

• Injector needle temperature

• Filtration rate
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• Syringe draw rate

• Needle wash volume

Note: For details about this page, see “Sample Manager Tab (Instrument Method Editor)” 
in the Alliance GPC 2000 Series System Help. 

To open the Sample Manager page, click the Sample Manager tab in the Instrument 
Method Editor dialog box (Figure 3-20).

Figure 3-20  Sample Manager Page

Mixer

Select Enable in the Mixer area. Then specify values for these parameters:

• Relative speed: Low, Medium, or High (50, 150, or 300 rpm). Default = High.

• Mix duration, from 0.5 to 60.0 min. Default = 5.0 min.

• Mix direction: Clockwise (CW), Counterclockwise (CCW), or Agitate (alternating 
between clockwise and counterclockwise).

Note: If you select Agitate you must specify values for Mix Spin Time and Mix Stop Time, 
selecting values from 0.5, 1, 2, 3, 4, 5 sec (default = 1 sec).

Carousel Temperature

Select Enable in the Carousel Temperature area. Then specify values for Set Point, High 
Limit, and/or Low Limit.
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Note: The carousel and injector temperatures allowed vary with the solvent you choose 
and under most circumstances should be set to the same value.

Injector Needle Temperature

Select Enable in the Injector Temperature area. Then specify values for Set Point, High 
Limit, and/or Low Limit.

Filtration Rate

In the Filter area, specify a filtration rate by selecting it from the Travel Rate list. Select 
from 10 to 100 mm/min. Default = 20 mm/min.

Note: For highly filled samples, use 10 mm/min.

Syringe Sample Draw Rate

In the Syringe area, specify a sample draw rate from the Sample Draw Rate list. Select 
from 0.1 to 4.0 mL/min. Default = 1.0 mL/min. 

Note: The draw rate specifies how fast the syringe moves when it aspirates sample. For 
viscous solutions (high MW), use a lower draw rate like 0.5 mL/min or lower.

Needle Wash Volume

In the Needle Wash area, click Minimum Volume or Standard Volume. This specifies the 
amount of solvent volume used to clean the needle in the needle wash. If you select 
standard volume, more solvent is used to wash the needle. To wash the needle for a longer 
time, select standard volume. The length of time the needle is washed is based on the 
number of injections. Default = Minimum Volume.

Aspirated Sample Disposition

If the Return to Vial button is selected, most of the unused sample in the inject loop is 
returned to the vial. If the Send to Waste button is selected, all samples are purged, sent to 
waste, and not returned to the vial. Default = Return to Vial.

Continue with Section 3.3.6, or click OK to save your specifications.

3.3.6  Specifying RI, Viscometer, and Light Scattering Detector 
Settings

Specify these parameters in the Detector page.

1. Click the Detector tab in the Instrument Method Editor dialog box (Figure 3-21).
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Figure 3-21  Detector Page

2. Optionally select these items in the RI area:

• Autozero (to automatically zero the refractometer baseline).

• Invert Channel (to display and save negative peaks as positive ones).

3. Optionally select Autozero in the Viscometer area (Alliance GPCV 2000 system 
only) to automatically zero the viscometer baseline.

4. Optionally select these parameters in the Light Scattering area:

• Autozero to adjust the zero offset of the signal output of the LS detector to 
compensate for changes in baseline position due to drift (moves the signal 
baseline to 0 light scattering units). Autozeroing allows the system to compensate 
for any long-term drift that may occur. If you select this check box, the LS 
detector is always at 0 before to making an injection.

• Laser On (to enable laser and the LS detector).

• Collection Fraction % to control filtering of the light scattering detector data. A 
value of 100% represents no filtering; a value of 1% represents maximum 
filtering. Suggested starting value: 20 %.

5. Select a sample rate, from 10 to 0.5 samples/sec, from the Sample Rate list. The 
default, 1 sample/sec, best suits broad standards.
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Note: If you select a rate faster than 1 sample/sec., only the light scattering 
channels will be processed at 1 sample/sec.; the remainder of the detector channels 
will be processed at the selected rate.

6. Optionally select Enable in the Column Temperature area to set an analysis 
compartment temperature. Then specify values for Set Point, High Limit, and Low 
Limit. The set point should fall in the range between the high and low limits.

Note: The allowed set point values vary with the solvent you choose. Nevertheless, 
a 50 degrees Celsius difference should exist between the set point and limits.

7. Click OK to save your specifications and to close the Instrument Method Editor. 

3.4  Preparing the Flow Path

Preparing the flow path involves these tasks:

• Priming the system (Section 3.4.1)

• Purging the injector (Section 3.4.2)

• Purging the refractometer (Section 3.4.3)

• Purging the viscometer (sense-tube type, only) (Section 3.4.4)

• Changing a solvent (Section 3.4.6)

• Priming the seal wash (Section 3.4.7)

Caution: To avoid chemical hazards, always observe safe laboratory practices when you 
operate the system and handle solvents. Know the chemical and physical characteristics 
of the solvents you use, referring to their Material Safety Data Sheets.

Caution: To prevent solvent overheating, select the correct solvent name when you 
configure a solvent in the Instrument Configuration Editor.

Caution: If you use a solvent that the Instrument Configuration Editor’s Mobile Phase 
page does not list, and you therefore select Other, record the solvent and its physical 
characteristics elsewhere.
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Note: To maintain solvent manager system efficiency and obtain accurate, reproducible 
chromatograms, use only filtered HPLC-grade solvents.

3.4.1  Priming the Solvent Management System

A priming operation incorporates a manual prime and a pump prime.

Prime the system with a low-viscosity solvent when the flow path is dry or when air 
bubbles persist despite purging. 

Required Materials

• Priming syringe (startup kit)

• Wide-mouth, solvent-resistant container

Procedure

1. Set up the solvent reservoirs as in Section 2.3.1. Gently shake the filters in the 
reservoirs to remove trapped bubbles. Ensure all waste tubing drains into the waste 
container.

2. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3) and 
ensure the flow rate is 0.

3. Select Operations > Manual Pump Prime. The Manual Prime wizard appears for 
solvent A or B. 

Note: To prime with the alternate solvent, click Exit. Then select Setup > Current 
Instrument Method and the solvent, A or B, from the Instrument Method Editor 
dialog box.

4. Follow the wizard’s instructions:

a. Click Next.

b. Connect the priming syringe to the purge valve (Figure 3-22).

����
Attention: To avoid precipitating salts in the solvent management system, use an 
appropriate intermediate solvent when you change from buffered solvents to 
high-organic-content solvents. See to Appendix C, Solvent Considerations, for solvent 
miscibilities.

����
Attention: To avoid column damage, ensure the purge valve is open before priming the 
system. This protects the columns from the effects of sudden pressurization when the 
Auto Pump Prime feature suddenly pumps solvent at a high flow rate.
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c. Turn the purge valve counterclockwise, between a half and a full turn.

Note: Because the priming syringe does not lock onto the purge valve, hold the 
syringe body in place while you retract the syringe plunger.

Figure 3-22  Using the Priming Syringe

d. Retract the syringe plunger, drawing solvent from the reservoir and through the 
tubing. This can require considerable force. Let the syringe fill and repeat the 
procedure until you remove at least 60 mL of solvent and solvent flows out the 
purge valve. 

e. Click Exit to close the wizard.

5. Continue with these purging functions:

• Section 3.4.2, Purging the Injector

• Section 3.4.3, Purging the Refractometer

• Section 3.4.4, Purging the Sense-Tube Viscometer (sense-tube type, only)

3.4.2  Purging the Injector

Purging flushes fresh solvent through the injector, sample loop, needle, and associated 
tubing. 

Purge to remove any traces of sample from a previous run or to clear bubbles from the 
flow path or the syringe. 

Note: Always purge the injector after priming with a new solvent.

Open

Purge 
ValveSyringe 

Body
Syringe 
Plunger
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You can also purge the injector in Sample Set mode by adding an Inject Purge row to the 
sample set method. See “Control Functions and Purging the Injector” in the Alliance GPC 
2000 Series System Help. 

1. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3).

2. Monitor the solvent flow rate as shown in the status bar. If it is 0 mL/min, enter a 
flow rate in the Flow field, and click Set Flow.

3. When the solvent reaches the specified flow rate, select Operations > Inj Purge to 
open the Injector purge dialog box (Figure 3-23). 

Figure 3-23  Injector Purge Dialog Box

4. At the prompt, select from the list the volume of injector purge solvent. Available 
choices: 
1 to 60 mL. Default = 1 mL. Suggested = 4 mL.

5. Click OK. The injector purge process starts. When the purge is complete, the system 
status reads Idle. 

3.4.3  Purging the Refractometer

Purge the refractometer whenever you change solvents or observe an increase in noise or 
drift. 

Note: You can also purge the refractometer in Sample Set mode by adding a row, RI 
Purge, to the sample set method. See “Interactively Creating a Sample Set Method” in the 
GPC 2000 Series System Help.

During the purge, the refractometer purge valve opens, and solvent flows through the 
reference side of the flow cell. 

Note: If you use the refractometer frequently, purge it weekly. 

1. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3).

2. Observe the solvent flow rate readout in the status bar. If it is 0 mL/min, enter a flow 
rate in the Flow field, and click Set Flow.
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3. When the solvent flow reaches the specified rate, select Operations > RI Purge to 
open the RI Purge dialog box (Figure 3-24).

Figure 3-24  RI Purge Dialog Box

4. At the prompt, select from the list, a purge duration, from 1 to 60 min. Default = 1 
min. 

5. Click OK. The refractometer purge process starts. When the purge ends, “Idle” 
appears in the Interactive Mode window’s status bar (Figure 3-3). 

Note: If refractometer bubbles persist despite purging, prime the system (see 
Section 3.4.1).

3.4.4  Purging the Sense-Tube Viscometer

Purge the sense-tube viscometer type whenever you change solvents or observe a noise 
increase in the Noise and Drift dialog box.

The viscometer purge involves the transducers and associated tubing.

Note: This process takes solvent from the outlet of the delay volumes, inside the 
viscometer. Therefore, at least 30 mL of solvent should flow through the viscometer before 
starting a purge.

Note: You can also purge the viscometer in Sample Set mode by adding a row, Visc 
Purge, to the sample set method. See “Control Functions” and “Purging the Viscometer” in 
the Alliance GPC 2000 Series System Help. 

1. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3).

2. Observe the solvent flow rate in the status bar. If it is 0 mL/min, enter a flow rate in 
the Flow field, and click Set Flow.

3. When the solvent flow reaches the specified rate, select Operations > Visc Purge to 
open the Viscometer Purge dialog box (Figure 3-25). 
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Figure 3-25  Viscometer Purge Dialog Box

4. Select the viscometer purge time (purge duration), from 1 to 60 min. Default = 
1 min. Suggested = 6 purges for 5 minutes at 1 mL/min.

5. Click OK. When the purge ends, “Idle” appears in the Interactive Mode window’s 
status bar (Figure 3-3). 

Note: Multiple purges of short duration (two minutes at 1 mL/min) effectively dislodge 
bubbles.

3.4.5  Calibrating the Viscometer

Wait three to four hours after purging the viscometer to calibrate it. Doing so assures more 
accurate results in the relative viscosity and can be viewed in the viscometer relative flow 
data channels. 

Viscometer calibration prepares the viscometer to operate under a particular set of 
operating conditions. It is valid only for a particular solvent, detector temperature, and 
flow rate. Calibrate the viscometer when any of these operating conditions changes, or 
when viscometer performance degrades.

Before starting a calibration sequence, ensure that these conditions are satisfied:

• The detector’s operating temperature is at the specified temperature for your 
analysis.

• The viscometer’s internal volume (35 mL) has been flushed with solvent in use, for 
at least two volumes.

• The viscometer is purged (sense-tube type only).

• The flow rate is the same as that specified for your analysis.

The viscometer calibration sequence requires six minutes or more to finish, depending on 
the specified flow rate.

There are two ways to calibrate the viscometer, in Interactive Mode or by adding a row to 
a sample set method.
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Calibrating the Viscometer in the Interactive Mode

1. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3).

2. Select Operations > Visc. Cal. 

3. At the confirmation prompt, click OK.

4. The viscometer calibration sequence starts. Progress is reported at the bottom left 
corner of the Alliance GPC 2000 Series window. 

Note: The Stop button is active.

Calibrating by Sample Set

1. Add a row, Visc Calibrate, to the sample set method that calibrates the viscometer at 
the specific operating conditions (solvent, flow rate and temperature settings). 

2. Add a row, Equilibrate, to the sample set method to equilibrate for at least two 
hours.

When the viscometer calibration finishes, the status display reads Idle, or the sample set 
method moves to the next line in the table and Stop button is disabled.

3.4.6  Changing a Solvent

When changing the solvent source from one reservoir to another that contains a different 
but miscible solvent, you must replace the solvent in the flow path. This involves priming 
the solvent manager then purging the injector and detector(s). See Section 4.6 for 
column-related information. 

1. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3).

2. Set the flow rate to 0 mL/min, and wait for the flow to stop.

3. Remove the filter and tubing from the current reservoir and immerse them in the 
new reservoir, gently shaking the filter to remove its infiltrated air.

4. Increase the flow gradually, in 0.1-mL/min increments, to 2.0 mL/min.

5. Prime with 48 mL of solvent, or more, for each 300 mm × 7.8 mm column. 

����
Attention: To avoid precipitating salts in the solvent management system, use an 
appropriate intermediate solvent when you change from buffered solvents to strongly 
organic ones. See to Appendix C for solvent miscibility information.
88 Preparing for Operation



3.4.7  Priming the Optional Seal Wash 

Note: Ensure the seal-wash apparatus is connected to a seal-wash reservoir (see 
Section 2.3.4). It must also be configured for solvent A or B (see Section 3.2.1 or 
Section 3.2.2). 

Required Materials

• Priming syringe (startup kit)

• Syringe adapter

• Seal-wash solvent

Procedure

1. Attach the syringe adapter to the priming syringe.

2. Fill the syringe with seal-wash solvent.

3. Remove the filter from the reservoir end of the seal-wash inlet tubing, and attach the 
syringe adapter in its place.

4. Click  (Interactive Mode) in the Interactive Mode window (Figure 3-3).

5. Select Operations > Seal Wash Prime to open the Seal Wash Prime dialog box 
(Figure 3-26).

Figure 3-26  Seal Wash Prime Dialog Box

6. Specify duration of the prime and click Start. Default = 1 min. Suggested = 10 min. 

7. Push the priming syringe plunger to force seal-wash solvent through the seal-wash 
system as the pump operates.

����
Attention: To prevent system damage, use a seal-wash solvent that mixes with your 
solvents and does not react with the material that composes the seal-wash body. See 
Appendix C for solvent compatibility information.
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8. When solvent flows from the waste tubing, click Stop to stop the seal-wash pump. 
Click OK and then Cancel. 

9. Remove the syringe and adapter from the tubing. Reinstall the filter, and return the 
tubing to the seal-wash reservoir.

10. Select Setup > Instrument Configuration from the Interactive Mode window to open 
the Instrument Configuration Editor.

11. Click the Mobile Phase A and/or Mobile Phase B tabs. 

12. Select Seal Wash, and then click OK.

3.5  Preparing Samples

The system accommodates two carousel types. One that holds up to 24sample vials of 
4-mL, 7-mL, and 10-mL capacity. The other holds up to 40 4-mL vials.

3.5.1  Preparing and Capping Sample Vials

Required Materials

• 10-mL glass vials (standard)

• Screw caps with PTFE septa

• Large vial holders

• 4-mL glass vials (optional):

– Screw caps

– 4-mL vial septa

– 4-mL vial holders

• 7-mL stainless steel filter vials (optional):

– Plunger

– Vial cup

– Plunger seal

– Filter (0.5µm or 2.0µm)

����
Attention: To prevent damage to the sample management system, use only Alliance 
GPC 2000 sample filter vials when filtering samples.
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Procedure

1. Select vial sizes according to your sample sizes (Table 3-3).

2. Dissolve polymer samples, ensuring complete solubility at the desired 
concentration. Highly crystalline polymers may require high temperatures to 
completely dissolve. 

Note: Because some solvents can expand as much as 10% when heated, a vial’s 
nominal capacity can prove in certain cases insufficient. You should therefore fill a 
vial only to the bottom of its shoulder. Alternatively, you can calculate the heated 
solvent’s expected volume, applying its expansion coefficient, and then adjust the 
vial volume accordingly.

3. Add a sample aliquot to each vial. See Table A-6 for the minimum volume of 
sample needed for each vial size and for each sample loop.

4. Seal each 10-mL vial with a screw cap and septum.

5. Seal each 4-mL vial with a 4-mL vial septum and screw cap. Then install the vial in 
a 4-mL vial holder.

6. Assemble 7-mL sample filter vials (Figure 3-27): 

a. Press a 0.5-µm filter onto the bottom of the plunger. You can use a 2.0-µm filter 
for shear-sensitive polymer samples.

b. Install a 20-mm crimp cap on the plunger top.

c. Crimp the 20-mm crimp cap with the vial crimper (part number 700000847).

Note: You can preheat the vial cup and the assembled, crimped plunger before 
adding heated sample. 

7. Carefully pour about 7 mL of heated, dissolved sample into a stainless steel vial 
cup. 

Note: You may dissolve the sample at a higher temperature than the analysis 
temperature to ensure it remains dissolved during transfer to the vial cup. 

Table 3-3  Vial Types

Vial Cap Vial Holder

10-mL glass vial (standard) 20-mm screw cap Large vial holder

4-mL glass vial (optional) Screw cap and 4-mL 
vial septum

4-mL vial holder and large vial 
holder

7-mL stainless steel filter 
vial (optional)

20-mm crimp/seal 
cap

Large vial holder
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8. Carefully slide the plunger assembly into the vial cup until its alignment mark aligns 
with the top of the vial cup. Do not push the plunger down below this alignment 
mark.

Figure 3-27  Assembling a Filter Vial with Sample

9. Place the assembled filter vial in a large vial holder within the carousel. Ensure its 
position matches the vial location illustrated in the Carousel Mode window (see 
Figure 1-13). 

3.5.2  Loading the Carousel 

When the sample compartment door button on the front panel is illuminated, you 
can open the sample compartment door. Do not open the sample compartment door under 
these conditions:

• The sample compartment door button is not illuminated.

• A sample set is running.

• The injection needle is down inside a vial.

Note: When the GPC 2000 software is not running and GPC instrument is on, the sample 
compartment door button may flash intermittently:

To stop the flashing, either power-off the system and Windows 2000 software, or start the 
GPC 2000 software. If the compartment door flashes at any other time, phone Waters 
Technical Service.

Caution: To avoid injury from burns, allow the system enough time to cool before you 
perform maintenance or troubleshooting. Wear protective clothing whenever you open 
the sample or analysis compartment.

20-mm Crimp Cap with Seal
 Plunger Top 

Plunger Seal 
(Open Side Away 

from Filter)Filter

Stainless Steel Vial Cup

Sample

Alignment Mark
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Loading vials

1. Before opening the sample compartment door, ensure the sample door button is 
illuminated. Open the sample compartment door by pulling the sample door 
(Figure 3-28) outward to a 90° angle. 

Figure 3-28  Opening the Sample Compartment Door

2. Pull the sample compartment handle downward to an angle of 90° from vertical 
(Figure 3-29). To access the sample tray, grasp the sample tray handle with a gloved 
hand, and swing the carousel outward.

3. With a gloved hand, grab the carousel handle and remove the carousel by lifting it 
out of the sample management system. 

����
Attention: Stop the sample set, and wait for idle mode before you add vials to the sample 
compartment. Ensure the needle is in the home position or wash station. If the needle is 
inside a vial, initialize the software by selecting Operations > Smart Reinit.

Sample 

Compartment 

Door Handle

Sample Tray 
Handle
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Figure 3-29  Accessing the Carousel

Note: If a vial is accessible, you can use gloves and/or tongs to load or remove it 
without removing the carousel (Figure 3-30).

Carousel Handle
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Figure 3-30  Installing or Removing a Vial

4. After you finish loading and/or removing samples, replace the carousel if necessary.

5. Grab the sample tray handle and move the carousel back into the unit. 

6. Close the sample compartment door until it reaches its stop within 0.5 in. (1.3 cm) 
of the cabinet. Ensure the door is vertical. The carousel rotates to its home position 
so that it will be ready for a run.

7. Equilibrate the system (see Section 3.6.1, Equilibrating the System).

3.6  Equilibrating the System

Before running a sample set, make a preliminary injection to ensure the system operates 
and that parameter values are correctly specified. 

Note: Ensure the system contains sufficient solvent and that it is purged of all air (no 
bubbles).

TP01649

Sample Tray Handle
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3.6.1  Equilibrating the System

Using Interactive mode, operate the system at initial run conditions until the baseline 
stabilizes. Alternatively, you can use the sample set mode and an Equilibrate or Verify 
function (see Section 3.7).

Note: Minute variations in parameter settings like flow rate, temperature, and solvent 
viscosity can adversely affect chromatographic results. You should therefore allow four 
hours or more for equilibration. Bringing the system from ambient to high temperatures 
may require up to 24 hours for equilibration.

Interactive Mode Equilibration

1. Click  (Interactive Mode) in the Alliance GPC 2000 Series system window 
(Figure 3-3). 

2. Specify an appropriate set of instrument operating parameters for the current 
instrument method. For details, consult these topics in the Alliance GPC 2000 
Series System Help:

• “Creating an Instrument Method for Interactive Mode Operation”

• “Modifying an Instrument Method for Interactive Mode Operation”

• “Temperature Control”

����
Attention: To prevent damaging your columns with sudden flow rate 
changes, use the Limit Ramp Rate function in the Instrument Configuration 
Editor (for solvent reservoir A and/or B). Increase the flow rate in no more 
than 0.1-mL/min increments.
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Figure 3-31  Sample Set Equilibration Example

3. Let the equilibration continue until the baseline is stable. If the baseline does not 
stabilize, see Chapter 5, Troubleshooting the System. 

Note: You can also equilibrate your system by inserting an Equilibrate or Verify row into a 
sample set method. 

Use “viscometer purge” to purge sense-tube viscometers only.

Select Equil or Verify from the Sample Set Method table’s Function list, and then select an 
instrument method from the Method list. When you run the sample set method, 
equilibration automatically occurs. 

Using an Equil function in your sample set method lets you equilibrate for a specified run 
time. A Verify function monitors parameters and waits until programmed conditions are 
reached.

3.7  Creating and Running a Sample Set 

3.7.1  Creating a Sample Set

To create a new sample set, you can either enter information directly in the Sample Set 
Method Editor, or you can use the Wizard and follow its instructions. 

A sample set can include two types of functions, acquisition and control.
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Acquisition functions include

• Prelude operations

• Broad and/or narrow standards

• Broad and/or narrow unknowns

Control functions include

• RI Purge

• Inj Purge

• Visc. Purge (sense-tube only)

• Equil

• Verify

• Visc Calibrate

Using the Sample Set Method Editor to Create a Sample Set

1. Click  (Sample Set) in the Alliance GPC 2000 Series system window. The 
Sample Set Mode window appears with a read-only view of the Sample Set Method 
table (Figure 3-32).

Figure 3-32  Sample Set Method Table

2. Click Editor in the Sample Set Operations area, to open the Sample Set Method 
Editor.

3. Click New to create a new sample set method.

4. To use a control function prior to acquiring data

• Click the Function column, and then select the function (such as Equil, Inj Purge, 
RI Purge, Verify) that you want to perform. 

• Click the Time column, and then enter a suitable run time for the control function 
(or injection volume in the case of Inj Purge).

Note: Do not enter an injector purge volume less than 1 mL. A typical injector purge 
volume is 5 mL.
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• Click the Method column, and then select a previously created method from the 
list.

5. Click the next row in the Sample Set Method table. Define the acquisition sample 
set as follows:

a. Specify in the Vial# and Sample fields, the vial number and sample name.

b. Click the Method column, and then select from the list of instrument methods the 
one for the row. 

Note: If you do not select an instrument method, the one you specified in the 
preceding row is adopted by default. You can create a new instrument method or 
modify an existing one via Instrument Method Editor.

c. Click the Function column, and then select from the list the acquisition function 
you want to use for the row: Narrow Unknown, Broad Unknown, Narrow Std, or 
Broad Std.

d. In the Inject field, specify the number of injections from the specified vial.

e. In the Time field, specify the run time (in minutes) for each injection.

f. In the Vial Size field, specify the size of the vial in the specified vial position.

g. If you intend to use Empower to process the acquired sample set data, click More 
in the Info field. This allows access to the component information dialog box 
whose parameters reflect the selected acquisition function (narrow standard, 
broad standard, narrow unknown, or broad unknown). Specify component 
information for the standard or unknown, and then click OK.

6. Repeat step 5 as required for subsequent standard and unknown sample rows in the 
table. 

Note: You can copy and paste rows of data. Select the row number, right-click, 
select Copy, and then select Paste. 

7. If you want to ramp-down the solvent flow rate after the last injection specified in 
the table, add a row at the end of the table that includes an instrument method with a 
progressively diminished flow rate.

8. When you finish, click OK. 

9. Click Yes to save changes. The Save Sample Set Method dialog box appears.

10. Enter the name of the sample set method in the File Name field, and then click OK. 

Note: Sample set method names must be alphanumeric characters with a 
maximum length of 30 characters; do not use special characters (slashes (/), or an 
underscore (_), or a blank space). 
Creating and Running a Sample Set 99



11. Click Yes to load the contents of the saved sample set method into the active Sample 
Set Method table. The contents of the sample set method appear in the Alliance 
GPC 2000 Series window.

Note: If you are sending sample data to Empower, ensure the sample set table 
contents are left-justified and do not contain spaces in the rows or cells of the table.

Modifying a Sample Set Method

1. In the Sample Set Mode window, click Editor to open the Sample Set Method 
Editor. 

2. Click Open, select a sample set method, and then click OK. 

3. Modify the sample set method in the Sample Set Method Editor.

4. If you want to change the name of the sample set method, click Save As, and enter a 
new a sample set method name. If you want to save the changes to the sample set 
method without changing the name, click Save.

5. Click Yes to load the sample set.

6. Click OK to close the Sample Set Method Editor. 

3.7.2  Running a Sample Set

Note: You can run a sample set with or without sending the data to Empower during the 
run. 

1. In the Sample Set Mode window, click Run to open the Start Sample Set dialog box 
(Figure 3-33).

Figure 3-33  Start Sample Set Dialog Box

Note: If you are not using Empower, go to step 5.
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2. Enter the following information in the Start Sample Set dialog box:

• Enable – Activates communication with Empower.

• Save Password – Saves the current password and redisplays it for the next login.

Note: Use correct uppercase and lowercase letters. Names and passwords are 
case-sensitive.

• User Name – Your user name (assigned by the Empower system administrator).

• Password – Your password (assigned by the Empower system administrator). 

3. In the Node area, select the node name of the computer that hosts the database you 
want to connect to. 

a. Click Local to connect to the Empower database on your Alliance GPC 2000 
system. 

b. Click Remote and then Browse to connect to a remote Empower database and 
select the Empower computer whose database you want to access.

4. In the Project area, click Browse. Select from the list of previously created 
Empower projects that will receive the data you transfer.

5. To start the sample set at row 1 (default), click OK. To start it at a different row, 
specify a number in the Start At Line Number field, and then click OK.

6. To watch the sample set as it runs, open either the Carousel mode or the Sample Set 
mode window. The active row is highlighted in the sample set table, depicting the 
progress of the run (Figure 3-3).

3.7.3  Moving the Sample Set Results into Empower

Note: If the sample set run is interrupted for any reason, you must manually import the 
sample set data into Empower and you cannot use the Sample Set Mover.

To move sample set results into Empower after a run:

1. Click (Sample Set Mover) to open the Sample Set Mover - Please Login dialog 
box (Figure 3-34). 
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Figure 3-34  Selecting the Sample Set to Transfer

2. Click Login to open the Empower Login dialog box (Figure 3-35).

Figure 3-35  Empower Login

3. Select the Save Password check box to save the current password and re-display it 
the next time you log on.

4. Enter your Empower user name and password in the User Name and Password 
fields.

Note: Your Empower System Administrator defines your user name and password.

5. Select your Empower database:

• Local, to connect to the Empower database on your Alliance GPC 2000 system.

• Node name, identifying where your Empower database resides, to connect to a 
remote Empower database.

6. Click OK. The Select Project dialog box appears.
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7. Select the name of the Empower project that you want to send the results of your 
sample set to, and click OK. 

8. The Sample Set Mover - Please Login dialog box reappears (Figure 3-34). Click 
Select Sample Set to browse for the sample set results that you want to send to 
Empower. All sample set results reside in this folder:

c:\Program Files\Waters\GPC2000\SSArchive\SampleSets

Note: You must select an entire sample set folder to send to Empower. You cannot 
send partial sample set components, for example, channels of data.

9. Click Transfer File. A dialog box appears verifying the successful transfer of the 
sample set results. When the transfer is complete, click OK. 

3.8  Shutting Down the System

After the system reaches operating temperature and equilibrates, it should hold that 
temperature for long periods to ensure thermal stability. 

You will occasionally need to shut the system down, temporarily or indefinitely.

Temporary Shutdown

If you are shutting down your system for four days or less, do this:

• Ensure all equilibration, acquisition, and purge operations in the sample sets are 
complete. 

• Keep the system at its current temperature and flow rate, or maintain the current 
temperature but decrease the flow rate.

If you are shutting your system down for more than four days, do this:

• Purge the injector (Section 3.4.2).

• Purge the refractometer (Section 3.4.3).

• Purge the (sense-tube type) viscometer (Section 3.4.4).

• Decrease the flow rate slowly to approximately 0.1 mL/min or higher (depending on 
the solvent) and decrease the temperature. 

• Empty the waste container.
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Indefinite Shutdown

1. Follow the suggestions for temporarily shutting down the system, but slowly 
decrease the flow rate to 0.0 mL/min.

2. Ensure all equilibration, acquisition, and purge operations in the sample sets are 
complete.

3. Select File > Exit from the Interactive Mode window (Figure 3-3).

4. Select Start > Programs > Gpc2000 Chromatography > Shutdown GPC 2000 
Platform.

Note: If the software does not appear to shutdown after several minutes, select 
Start > Programs > Gpc2000 Chromatography > Stop All GPC2000 Processes.

5. Select Start > Shut Down. At the prompt, confirm your decision to shut down the 
system, and then click Yes to exit application.

6. Set the power switch (on the right side panel) to Off (O). 

7. Once the system is off, shut down the monitor and printer.

����
Attention: To prevent the corrosion of metal surfaces, remove buffered solvent before 
you shut down the system (see Appendix C).
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Chapter 4
Routine Maintenance

This chapter presents routine maintenance procedures, which when followed ensure the 
system consistently provides accurate and precise results.

4.1  Required Materials

See Appendix B for spare parts information.

In addition to spare parts, you need these items:

• Medium-sized container that is resistant to your solvents

• Squirt bottle with solvent that is compatible with your solvents

• Lint-free tissues

• Heat-resistant gloves

• Torx® T20 driver

• Medium Phillips-head screwdriver

• Medium flat-blade screwdriver

• Open-end wrenches, 1/4-in., 5/16-in., 3/8-in., 1/2-in., and 5/8-in.

• Flashlight

• Pipe cleaners (compatible with solvents)

4.2  Safety and Handling 

When you perform maintenance procedures, keep the following safety considerations in 
mind.     

Caution: To avoid injury from burns, allow the system enough time to cool before you 
perform maintenance or troubleshooting. Wear protective clothing whenever you open 
the sample or analysis compartment. 
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4.3  Contacting Waters Technical Service

Customers in the USA and Canada should report the problems to Waters Technical 
Service (800 252-4752). Others should phone their local Waters subsidiary or Waters 
corporate headquarters in Milford, Massachusetts (USA), or they may visit 
http://www.waters.com, and click Offices.

For complete information on reporting shipping damages and submitting claims, see 
Waters Safety Notices, Licenses, Warranties, and Support.

4.3.1  Maintenance Schedules

Based on 24-hour operation, maintain the system as recommended in Table 4-1. 

Caution: To prevent injury, observe good laboratory practices when you handle solvents, 
change tubing, or operate the system. Know the physical and chemical properties of the 
solvents you use. Refer to the Material Safety Data Sheets for the solvents in use.

Caution: To avoid electric shock, or damaging the system, do not open the back panel. 
Removing the back panel does not allow you access to user-serviceable parts.

����
Attention: To avoid damaging electrical parts, never disconnect an electrical assembly 
while power is applied to the system. Once power is turned off, wait 10 seconds before 
you disconnect an assembly.

����
Attention: To prevent circuit damage from static charges, do not touch integrated circuit 
chips or other components that do not specifically require manual adjustment.

Table 4-1  Suggested Maintenance Procedures

Procedure Frequency Reference

Replace the solvent inline filter Every 1 to 4 
weeks, depending 
on your applica-
tion and solvent.

Section 4.5.7
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Replace the solvent reservoir filters Every 2 to 4 
weeks, depending 
on the solvent.

Section 4.5.8

Replace the vapor sensors Every 2 months, 
depending on the 
solvent

Section 4.4.5

Replace the piston seals 30 days (applica-
tion dependent)

Section 4.5.9, 
Section 4.5.10, and 
Section 4.5.13

Replace the seal-wash seals (optional)

Do not use with TCB. For more information 
about solvents, see Table C-2.

As needed (appli-
cation dependent)

Section 4.5.9, 
Section 4.5.10. 
Section 4.5.11, and 
Section 4.5.13

Replace the primary and accumulator 
pistons 

Every 12 months Section 4.5.9 to 
Section 4.5.13

Replace check valves Every 3 months Section 4.5.14

Replace waste tubing or other tubing As needed Section 4.5.15

Replace the sample needle As needed Section 4.5.2

Replace the syringe and seal 90 days Section 4.5.3

Change the sample loop As needed Section 4.5.4

Replace the filter in a sample filter vial After use of a 
sample filter vial

Section 4.5.6

Add, delete, or replace a column As needed Section

Replace the pre-detector inline filter As needed Section 4.5.7

Clean the system and inspect for leaks Daily Section 4.4

Back up and delete chromatographic data Weekly or as 
needed

Section 4.7.1

Table 4-1  Suggested Maintenance Procedures (Continued)

Procedure Frequency Reference
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4.4  Maintaining Performance

To keep your system in optimal working order, perform the routine operating tasks in 
Table 4-2 and the maintenance procedures in this chapter. These maintenance tasks are 
based on 24-hour system operation. 

4.4.1  Cleaning the System

If you are using TCB, clean the system every 30 days at 160 °C at a low flow rate. Clean 
the system regularly if you are processing high MW samples or begin to see extra peaks in 
your chromatograms.

Required Materials

• Laboratory detergent

• Distilled and deionized water

• Absorbent tissue

• Gloves

Table 4-2  Routine Operating Tasks

Task Frequency

Empty the waste container. Weekly or as needed

Check and refill the solvent reservoirs with solvent. As needed

Check and refill the seal-wash reservoir with seal-wash 
solvent. 

As needed

Change the seal-wash solvent (optional). As needed (optional)

Calibrate using standards appropriate for your samples. As needed

Purge the injector. See Section 3.4.2. At the beginning of each 
sample set

Purge the refractometer. See Section 3.4.3. As needed weekly

Clean the waste manifold. See Section 4.5.1. Weekly or as perfor-
mance dictates

Back up data files and logs (Alliance GPC 2000 Series 
system). See Section 4.7.

Weekly

Back up sample sets and projects (Empower application). Weekly
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Spill Control and Waste Fluids

Waste fluids drain to a waste container placed below the level of the system.

• Drip trays provide spill control for all compartments. Fluid drains through a waste 
port on the left side of the system to a waste container (Chapter 5, Troubleshooting 
the System). 

• Waste solvents from detectors exit the system through a waste port on the upper-left 
side. 

• Waste solvents from the needle wash apparatus exit the system through a waste port 
on the lower-left side. 

Procedure

1. Clean the sample compartment:

a. Open the door, and remove the carousel.

b. Inspect the sample compartment for leaks, and then wipe surfaces and the drip 
tray under the carrier with dilute laboratory cleaning agent.

c. Wash the carousel. Rinse it with water, and dry it thoroughly.

d. Wash the vial holders. Rinse and dry them thoroughly.

e. Close the door.

2. Open the analysis compartment door. Inspect the sample compartment for leaks, and 
wipe its lower surface. Close the door.

3. Open the syringe door. Inspect for leaks, and wipe the grill area. If you can, wipe the 
drip area under the grill (reach back, and then under). Close the door.

Note: The grill is not removable.

Caution: Dispose of cleaning materials safely, complying with local, state, and federal 
regulations.

Caution: To prevent injury, observe safe laboratory practices when you clean the system 
and handle solvents. See the Material Safety Data Sheets for the solvents you use.

Caution: To avoid burn injuries, allow the system enough time to cool before you perform 
maintenance or troubleshooting tasks. Wear protective clothing whenever you open the 
sample or analysis compartment.
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4. Open the solvent compartment door. Inspect the compartment for leaks, and wipe 
the drip tray, under the solvent management system. Close the door.

5. Disconnect the waste container tubing. Empty the waste container, and clean it. Let 
it drain, and then reconnect the waste tubing.

6. Purge the injection valve, refractometer, and viscometer, and then equilibrate the 
system.

7. Consult manufacturers’ instructions for cleaning the surfaces of the monitor and 
computer peripherals.

4.4.2  Monitoring the Inlet Check Valve Performance

Replace the inlet check valve if it leaks or otherwise fails to function properly (see 
Section 4.5.14). For optimal performance, check for leakage daily.

Determining Whether the Check Valve Leaks

1. Monitor the baseline by

• using the Viewer (“Viewer Window” on page 27), or 

• viewing the real-time plots in the Interactive mode window, or

• importing the viscosity relative flow channel into Empower. See “Manually 
Importing AIA Raw Data into the Empower Software” in the Alliance GPC 2000 
Series System Help.

Figure 4-1  Normal Viscosity Relative Flow Channel

Figure 4-1 depicts a normal viscosity flow channel. (Figure 4-2), however, depicts 
one with three times the normal noise, which indicates a leaking check valve. 

Normal

ThreeTimes 
Noise

Noise
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Figure 4-2  Abnormal Viscosity Flow Channel

2. If it is leaking, replace the inlet check valve (see Section 4.5.5). 

4.4.3  Determining Whether the System Is Plugged

If the polymer precipitates, there may be a plug in the system. 

1. View a plot to ensure that the pump pressure is relatively constant. If there is any 
fluctuation, look for some sign of a blockage.

2. You can view a plot by using the Viewer (“Viewer Window” on page 27), the 
Interactive Mode window, or by plotting the P1 or P2 channel in Empower 
(Figure 4-3) if you have a GPC/V system. See “Manually Importing AIA Raw Data 
into the Empower Software” in the Alliance GPC 2000 Series System Help. The rise 
and fall of the baseline indicate a blockage within the system (twice the width of the 
baseline is acceptable).

Figure 4-3  Abnormal Baseline

Check valves are 
leaking at 19.5 and 
22.8 minutes, which 
indicate poor check 
valve performance.

Sign of blockage in 
the system
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3. Replace any blocked tubing (Section 4.5.15, Replacing Tubing).

4.4.4  Monitoring the Vapor Sensors

Check solvent vapor levels every 90 days for potential leakage by using one of the 
following methods:

• View plots in the Viewer or the Interactive mode window

• Import the vapor level channel into Empower. 

4.4.5  Replacing the Vapor Sensors

If you are using chlorinated solvents, like TCB, vapor sensor performance may degrade 
over time. To maintain optimal performance when using TCB, replace the vapor sensors 
every two months, or as needed.

Note: Before replacing the vapor sensors, ensure that the instrument and ambient room 
space is free of vapors. 

Required Materials

• Torx T10 screwdriver 

• Replacement vapor sensors (3) 

Procedure

1. Power-down the GPC 2000 instrument (Section 3.8) and unplug it.

2. Lift and slide the L-shaped vent cover to expose the vapor sensor manifold and 
mounting blocks.

Figure 4-4  Removing the L-shaped Cover

L-shaped cover
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3. Using a Torx T10 wrench, remove the four corner screws from the vapor sensor 
mounting plate, and then place them in a secure location.

Figure 4-5  Removing the screws from manifold

4. Remove the vapor sensor manifold, and then invert it to access the three vapor 
sensors.

Figure 4-6  Accessing the vapor sensor manifold

5. To replace the vapor sensors, gently pull each from the vapor sensor manifold. 

6. Remove and replace teflon gasket if needed.

7. Remove and replace the three vapor sensors.

Note: You need not align the pins at the bottom of a vapor sensor when you replace 
it.

8. Replace the four screws in the mounting plate, and then gently place the plate on top 
of the vapor sensor manifold.

Corner
Screw

Corner
Screw

Vapor sensor

Vapor sensor 
manifold

Teflon gasket
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Figure 4-7  Replacing the vapor sensor manifold

9. Using a Torx T10 driver, drive the four screws into the manifold.

10. Replace the L-shaped cover by snapping it back into place.

11. Plug in the power cord into a grounded power outlet, and then start the instrument.

Determining a Vapor Sensor Reading 

When you replace the vapor sensors, allow the sensors to stabilize for at least two hours, 
and then check the vapor levels in the Interactive window. 

1. From the Interactive Mode window, right-click any plot, and then select Channel > 
Ambient Vapor.

2. Repeat step 1 to check the Carousel Vapor and Detector Vapor levels.

The resultant plot displays the selected sensor’s relative reading. If the vapor sensor 
is below 5.0 level, they are set correctly. If they exceed this level, contact your 
Service Representative to request that your vapor sensors be calibrated in the 
Service Diagnostics window.

Verifying that the Replaced Vapor Sensors were Installed Correctly

When you replace the vapor sensors, you can use the procedure outlined below to verify 
that they are working correctly. 

Required Materials

• 10 mL glass vial 

• Methanol

• Gloves

• Syringe

Corner
Screw

Corner
Screw
114 Routine Maintenance



Procedure

1. From the Vapor Sensors tab in the Instrument Method Editor, disable the ambient 
carousel, and detector vapor sensors by clearing the Enable check boxes 
(Section 3.3.4).

2. From the Detector tab in the Instrument Method Editor, set the column, carousel, 
and injector temperature to 40 °C for the current instrument method, and save the 
modified instrument method. Wait until the temperature stabilizes at 40 °C.

3. Using gloves, draw approximately 2 mL of methanol and inject into a 10 mL vial.

4. Place the vial in the front left-hand corner of the detector compartment and close the 
compartment door.

5. From the Interactive Mode window, right-click any plot, and then select Channel > 
Detector Vapor.

6. Wait 30 minutes.

The resultant plot displays the detector’s relative reading. A sudden increase in 
vapor levels confirms that the vapor sensor is working correctly. 

7. Remove the vial from the detector compartment and place in position #15 of the 
carousel.

8. Repeat steps 5 and 6, but monitor the carousel channel by selecting Channel > 
Carousel Vapor.

9. Remove the vial from the carousel compartment and hold next to ambient vapor 
sensor tube (Figure 4-8).
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Figure 4-8  Ambient Vapor Sensor Location

10. Repeat steps 5 and 6, but monitor the ambient vapor channel by selecting Channel > 
Ambient Vapor.

11. Before you enable the vapor sensors in the Instrument Method Editor, allow vapor 
levels to fall below the warning level.

12. Reset the detector’s operating temperature for your analysis.

4.4.6  Routine Solvent Manager Maintenance Tasks

Periodic maintenance involves these procedures: 

Table 4-3  Routine Solvent Manager Maintenance Tasks

Task Frequency

Replacing the solvent inline filter. Every 1 to 4 weeks, depending on the 
solvents

Replacing a solvent reservoir filter. Every 2 to 4 weeks, depending on the 
solvents

Replacing the piston and face seals. Monthly (application dependent)

Ambient Vapor Sensor 
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Note: See Chapter 5 for information about isolating problems in the solvent management 
system.

4.5  Maintaining the Sample Manager System (SMS)

Periodic maintenance of the sample management system involves these tasks:

• Maintaining (cleaning) the waste manifold – Weekly

• Replacing the sample needle – As needed

• Replacing the syringe and seal – Every 12 months or as needed

• Replacing the sample loop – As needed

• Replacing the filter in a sample filter vial – As needed

Change the seal-wash solvent (optional). As needed

Inspect, clean, and replace (if needed) the 
needle wash line, waste line, and waste 
manifold.

Every 1 to 3 months

Replacing the seal-wash seals (optional). As needed (application dependent)

Replacing a piston. Every 12 months

Replacing a check valve. Every 90 days

Caution: Always observe good laboratory practices when you handle solvents, change 
tubing, or operate the system. Know the physical and chemical properties of the solvents 
you use by referring to their Material Safety Data Sheets.

Caution: To avoid injury from burns, allow the system enough time to cool before you 
perform maintenance or troubleshooting. Wear protective clothing whenever you open 
the sample or analysis compartment.

����
Attention: In order to avoid leaks when you maintain and/or replace parts in the sample 
management system, use Waters fittings and ferrules.

Table 4-3  Routine Solvent Manager Maintenance Tasks (Continued)

Task Frequency
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4.5.1  Maintaining the Waste Manifold

The waste manifold can become contaminated with polymer residue if you do not properly 
maintain it. When the waste manifold is dirty, extra peaks appear at the beginning of your 
chromatogram. Waters recommends you clean the waste manifold (Figure 4-9) weekly.

Figure 4-9  Accessing the Waste Manifold

Cleaning the Waste Manifold:

1. Power-down the GPC 2000 system.

2. Open the syringe compartment door.

3. Remove waste drain tubing from the detector (1/4-inch NPT).

4. Remove the RI reference flush tubing, 5/16-inch.

5. Remove the tubing from the rear of the waste manifold (1/4 to 20 in.).

6. Remove the vent tubing, 1/4 inch NPT.

7. Using a Torx T20 driver, remove the two T-20 screws that secure the waste manifold 
to the GPC 2000 chassis, and remove the waste manifold.

8. Clean the waste manifold using pipe cleaners and/or a solvent bath.

Waste Manifold

Syringe Body
Syringe

Compartment
Door
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Note: Do not use nylon pipe cleaners. The accumulation of polymers in the waste 
manifold will dissolve them.

9. Dry and reinstall the manifold onto the chassis.

10. Reconnect the flow tubes to the manifold.

11. Restart the system and check for fluid leaks.

4.5.2  Replacing the Sample Needle

Replace the sample needle when it becomes blocked, bent, or otherwise damaged. 

Required Materials

• New sample needle

• Open-end wrenches, 5/16-in. and 1/2-in.

• Screwdriver

• Flashlight

• Gloves

Procedure

1. Let the sample compartment cool.

2. Click  (Diagnostics) in the Interactive Mode window (Figure 3-3) to open the 
Diagnostics Mode window (Figure 4-10).
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Figure 4-10  Diagnostics Mode Window

3. Click Diagnostics, in the lower-right corner, to open the User Maintenance and 
Service Diagnostics dialog box (Figure 4-11).

Diagnostics Button 
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Figure 4-11  User Maintenance and Service Diagnostics Dialog Box

4. Click Needle Replacement.

5. Follow the steps in the Needle Maintenance wizard to remove the sample needle:

a. Ensure the sample compartment door is closed, and then click Next.

b. Fully open the sample compartment door.

c. Remove the sample carousel.

d. Click Next to lower the needle.

e. Find the ram nut and sample needle inside the sample compartment, to the left of 
the tray (Figure 4-12). Use the flashlight to monitor the needle movement.

Figure 4-12  Viewing the Sample Needle

f. Remove the left panel (Figure 2-5).

Ram Nut

Vent Needle

Stripper Fork

Sample Needle
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g. Find the needle-moving knob on the left side of the system (Figure 4-13). When 
the wizard needle no longer moves, turn the knob clockwise to lower it or 
counterclockwise to raise it. It should remain approximately half-way between its 
highest and lowest positions.

Figure 4-13  Manually Moving the Needle

h. Use the 1/2-inch wrench to remove the ram nut (see Figure 4-12).

i. Use the 5/16-inch wrench to remove the needle.

6. Install the new sample needle:

a. Set the ferrule first (Figure 4-14), cinching it onto the replacement needle while 
both are outside the sample compartment. If the replacement needle comes with a 
pre-installed ferrule, go to step 6e.

b. Slide the compression screw and ferrule onto the needle’s blunt end.

c. Thread the compression screw into a standard 1/16-inch compression union. This 
forces the ferrule into place at the bottom of the compression union. Use the two 
open-end wrenches to tighten the compression screw 1/4-to-1/2 turn into the 
union, permanently crimping the ferrule to the needle.

d. Remove the compression union, and ensure the ferrule crimps properly to the 
needle.

Needle-Moving Knob
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Figure 4-14  Setting the Ferrule

e. Assemble the needle, ferrule, and compression screw onto the ram nut/needle 
assembly in the sample compartment.

f. Place the ram nut/needle assembly on top of the stripper fork in the sample 
compartment.

g. Use the 5/16-inch wrench to install the compression screw.

h. Install the ram nut.

Note: Reinstall the ram nut in its original position.

7. Click Next in the Needle Maintenance wizard to reposition the needle.

8. Click Close to close the Needle Maintenance wizard.

9. Reinstall the left side panel.

10. Click Exit to close the User Maintenance and Service Diagnostics dialog box.

11. Install the carousel, and close the sample door.

12. Select Operations > Inj Purge from the Interactive Mode window (Figure 3-3) to 
purge the injector (Section 3.4.2).

13. Let the sample compartment reach the operating temperature and the system 
equilibrate (Section 3.6.1).

Needle

Compression Screw

Ferrule

Compression Union
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4.5.3  Replacing the Syringe and Seal

Replace the syringe and seal when you need a different volume or if the syringe leaks or 
draws air.

The current instrument method specifies the syringe speed during its downstroke (filling) 
and upstroke (emptying). You can create an instrument method to increase syringe speed 
(Section 3.3.1).

Note: You should specify a relatively slow speed on completing syringe maintenance.

Required Materials

• New syringe, 5.0-mL

• Absorbent tissue

• Gloves

Procedure

1. Open the syringe compartment door (Figure 4-9).

2. Click  (Diagnostics) in the Interactive Mode window (Figure 3-3), and then 
click Diagnostics to open the User Maintenance and Service Diagnostics dialog box 
(Figure 4-11).

3. Click Syringe Replacement to open the Syringe Replacement wizard.

4. Unscrew the knurled nut at the bottom of the syringe (Figure 4-15).
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Figure 4-15  Removing the Syringe

5. Click Next. The bottom post drops to a point below the syringe bottom, releasing 
the lower end of the piston.

6. Turn the top of the syringe counterclockwise to remove it from its manifold. Hold 
the syringe by its middle or higher, and pull it down and away from you.

Knurled Nut

Syringe Body 

Lower End of Piston

Bottom Post

Syringe Piston

Bottom Post

Syringe 
Manifold
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Figure 4-16  Syringe Seal

7. Screw the top of the new syringe clockwise into the manifold, finger tightening it 
(Figure 4-16). Then turn it another 1/8- to-1/4 turn.

Note: You might need to guide the syringe bottom into the hole in the lower post.

8. Click Next. The lower post rises until it connects to the syringe bottom and engages 
the end of the piston.

9. After the syringe stops moving, install and tighten the knurled nut at the syringe 
bottom.

10. Click Close to close the Syringe Replacement wizard.

11. Inspect the syringe and tubing to ensure no bubbles remain. If you see bubbles, 
purge the injector (Section 3.4.2).

12. Close the syringe compartment door, and click Exit to close the User Maintenance 
and Service Diagnostics dialog box.

4.5.4  Replacing the Sample Loop

Replace the sample loop when you want to use one with a different volume or if the 
current one leaks or otherwise fails to function properly. The system is shipped with a 
200-µL calibrated sample loop.

Required Materials

• Open-end wrench, 1/4-inch

• New sample loop

• Absorbent tissue

• Gloves

Syringe Body

Syringe Seal
Top of Syringe
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Procedure

1. Allow the analysis compartment and the columns to cool (Section 3.4).

2. Open the analysis compartment door.

3. Use the wrench to loosen the two compression screws that connect the sample loop 
to ports 1 and 4 of the injection valve, then remove the sample loop (Figure 4-17).

Figure 4-17  Changing the Sample Loop

4. Install the new sample loop on ports 1 and 4, and tighten the two compression 
screws.

5. Record the exact loop volume, in µL, as labeled on the loop tag.

6. Close and lock the analysis compartment door.

7. Configure the sample loop for the volume labeled on its tag (Section 3.2.3).

8. Select Operations > Inj Purge from the Interactive Mode window (Figure 3-3).

9. Equilibrate the system (Section 3.6.1).

4.5.5  Replacing the Injection Valve

Replace the injection valve if it leaks or otherwise fails to function properly. The system is 
shipped with a 200-µL calibrated sample loop.

Required Materials

• Open-end wrench, 1/4-inch
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• Injection valve cartridge

• Absorbent tissue

• Gloves

• New injection valve

Procedure

1. Allow the analysis compartment and the columns to cool (Section 3.4).

2. Open the analysis compartment door.

3. Use the wrench to loosen the two compression screws that connect the sample loops 
to ports of the injection valve, then remove all the sample loops (Figure 4-17).

Note: Label the tubing as you remove it. 

4. Loosen the thumb screw at the bottom of the valve and remove it.

5. Install the new injection valve, making sure to align Port 3 in the 12 o’clock 
position. If you do not replace the valve correctly, it will not be flush with the valve 
holder body.

6. Install the sample loop in the correct ports as labeled, and tighten the two 
compression screws.

7. Close and lock the analysis compartment door.

8. Select Operations > Inj Purge from the Interactive Mode window (Figure 3-3).

9. Equilibrate the system (Section 3.6.1).

4.5.6  Replacing the Filter in a Sample Filter Vial 

You can reuse the sample filter vials by cleaning them with solvent, or you can replace the 
filter after each use. 

Required Materials

• New sample filter, 0.5-µm, or 2.0-µm for shear-sensitive samples

• Filter removal tool for 7-mL stainless steel vials

• Seal for vial plunger

• Absorbent tissue

����
Attention: To prevent damage to the sample management system, use only Alliance 
GPC 2000 sample filter vials to filter samples in the Alliance GPC 2000 Series system.
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• Gloves

Procedure

1. Remove and discard the crimp/seal cap, using the 10-mL decapping pliers 
(Figure 4-18).

2. Discard the remaining filtered sample.

3. Remove the plunger assembly.

4. Discard any sample residue from the vial cup, and clean the vial cup with solvent.

5. Remove the filter from the plunger assembly, using the filter removal tool, and then 
clean the plunger and the seal. Replace the plunger seal if it is damaged.

6. Install a new filter in the plunger.

7. To add sample to the vial, see Section 3.5.1.

Figure 4-18  Changing the Filter in a Sample Filter Vial

4.5.7  Replacing the Solvent Inline Filter 

The solvent inline filter filters solvent as it flows from the solvent management system to 
the sample management system. Replace this filter when it leaks, shows contamination, or 
elevates backpressure.

Required Materials

• Open-end wrenches, 5/8-inch (2) and 5/16-inch

• Squirt bottle containing a solvent compatible with the one you are using

• New solvent inline filter, 2-µm

Crimp/Seal Cap
 Plunger Top

 Seal (Open Side 
Away from Filter)Filter

7-mL Stainless Steel Vial Cup

Sample
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• Absorbent tissue

• Gloves

Procedure

1. Use a 5/8-inch wrench and the 5/16-inch wrench to separate the compression screw 
on the left side of the solvent inline filter from the inlet filter housing. Use a tissue to 
absorb the small amount of solvent that may leak.

2. Hold the outlet housing with a 5/8-inch wrench while you loosen the inlet housing 
with a second 5/8-inch wrench (Figure 4-19).

Figure 4-19  Replacing the Solvent Inline Filter

3. Tip the inlet housing upside down to remove the filter.

4. Wet the new filter with solvent.

5. Insert the new filter into the inlet housing.

6. Reconnect the inlet and outlet housings.

7. Tighten the compression screw in the inlet housing.

8. Purge the system:

• Select Operations > RI Purge from the Interactive Mode window (Figure 3-3). 
See Section 3.4.3 for details.

• Select Operations > Visc Purge (for sense-tube type GPCV viscometers only). 
See Section 3.4.4 for details.

9. Inspect the filter housing for leaks, and if necessary tighten it.

4.5.8  Replacing the Solvent Reservoir Filter

Replace the solvent reservoir filters when they show contamination.

Solvent Flow

Outlet Housing

Filter 

Inlet Housing
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Required Materials

• New solvent reservoir filter, 5-µm or 10-µm

• Absorbent tissue

• Gloves

Procedure

1. Remove the solvent reservoir cap from the solvent reservoir.

2. Remove the solvent reservoir filter from the solvent tubing.

3. Install the new solvent reservoir filter on the solvent tubing.

4. Reinstall the solvent reservoir cap on the solvent reservoir.

4.5.9  Removing the Head Nut and Head Piston Assembly

Remove the head nut and head piston assembly when you replace any of these parts:

• Piston seal and face seals

• Seal-wash seals (optional)

• Pistons

Required Materials

• Absorbent tissue

• Gloves

Procedure

1. Click Stop Flow in the Interactive Mode window (Figure 3-3) to stop solvent flow.

2. Click  (Diagnostics) to open the Diagnostics Mode window (Figure 4-10).

3. Click Diagnostics in the lower-right corner, to open the User Maintenance and 
Service Diagnostics dialog box (Figure 4-11).

4. Click Head Maintenance. When the Head Maintenance wizard appears, click Next.

5. Open the solvent compartment door. Place absorbent tissue under the purge valve, 
and then turn the purge valve one turn, counterclockwise, to open it (Figure 4-20).
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Figure 4-20  Solvent Management System Components

6. Select Primary or Accumulator. Click Next.

7. If seal-wash tubing is connected to ports on the piston chamber manifold, 
disconnect it.

8. Push in, and turn counterclockwise the piston chamber’s release ring. Click Next to 
release the piston and push it forward.

Figure 4-21 shows the head nut, head piston assembly, and check-valve components 
of a piston chamber.

TP01654
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Figure 4-21  Piston Chamber Components

9. Rotate the head nut counterclockwise, and remove it.

10. Remove these head piston assembly components from the piston chamber 
(Figure 4-22):

• Piston head with the J tube

• Seal-wash assembly (if fitted)

• Seal-wash housing washer (if fitted)

• Piston

Figure 4-22  Head Piston Assembly

11. Continue with the maintenance procedures in the following sections:

Head Nut

Release Ring

Manifold

Head Piston 
Assembly

Check-Valve Cartridge

Check-Valve Housing

Piston Chamber 
(Not Removable)

Piston

Seal-Wash 
Housing 
Washer

Seal-Wash 
Assembly

J Tube

Head
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• Section 4.5.10, Replacing the Piston Seal and Face Seals

• Section 4.5.11, Replacing the Seal-Wash Seals (Optional) (if fitted)

• Section 4.5.12, Replacing the Piston

• Section 4.5.13, Completing Piston Head Maintenance

4.5.10  Replacing the Piston Seal and Face Seals 

Replace the piston seal when you perform piston head maintenance (application 
dependent). Replace the inlet and outlet face seals after every two or three replacements of 
the piston seal. Before you begin, remove the head nut and head piston assembly 
(Section 4.5.9).

Required Materials

• Startup Kit:

– Seal insertion and removal tool

– Priming syringe

• New seals

• Squirt bottle containing a solvent compatible with the one you are using

• Absorbent tissue

• Gloves

• Clean, flat object for applying pressure to seals

• Plastic tweezers

Procedure

1. Use the plastic end of the seal insertion and removal tool to remove the piston seal 
from the head (Figure 4-23).

����
Attention: To avoid scoring the sealing surfaces, do not use a sharp or metallic tool to 
remove or install seals.
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Figure 4-23  Piston and Face Seal Placement

2. Clean the seal opening with tissues if you see residue, and wet the insertion and 
removal tool, seal opening, and new piston seal with solvent.

3. Place the new piston seal on the seal insertion and removal tool with the spring side 
facing the tip of the tool.

4. Insert the tip of the tool into the piston seal opening, then remove the tool.

5. Use plastic tweezers to remove the face seals from the seal openings in the head 
(Figure 4-23).

6. Clean the seal opening with tissue if you see residue, and wet the new seals and seal 
openings with solvent.

7. Place the new face seals in the face seal openings in the head.

8. Use a solvent-cleaned, flat object to firmly press the face seals into the openings on 
the pump head.

4.5.11  Replacing the Seal-Wash Seals (Optional)

Replacing the seal-wash seals involves replacing the seal-wash face seal, two tube seals, 
and the piston-wash seal (Figure 4-24). 

Before you begin, remove the head nut and head piston assembly (Section 4.5.9).

Note: See Chapter 5 when isolating seal-wash problems.

Piston Seal
(Spring Side 
Faces Head)

Head

Inlet Face Seal

J Tube

Outlet Face Seal
Maintaining the Sample Manager System (SMS) 135



Required Materials

• Startup Kit:

– Seal insertion and removal tool

– Priming syringe

• New seal-wash face seal, tube seals, and piston-wash seal

• Squirt bottle containing a solvent compatible with your solvents

• Absorbent tissue

• Gloves

• Plastic tweezers

Procedure 

1. Use the plastic end of the seal insertion and removal tool to remove the 
piston-wash seal from its seat. Repeat this procedure for each tube seal 
(Figure 4-24).

Figure 4-24  Seal-Wash Assembly Seals

2. Use the plastic tweezers to remove the seal-wash face seal.

3. Clean the seal openings with tissues if you see residue, and wet each new seal, seal 
opening, and the seal insertion and removal tool with solvent.

����
Attention: To prevent system damage, use a seal-wash solvent that is miscible with the 
solvent in the system and also compatible with the seal-wash seals.

Consult Appendix C for solvent compatibility information.

Seal-Wash Face Seal

Tube Seal
(Spring Side Faces In)Piston-Wash Seal 

(Spring Side Faces In)

Tube Seal
(Spring Side Faces In)

Seal-Wash Housing
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4. Place the new piston seal on the seal insertion and removal tool with the spring side 
facing the tool tip.

5. Insert the tool tip into the seal opening, and remove the tool. Repeat this procedure 
for each tube seal.

6. Press the new seal-wash face seal into the opening with your thumb.

7. Install the seal-wash housing washer (Figure 4-22).

8. If you intend to replace the piston, proceed with Section 4.5.12; otherwise, proceed 
with Section 4.5.13.

4.5.12  Replacing the Piston 

Replace the primary and accumulator piston at the same time. Before you begin, remove 
the head nut and head piston assembly (Section 4.5.9).

Required Materials

• New pistons

• Absorbent tissue

• Gloves

Procedure

1. Inspect the piston for damage, excessive wear, or residue.

2. If the piston or seal shows signs of damage, excessive wear, or residue, replace it 
(Section 4.5.10).

4.5.13  Completing Piston Head Maintenance

1. Click Next at Head Maintenance, Part 3, of the Head Maintenance Wizard 
(Section 4.5.9).

2. Reinstall the piston, washer, seal-wash housing, and head. The head alignment pin 
should be correctly positioned, and the J-tube should face downward (Figure 4-22).

3. Replace the head nut, and tighten it.

4. Turn the release ring clockwise. Withdraw it (Figure 4-21), and click Next.

5. If the seal-wash option is installed, connect the seal-wash tubing to ports on the 
piston chamber manifolds. Click Next.

6. Click Exit to close the Head Maintenance wizard.

7. Repeat Section 4.5.9, through Section 4.5.13 for the other piston.
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8. Turn the purge valve counterclockwise to close it, and close the solvent 
compartment door.

9. Prime and purge the solvent management and seal wash systems to draw solvent 
into the piston cavities and through the seal wash before you start pumping them 
(Section 3.4).

4.5.14  Replacing a Check Valve

Replace both check valves during the same service interval.

Note: See Chapter 5 for details for how to identify check valve malfunctions.

Required Materials

• Open-end wrenches, 1/2-inch and 5/16-inch

• New inlet check-valve cartridge, 2

• Squirt bottle containing a solvent compatible with your solvents

• Priming syringe (Startup Kit)

• Absorbent tissue

• Gloves

Procedure

1. Open the solvent compartment door.

2. Hold the check-valve housing with the 1/2-inch wrench as you disconnect the 
compression screw with the 5/16-inch wrench (Figure 4-25).
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Figure 4-25  Inlet Check Valve

3. Use the 1/2-in. wrench to disconnect the check-valve housing from the piston 
chamber inlet port.

4. Invert the check-valve housing, removing the old check-valve cartridge.

5. Wet the new cartridge with solvent.

6. Insert the cartridge into the check-valve housing. 

7. Insert the check-valve housing into the piston chamber housing.

8. Finger-tighten the housing, afterward using the 1/2-in. wrench to tighten it 1/8-turn.

9. Hold the check-valve housing with the 1/2-in. wrench as you reinstall and tighten 
the compression screw inside it with the 5/16-in. wrench.

10. Close the solvent compartment door.

11. Prime the solvent management system (Section 3.4.1). See “Priming the Pump, 
Manual Prime Wizard” in the Alliance GPC 2000 Series System Help.

����
Attention: The arrow on the check-valve cartridge must point toward the 
piston chamber.

Check-Valve Housing

Check-Valve Cartridge

Compression Screw

Manifold
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4.5.15  Replacing Tubing

Replace the following tubing when leaks, clogs, kinks, deterioration, or contamination 
affect fluid flow:

• Solvent reservoir

• Drip tray:

– Syringe waste

– Refractometer waste

• Intercolumn

• Tubing between the injection valve and columns

• Degasser

• Interdetector (Alliance GPCV 2000 system only)

Figure 1-5 illustrates the solvent flow path and provides tubing descriptions and part 
information.

4.6  Replacing, Adding, or Removing Columns

Column life span is reduced by contamination from samples and solvents, frequent solvent 
changeover, improper handling and storage, and excess temperature or pressure. For best 
results, see the manufacturer’s instructions for the columns. Use HPLC-grade solvents and 
filter all solvents through a 0.5-µm filter.

General Guidelines for Styragel Columns

• Use solvents compatible with the columns to prevent gel shrinkage and irreversible 
channeling.

• Allow a maximum flow rate of 2.0 mL/min and a maximum backpressure of 500 psi 
(30 bars) per column.

• Protect the columns from vibration and mechanical shock.

• Protect the columns from rapid changes in pressure, this can result from rapid 
composition changes of the solvent during solvent changeover and from 
temperature or flow rate changes.

• When changing to a solvent of different viscosity, use a flow rate of 0.1 mL/min to 
prevent excess backpressure.
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• Dissolve samples in the solvent to avoid precipitation.

• Dedicate each column, or column set, to a specific application. Frequent switching 
of samples and solvents accelerates column deterioration and loss of resolution.

• Maintain a solvent flow of 0.1 mL/min or greater at all times. Keep columns filled 
with solvent.

If the column set performance deteriorates, you can replace the entire column set, or 
isolate the problematic column and replace it. To isolate a problematic column, remove 
one column at a time, and install it in a well-performing column bank. Run a known 
standard, and then compare results.

 

Required Materials

• Styragel HMW, HT, or HR columns (Table B-3), Ultrahydrogel columns 
(Table B-4), or HSP gel columns (Table B-5)

• Open-end wrenches, 5/16-inch and 5/8-inch

• Small waste container for solvent

• Absorbent tissue

• Gloves

Procedure

If you are using Styragel columns for high-temperature chromatography in solvents such 
as TCB or ODCB, switch the column to the selected solvent at an elevated temperature. 
Refer to the Styragel Column Care and Use Manual for details about Styragel columns.

1. Allow the analysis compartment to cool, and maintain a solvent flow of 0.1 mL/min.

2. Open the analysis compartment door.

����
Attention: Use LS-compatible or preconditioned column(s) for optimal 
results in LS or viscometry. This minimizes detector contamination by 
particulates that manifest themselves as signal noise.

Caution: To avoid burn injuries, always allow adequate time to cool the system before 
you perform maintenance or troubleshooting. Wear protective clothing whenever you 
open the sample or analysis compartment.

����
Attention: To prevent column damage, use extreme care whenever you change any 
system parameter, including temperature, pressure, flow rate, solvent type, and/or solvent 
concentration.
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3. If columns are installed in the analysis compartment, use the 5/16-in. and 5/8-in. 
wrenches to disconnect the column tubing (that connects to ports 1 and 2 of the 
column bypass valve) and remove the column set.

4. If the new columns will use a solvent different from the one old columns used, 
follow these steps:

a. Install a zero-dead-volume union in place of the columns.

b. Convert the system to the solvent the new columns will use.

c. Purge the system to remove any micro particulates and old solvent (Section 3.4.6, 
Changing a Solvent).

d. Remove the zero-dead-volume union.

5. To install a column, see Section 2.3.3, Installing Columns.

6. Close and lock the analysis compartment door.

7. Equilibrate the system (Section 3.6.1, Equilibrating the System).

4.7  Maintaining Data Storage

Periodically storing, backing up, and archiving data files and log files frees disk space and 
helps prevent loss of data if the hard drive fails. You can store data on CDs using the CD 
R/W drive or on a networked server if the system is connected to one. 

Use Windows 2000-compatible software to check for viruses.

Ensure that the latest Microsoft Windows critical updates and service packs are installed.

The drives of the onboard CPU consist of:

• Floppy disk drive

• Hard drive

• CD R/W drive

����
Attention: Waters recommends that you purge new columns individually to 
remove any micro particulates.

����
Attention: Waters recommends that you install only Waters-supplied software on the 
Alliance GPC 2000 Series system onboard CPU. Installation of other software may cause 
improper operation and/or poor performance of your GPC 2000 system.
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4.7.1  Backing Up Data

Each injection during a sample set run, generates a sample set containing multiple sets of 
AIA (Analytical Instruments Association) data files, such as refractometer, viscometer, 
vapor sensor, light scattering detector, and temperature sensor responses. If you connect to 
the Empower database, detector data files are also sent there via the Empower storage 
server. The refractometer, viscometer, light scattering files and other data files remain in 
the Waters\GPC2000\SSArchive\Sample Sets folder until you delete them. The data 
channels also remain available for display in Interactive Mode for 72 hours. For 
troubleshooting purposes, you can view a running recording of the data channels so that 
you can compare injections before and after a problem arises.

You can manually transfer all AIA files of a sample set run into any Empower database 
after the injection, using the Sample Set Mover (Section 3.7.3).

To back up data using a CD R/W, select files for replication, and drag them to the CD 
drive.

4.7.2  Restoring Data

To restore data from a CD, selected files can be dragged and dropped to the appropriate 
drive, resulting in file replication. A Windows wizard provides a dialog decision box that 
requires you to overwrite the original file, or create a new file via a Save As command.

Data files are located in C:\Program Files\Waters\GPC2000\SSArchive\SampleSets.

4.7.3  Updating the Software

Note: Remove all Empower options before updating the software.

To update the Alliance GPC 2000 software or the Empower software from a CD

1. Open the solvent compartment door.

2. Install the CD in the CD drive.

3. From the Windows desktop, access My Computer.

4. Double-click the CD-Drive to view all the files on the CD.

5. Open the file labeled Install Instructions.Txt, and follow the installation 
instructions.

6. Remove the CD from the CD drive once the installation is completed.

7. Store the CD in a safe location for future reference.
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8. Close the solvent compartment door.
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Chapter 5
Troubleshooting the System

This chapter describes methods for diagnosing problems with an Alliance GPC 2000 
Series system. Two assumptions apply to the troubleshooting information in this chapter:

• System performance has degraded compared with previous performance.

• All preventive maintenance tasks have been performed correctly and on time.

For detailed troubleshooting information, see to the Error Messages, General System 
Troubleshooting, Instrument Operation Troubleshooting, and Instrument Performance 
Troubleshooting topics in the Alliance GPC 2000 Series System Help. If the suggestions in 
this chapter do not solve the problem, call Waters Technical Service (see Appendix D).  

5.1  Analyzing the Problem

Perform a preliminary inspection:

• Inspect your system for leaks, tubing blockages and connections, cable connections, 
temperature problems, and other areas that you can quickly check.

• Check the values specified in the Instrument Configuration Editor and the current 
instrument method to ensure that operating parameters such as temperature and flow 
rate are set correctly.

You can take several approaches to analyzing and diagnosing problems with an Alliance 
GPC 2000 Series system.

To locate the problem’s source,

• use the status LEDs in the Diagnostics mode window and in the Diagnostics dialog 
boxes for Solvent Management, Sample Management, and Detectors (see 
Section 5.1.1).

• read the Message Board for recent error, warning, and information messages that 
may be related to the problem (see Section 5.1.2).

Caution: To avoid injury from burns, allow the system enough time to cool before you 
perform maintenance or troubleshooting. Wear protective clothing whenever you open the 
sample or analysis compartment. 
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Depending on your findings from these initial approaches, you may perform these 
diagnostic tests:

• Noise and drift (see Section 5.2.1)

• Temperature control (see Section 5.2.2) 

• Baseline investigation (see Section 5.3) 

• Peak investigation (see Section 5.4)

You may also use the appropriate troubleshooting tables to help you resolve 
hardware-based problems (see Section 5.5 to Section 5.8).

5.1.1  Using the Onboard Diagnostics
Use the LEDs to obtain specific diagnostic information about the solvent management 
system, sample management system, columns, and detectors.

Gathering Diagnostic Information from LEDs:

1. Check the status LED on the front of the Alliance GPC 2000 Series system:

• If the LED is red, an error exists; proceed to step 2.

• If the LED is yellow, there is a warning; allow sufficient equilibration, and then 
proceed to step 2 if the LED remains yellow.

• If the LED is green, proceed to Section 5.1.2, Checking the Message Board and 
Logs.

2. Click  (Diagnostics) in the Alliance GPC 2000 Series system window. The 
Diagnostics Mode appears (Figure 5-1).
146 Troubleshooting the System



Figure 5-1  Checking the Onboard Diagnostics

3. To check the component diagnostics, click the More button near an LED. When you 
do so, these dialog boxes appear:

• Solvent Management Status Indicators (Figure 5-2).

• Sample Management Status Indicators (Figure 5-3).

• Detection Status Indicators (Figure 5-4).

For information about the yellow or red status LEDs that may appear in the 
diagnostic dialog boxes, see “Solvent Management Diagnostics Dialog Box,” 
“Sample Management Diagnostics Dialog Box,” and “Detection Diagnostics Dialog 
Box” in the Alliance GPC 2000 Series System Help.
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Figure 5-2  Solvent Management Status Indicators Dialog Box

Figure 5-3  Sample Management Status Indicators Dialog Box
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Figure 5-4  Detection Status Indicators Dialog Box

4. Determine the components that contribute to, or that are affected by, the symptoms. 
Based on your findings, use the appropriate troubleshooting tables to help you solve 
hardware-based problems:

• Section 5.5, Correcting Solvent Manager Problems

• Section 5.6, Correcting Sample Manager Problems

• Section 5.7, Correcting Detector Problems

• Section 5.8, Correcting Miscellaneous Problems

5. If the Detection LED in Diagnostics Mode (see Figure 5-1) is yellow or red, or if 
one of the viscometer LEDs in the Detection Diagnostics dialog box (see 
Figure 5-4) is yellow or red, click Cal Info in the Diagnostics mode (see Figure 5-1) 
for details about viscometer calibration.

6. To return to normal operations, select Operations > Smart Reinit.

5.1.2  Checking the Message Board and Logs
Use the Message Board to obtain chronologically ordered information, warning, and error 
messages about the system. Also review the Log Book for the service records. Likewise, 
review your maintenance records for previously documented information about the 
problem.

Using the Message Board:

1. Click  (Message Board).
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2. Review recent error, warning, and information messages.

3. Click  (Log Book).

4. Review the service records.

5. Review your own maintenance records.

5.2  Performing Diagnostic Tests

You can test for these behaviors:

• Noise and drift of the baseline (Section 5.2.1, Testing Noise and Drift)

• Ability of the system to detect temperature overheating (Section 5.2.2, Testing 
Temperature Control)

5.2.1  Testing Noise and Drift 
For more detail about testing baseline noise and drift, see “Calculating Noise and Drift of 
Channel Data” and “Noise and Drift Dialog Box” in the Alliance GPC 2000 Series System 
Help.

Testing the Noise and Drift of an Injection

1. Purge the injector, refractometer, and (possibly) the sense-tube viscometer, and then 
allow the system to equilibrate.

2. Inject a standard using Sample Set mode (see Section 3.7.2, Running a Sample Set).

3. Review the results.

4. Calculate the noise and drift of a channel (Figure 5-5):

a. Right-click the pane displaying the chromatogram or trace, and then select a 
channel.

b. Right-click the pane, and then select Noise and Drift.

c. Select a time interval.

d. Click Calculate.

5. Record the noise and drift values that appear in the Results area.
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Figure 5-5  Noise And Drift Dialog Box

6. Click Exit to close the Noise And Drift dialog box.

You can test the noise and drift for any of the AIA channels- in a sample set. 

5.2.2  Testing Temperature Control
The OverTemp test sets the hardware overtemperature setting 5 °C below the current 
reading for the analysis (detector) compartment and both areas of the sample 
compartment (sample needle or injector and carousel). If system hardware temperature 
circuits are functioning correctly, the system detects the simulated overtemperature 
condition in each compartment and displays messages on the monitor screen.

For more detail about testing temperature control, see “User Maintenance and Service 
Diagnostics Dialog Box” and “Performing User Maintenance Procedures” in the Alliance 
GPC 2000 Series System Help.

Performing the overtemp test

1. Click  (Diagnostics). The Diagnostics Mode appears in the Alliance GPC 2000 
Series window (see Figure 5-1).

2. Click Diagnostics. The User Maintenance and Service Diagnostics dialog box 
appears (Figure 5-6).
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Figure 5-6  User Maintenance and Service Diagnostics Dialog Box

3. Click OverTemp Test.

4. If the overtemperature circuits test OK, message boxes appear, verifying that the 
compartments pass the overtemperature hardware sensor test.

5. Click OK to close each message box.

5.3  Optimizing the Baseline

Noisy Refractometer

1. Purge the refractometer (see Section 3.4.3, Purging the Refractometer).

2. Allow adequate time for equilibration (see Section 3.6.1, Equilibrating the System).

Noisy Viscometer

Note: You must measure viscometer noise at a flow rate ensuring that the transducer P1 
pressure is above 3 kPa and the transducer P2 pressure is above 30 kPa. The system 
must be properly and equilibrated.

1. Let the viscometer temperature stabilize.

2. Purge the viscometer (see Section 3.4.4).

3. Set the flow rate as indicated in the note above.

4. Calibrate the viscometer (in Interactive mode, select Operations > Visc. Cal, or see 
Section 3.4.5).

5. Allow adequate time for equilibration (see Section 3.6.1, Equilibrating the System).
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This section describes symptoms, causes, and corrective actions for baseline-related 
problems:

• Noncyclic or erratic noise (Table 5-1)

• Short-term cyclic noise (Table 5-2)

• Long-term cyclic noise (Table 5-3)

• Drift (Table 5-4)

• Noise spikes (Table 5-5)
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5.3.1  Noncyclic Baseline Noise
Use Table 5-1 to troubleshoot noncyclic (erratic) baseline noise.

Table 5-1  Noncyclic Baseline Noise

Possible Cause Corrective Action

Large air bubble 
trapped in the refracto-
meter flow cell

• Purge the refractometer (see Section 3.4.3).

• Ensure the solvent is properly degassed (see
Section 3.3.3).

Small air bubbles trav-
eling through the flow 
path

• Ensure the solvent is properly degassed (see
Section 3.3.3).

System not stabilized 
or equilibrated

Allow sufficient time for the baseline to stabilize (see
Section 3.6.1). Note the operating conditions of your applica-
tion (such as solvent type). 

Solvent contaminated • Discard the contaminated solvent.

• Clean the solvent reservoirs.

• Replace the solvent inline filter element (see
Section 4.5.7).

• Prepare and filter fresh solvent using only high-quality 
reagents and HPLC-grade solvents.

• Purge the injector (see Section 3.4.2) and equilibrate the 
system (see
Section 3.6.1).

Detector flow cell 
leaking

Call Waters Technical Service (see Appendix D).

Refractometer and/or 
viscometer not 
stabilized

Allow sufficient time for the baseline to stabilize (see
Section 3.6.1). 

Refractometer flow 
cell contaminated

Purge the refractometer (see Section 3.4.3). 

Detector electronics 
problem

Call Waters Technical Service (see Appendix D).
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5.3.2  Short-Term Cyclic Baseline Noise

Use Table 5-2 to troubleshoot short-term (seconds to minutes) cyclic baseline noise.

Column(s) 
contaminated

Replace all columns with a union or a known good column of 
the same type (see Section , Procedure and Section 2.3.3, 
Installing Columns). Equilibrate (see Section 3.6.1) and 
monitor the baseline. If the problem stops, discard the old 
column and install a new one.

If the problem continues, consider the following:

• Solvent properties such as miscibility (see Appendix C, 
Solvent Considerations).

• Contaminated solvent (see the Solvent Contaminated 
Possible Cause listed above).

• Contaminated solvent inline filter or solvent reservoir filter 
(see Section 4.5.7 or Section 4.5.8).

• Improperly connected reserve bottle (see Section 2.3.1).

Cable loose or improp-
erly connected to the 
external data-handling 
system

• Ensure the correct output signal is properly connected to the 
data-handling device (see Section 2.4.5).

• Ensure that output signal switch settings are in the proper 
positions (see Section 3.2.6).

Cycling equipment or 
radio frequency (RF) 
interference

• Isolate the system from other nearby equipment, especially 
devices with large electric motors.

• Ensure proper circuit grounding and determine line voltage 
quality.

• If necessary, relocate the system to an area where RF is not a 
problem.

Table 5-2  Short-Term Cyclic Baseline Noise

Possible Cause Corrective Action

Erratic solvent 
manager pressure or 
pulsations

Determine and correct the source of erratic pressure. If erratic 
pressure continues, see Section 4.4.3, to check solvent manager 
components.

Table 5-1  Noncyclic Baseline Noise (Continued)

Possible Cause Corrective Action
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Solvent manager 
tubing loose, bent, or 
blocked

Inspect the tubing. If loose, tighten it. If bent, straighten it. If 
blocked, replace (see Section 4.5.15). 

Solvent miscibility 
problems during 
solvent changeover 

Verify the miscibility of solvents and/or change to more 
miscible solvents (see Appendix C, Solvent Considerations).

Large air bubble in the 
refractometer flow cell

• Purge the refractometer (see Section 3.4.3).

• Ensure the solvent is properly degassed (see Section 3.2.1).

Dirty or malfunc-
tioning inlet check 
valve

Replace the inlet check valve (see Section 4.5.14).

Worn piston seal(s) Replace the piston seals (see Section 4.5.10).

Cycling equipment or 
radio frequency (RF) 
interference

• Isolate the system from other nearby equipment, especially 
devices with large electric motors.

• Ensure prompt circuit grounding and determine line voltage 
quality.

• If necessary, relocate the system to an area where RF is not a 
problem.

Table 5-2  Short-Term Cyclic Baseline Noise (Continued)

Possible Cause Corrective Action
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5.3.3  Long-Term Cyclic Baseline Noise

Use Table 5-3 to troubleshoot long-term (minutes to hours) cyclic baseline noise.

5.3.4  Baseline Drift

Use Table 5-4 to troubleshoot baseline drift.

Table 5-3  Long-Term Cyclic Baseline Noise

Possible Cause Corrective Action

Ambient temperature 
fluctuations

• Stabilize the operating environment temperature to allow 
full equilibration (see Section 3.6.1). 

• Ensure the analysis compartment set point is at least 5 °C 
above ambient temperature.

• Relocate the system to a thermally stable, draft-free 
environment.

• Avoid placing the system in direct sunlight or near 
heating/cooling vents.

Solvent being recycled 
from waste outlet back 
through the system

Use only fresh, filtered, HPLC-grade solvents for your applica-
tion. Unless necessary, do not recycle solvent through the 
system. 

Cycling equipment or 
radio frequency (RF) 
interference

• Isolate the system from other nearby equipment, especially 
devices with large electric motors.

• Ensure prompt circuit grounding and determine line voltage 
quality.

• If necessary, relocate the system to an area where RF is not a 
problem.

Table 5-4  Baseline Drift

Possible Cause Corrective Action

System not stabilized 
or equilibrated

Allow sufficient time for the baseline to stabilize (see 
Section 3.6.1). Note the operating conditions of your applica-
tion, such as solvent type.
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Ambient temperature 
fluctuations

• Stabilize the operating environment temperature to allow 
full equilibration (see Section 3.6.1).

• Ensure the analysis compartment set point is at least 5 °C 
above ambient.

• Relocate the system to a thermally stable, draft-free 
environment.

• Avoid placing the system in direct sunlight or near 
heating/cooling vents.

Solvent contaminated 
or degraded

• Discard the contaminated solvent.

• Clean the solvent reservoirs.

• Replace the solvent inline filter element (see
Section 4.5.7).

• Prepare and filter fresh solvent using only high-quality 
reagents and HPLC-grade solvents.

• Purge the injector (see Section 3.4.2) and equilibrate the 
system (see Section 3.6.1).

Solvent improperly 
degassed

• Degas the solvents (see Section 3.2.1).

• Equilibrate the system (see Section 3.6.1).

Detector flow cell 
leaking

Call Waters Technical Service (see Appendix D).

Column(s) 
contaminated

Replace all columns with a union or with a known good 
column of the same type (see Section 2.3.3). Equilibrate (see 
Section 3.6.1) and monitor the baseline. If the problem stops, 
discard the old column and install a new column.

If the problem continues, consider these possible causes:

• Solvent properties such as miscibility (see Appendix C, 
Solvent Considerations).

• Contaminated solvent (see the Solvent Contaminated 
Possible Cause listed above).

• Contaminated solvent inline filter or solvent reservoir filter 
(see Section 4.5.7 or Section 4.5.8).

• Improperly connected reserve bottle (see Section 2.3.1)

Table 5-4  Baseline Drift (Continued)

Possible Cause Corrective Action
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5.3.5  Noise Spikes

Use Table 5-5 to troubleshoot noise spikes.

Solvent being recy-
cled from waste outlet 
back through the 
system

Use only fresh, filtered, HPLC-grade solvents for your applica-
tion. Unless necessary, do not recycle solvent through the 
system. 

Leak(s) in system • Inspect all fittings for leaks. Tighten (do not overtighten) 
leaky fittings.

• If the leak continues, replace the fitting and ferrule.

Solvent contains a 
stabilizer that is 
degraded or changed 

Use a different stabilizer. Separations may require adjustment 
if changing the stabilizer.

Refractometer and/or 
viscometer not 
stabilized

Allow sufficient time for the baseline to stabilize (see 
Section 3.6.1). 

Change in ambient 
temperature 

• Stabilize operating environment temperature. 

• Ensure the analysis compartment set point is at least 5 °C 
above ambient temperature.

• Relocate the system to a thermally stable, draft-free 
environment.

• Avoid placing the system in direct sunlight or near 
heating/cooling vents.

Contaminated refracto-
meter flow cell

Purge the refractometer (see Section 3.4.3). 

Table 5-5  Noise Spikes

Possible Cause Corrective Action

Small air bubbles trav-
eling through the flow 
path

Ensure the solvent is properly degassed (see Section 3.3.3). 

Pump head cavitation Decrease the flow rate (see Section 3.3.3).

Table 5-4  Baseline Drift (Continued)

Possible Cause Corrective Action
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5.4  Optimizing Chromatographic Peaks

This section explains how to optimize chromatographic peaks and correct problems such 
as these:

• No peaks – see Table 5-6

• Smaller-than-expected peaks – see Table 5-7

• Broad peaks – see Table 5-8

• Other types of abnormal peaks, including double, shoulder, fronting, tailing, 
flat-topped, and negative peaks – see Table 5-9

See the “Acquisition Troubleshooting” in the Alliance GPC 2000 Series System Help.

Particles in refracto-
meter or viscometer

Purge the refractometer (see Section 3.4.3) and the viscometer 
(see Section 3.4.4). 

Improper grounding of 
system electrical 
connections 

• Use a shielded signal cable and attach the shield to one 
device only.

• Plug the system into another outlet on a different electrical 
circuit. If a separate outlet is unavailable, use a power line 
conditioner.

Cycling equipment or 
radio frequency (RF) 
interference

• Isolate the system from other nearby equipment, especially 
devices with large electric motors.

• Ensure proper circuit grounding and determining line 
voltage quality.

• If necessary, relocate the system to an area where RF is not a 
problem.

Detector electronics 
problem

Call Waters Technical Service (see Appendix D).

Table 5-5  Noise Spikes (Continued)

Possible Cause Corrective Action
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5.4.1  No Peaks

Consult Table 5-6 when troubleshooting chromatograms when peaks are expected but 
absent. 

Table 5-6  Troubleshooting – No Peaks

Possible Cause Corrective Action

Injector problem

• Wrong vial

• No vial

• Insufficient sample 
volume

• Incorrect injection

• Blocked needle

• Leaking syringe 
seal

• Ensure samples are prepared and installed in the carousel 
correctly (see Section 3.5).

• Check the vial number for the injection in the sample set 
method or the carousel view.

• Replace the needle if it is blocked or damaged (see 
Section 4.5.2).

• Inspect the syringe to ensure is no air is in it and no solvent 
leaks past the seal.

No flow or low flow

• Pump power not on 
or not delivering 
solvent

• Reservoir low or 
out of solvent

• Blocked inlet lines

• Blocked solvent 
reservoir inlet filter 

• Observe whether solvent is flowing from the detector waste 
outlet. Ensure pump is on and is delivering solvent.

• Refill the reservoir with filtered solvent.

• Inspect tubing for blockages and replace if necessary.

• Replace the solvent inlet filter. 

Incorrect detector 
settings

Verify the detector settings (see Section 3.3.6).

Detector output not 
zeroed

Zero the detector baselines by selecting RI Autozero and/or 
Visc. Autozero from the Operations menu. See the “Autoze-
roing the Refractometer” and “Autozeroing the Viscometer” in 
the Alliance GPC 2000 Series System Help.

Other detector 
problem (flow cell, 
power supply, 
electronics)

Call Waters Technical Service (see Appendix D).
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5.4.2  Smaller-Than-Expected Peaks

Consult Table 5-7 when troubleshooting peaks that are smaller than expected (indicating a 
loss of sensitivity).

Cable improperly 
connected to external 
data-handling system 

Ensure that the correct output signal is connected to the 
data-handling device and that related output signal switch 
settings are in the proper positions (see Section 2.4.5, and 
Section 3.2.6). 

Incorrect solvent • Prepare new solvent (see Section 3.4.6).

• If the system backpressure is also high, check for sample 
precipitation.

Degraded sample • Verify sample integrity and review the sample preparation 
process.

• Replace with a fresh sample.

• Reduce the total incubation time in the sample carousel at 
elevated temperature, if possible. 

Table 5-7  Troubleshooting Smaller Than Expected Peaks

Possible Cause Corrective Action

Wrong injection 
volume

Select an appropriate injection volume. See the “Making a 
Single Injection in Interactive Mode” in the Alliance GPC 2000 
Series System Help.

Incorrect size of 
sample loop

Verify the size of the sample loop in use (see Section 3.2.3). If 
necessary, replace with a sample loop of another size (see 
Section 4.5.4).

Incorrect detector 
settings 

Verify the detector settings in the Instrument Method Editor 
(see Section 3.3.6).

Detector output not 
zeroed

Zero the detector baselines by selecting Operations > RI 
Autozero and/or Visc. Autozero. See the “Autozeroing the 
Refractometer” and “Autozeroing the Viscometer” in the Alli-
ance GPC 2000 Series System Help.

Table 5-6  Troubleshooting – No Peaks (Continued)

Possible Cause Corrective Action
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Incorrect output signal 
to external 
data-handling system 

Ensure the correct output signal is connected to the 
data-handling device and that related output signal switch 
settings are in the proper positions. See Section 2.4.5, and 
Section 3.2.6. 

Contaminated refracto-
meter flow cell

Purge the refractometer (see Section 3.4.3).

Injector problem:

• Wrong vial

• No vial

• Insufficient sample 
volume

• Incorrect injection

• Blocked needle

• Leaking syringe 
seal

• Ensure samples are prepared and installed in the carousel 
correctly (see Section 3.5).

• Determine the correct vial number for the injection in the 
sample set method or the carousel view.

• Replace the needle if it is blocked or damaged (see 
Section 4.5.2).

• Inspect the syringe to ensure no air is in the syringe or no 
solvent leaks past the seal.

Sample too viscous Dilute the sample or decrease the syringe draw rate (see 
Section 3.3.3).

Table 5-7  Troubleshooting Smaller Than Expected Peaks (Continued)

Possible Cause Corrective Action
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5.4.3  Broad Peaks

Use Table 5-8 to troubleshoot broad peaks. 

Table 5-8  Troubleshooting Broad Peaks

Symptom Possible Cause Corrective Action

Early-eluting 
peaks are broad

Inline filter, 
column inlet, or 
connecting tubing 
partially blocked

• If the inline filter has particle buildup, replace 
it (see Section 4.5.7).

• If the column inlet has particle buildup, replace 
it.

• Replace any blocked tubing (see
Section 4.5.15). 

Injector problem:

• Sticking or 
leaking 
injection valve

• Blocked or 
damaged 
needle

• Plugged 
injection port

• Ensure samples are prepared and installed in 
the carousel correctly (see Section 3.5).

• Replace the needle if it is blocked or damaged 
(see Section 4.5.2).

• Call Waters Technical Service to repair an 
injection port (see Appendix D).

Incorrect size of 
sample loop in 
injector

Replace the sample loop with one of proper size 
(see Section 4.5.4).

Bandspreading Flow path 
problems

Look for injector problems, tubing/fittings prob-
lems, leaking refractometer flow cell, or column 
deterioration.

Large particle size 
(20-µm columns) 
for high-molec-
ular-weight 
polymers

Use axial dispersion correction in Empower 
GPC/GPCV software.
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5.4.4  Other Abnormal Peaks

Consult Table 5-9 when troubleshooting other types of abnormal peaks, including double, 
shoulder, fronting, tailing, flat-topped, and negative peaks. 

All peaks are 
broad 

Incorrect column 
size or type

Verify the source or type of the column (see 
Section 2.3.3). Use a column identical to that 
used during methods development.

Ambient tempera-
ture change

• Stabilize the operating environment 
temperature. 

• Ensure the analysis compartments set point is 
at least 5 °C above ambient.

• Move system to a thermally stable, draft-free 
environment.

• Avoid placing the system in direct sunlight or 
near heating/cooling vents.

System not stabi-
lized or 
equilibrated

Allow sufficient time for the baseline to stabilize 
(see Section 3.6.1). Note the operating conditions 
of your application (such as solvent and tempera-
ture set points).

Column contami-
nated or damaged

Determine the plate count. If the plate count is 
low, replace the column (see Section 2.3.3).

Table 5-9  Troubleshooting Other Abnormal Peaks

Symptom Possible Cause Corrective Action

Double 
peaks/shoulder 
peaks 

Column inlet 
partially blocked

Inspect for particle buildup:

• If the inline filter has particle buildup, replace 
it (see Section 4.5.7).

• If the column inlet has particle buildup, replace 
it (see Section 4.5.7).

• Replace any blocked tubing (see
Section 4.5.15). 

Column contami-
nated or degraded 
(due to voiding)

Determine the column plate count. If it is low, 
replace the column (see Section 2.3.3).

Table 5-8  Troubleshooting Broad Peaks (Continued)

Symptom Possible Cause Corrective Action
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Fronting peaks Column contami-
nated or degraded 
(due to voiding)

Determine the column plate count. If it is low, 
replace the column (see Section 2.3.3, Installing 
Columns).

Tailing peaks Column contami-
nated or degraded 
(due to voiding)

Determine the column plate count. If it is low, 
replace the column (see Section 2.3.3, Installing 
Columns).

Injector problem

• Wrong vial

• No vial

• Insufficient 
sample volume

• Incorrect 
injection

• Blocked needle

• Leaking 
syringe seal

• Ensure samples are prepared and installed in 
the carousel correctly (see Section 3.5).

• Determine the correct vial number for the 
injection in the sample set method or the 
carousel view.

• Replace the needle if it is blocked or damaged 
(see Section 4.5.2).

• Inspect the syringe to ensure that no air is in it 
and or solvent leaks past the seal.

Flat-topped 
peaks 

Incorrect detector 
settings 

Adjust the detector settings, then autozero the 
detector baselines by selecting Operations > RI 
Autozero and/or Visc. Autozero. See “Autoze-
roing the Refractometer” and “Autozeroing the 
Viscometer” in the Alliance GPC 2000 Series 
System Help.

Injection volume 
or sample concen-
tration too high

Decrease the injection volume or use a diluted 
sample. To select an appropriate injection 
volume, see the “Making a Single Injection in 
Interactive Mode” in the Alliance GPC 2000 
Series System Help.

Negative peaks 
(all peaks) 

Signal cables to 
external 
data-handling 
device reversed

Connect the cables correctly (see Section 2.4.5, 
and Section 3.2.6).

Table 5-9  Troubleshooting Other Abnormal Peaks (Continued)

Symptom Possible Cause Corrective Action
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Negative peaks 
(one or more 
peaks) 

Sample has a 
component with 
an RI lower than 
that of the solvent 
(refractometer 
only) 

Determine whether the negative peak is due to 
sample or solvent impurities, and then

• Right-click, and select Invert Channel to invert 
the peak.

• If the peak interferes with your analysis, 
modify the method.

• If the peak is due to solvent impurities, use 
fresh, filtered solvent (see Appendix C, 
Solvent Considerations).

Injection of air 
instead of sample 
(due to wrong 
vial, no vial, 
insufficient 
sample volume, 
incorrect injec-
tion, blocked 
needle, leaking 
syringe seal)

• Ensure samples are prepared and installed in 
the carousel correctly (see Section 3.5).

• Replace the needle if it is blocked or damaged 
(see Section 4.5.2).

• Inspect the syringe to ensure no air is in the 
syringe and no solvent leaks past the seal.

Table 5-9  Troubleshooting Other Abnormal Peaks (Continued)

Symptom Possible Cause Corrective Action
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5.5  Correcting Solvent Manager Problems

Use Table 5-10 when you suspect that the problem is caused by a component of the 
solvent management system. 

Table 5-10  Solvent Manager Troubleshooting

Symptom Possible Cause Corrective Action

Overpressure 
error or 
shutdown

Solvent viscosity 
too high for the 
specified flow rate

Lower the flow rate (see Section 3.3.3).

Solvent not heated 
to correct temper-
ature, so viscosity 
too high 

Wait until the system is equilibrated and has 
reached the set point. Allow sufficient time for the 
baseline to stabilize (see Section 3.6.1).

Blocked tubing, 
filter, or column 
frit

• If the inline filter or sample vial filter has 
particle buildup, replace it (see Section 4.5.7 or 
Section 4.5.6).

• If the column inlet or frit has particle buildup, 
replace the column.

• If any tubing is blocked, replace it (see 
Section 4.5.15). 

Blocked solvent 
inline filter

Replace the solvent inline filter (see Section 4.5.7).

Blocked waste 
tubing

Clean or replace tubing (see Section 4.5.15).

Restriction 
between solvent 
and sample 
management 
systems

Inspect tubing and remove restriction (see 
Section 4.5.15).

Solvent select 
valve not in 
correct position

Ensure the correct solvent (A or B) is selected (see 
Section 3.3.3).
168 Troubleshooting the System



Underpres-
sure error or 
shutdown

Leaky injection 
valve or valve 
fittings

Investigate the analysis compartment for an 
elevated vapor level (by selecting Detector Vapor in 
Plots). If elevated, inspect the injection valve and 
the valve fittings for leaks.

Leaky column 
fitting

Investigate the analysis compartment for an 
elevated vapor level (by selecting Detector Vapor in 
Plots). If elevated, inspect the column fittings for 
leaks (see Section 4.6, Replacing, Adding, or 
Removing Columns).

Leaky preheat 
loop

Investigate the sample compartment for an elevated 
vapor level (by selecting Carousel Vapor in Plots). 
If elevated, inspect the drip trays to find the fluid 
leaks.

Disconnected or 
damaged tubing

Investigate the tubing connections for leaks.

Replace tubing (see Section 4.5.15, Replacing 
Tubing).

Empty solvent 
reservoir

Refill the solvent reservoir.

Purge valve open 
or leaking

Close the purge valve (see Section 3.4.1).

Piston seal leaking Replace the piston seals (see Section 4.5.10).

Loose head nut, or 
piston ring not 
locked (in back or 
removal position).

Hand-tighten the head nut and ensure the piston 
ring is in the forward, locked position (see 
Section 4.5.13).

Cannot manu-
ally draw 
solvent from 
the purge 
valve into the 
priming 
syringe

Blocked reservoir 
filter 

Replace the solvent reservoir filters (see 
Section 4.5.8).

Blocked or 
restricted tubing

Replace any blocked tubing (see Section 4.5.15). 

Purge valve not 
open wide enough

Rotate the purge valve one turn counterclockwise 
to open it wider (see 
Section 3.4.1).

Table 5-10  Solvent Manager Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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Backpressure 
during equili-
bration 
exceeds 100 
psi

Blocked solvent 
inline filter

Replace the solvent inline filter (see Section 4.5.7).

Precipitated 
sample

• Use sample filter vial (see Section 3.5.1).

• Filter the sample before adding it to a vial.

• Warm sample up using mixing (see 
Section 3.7.2).

• Ensure correct solvent is used.

Piston head 
leaks

Worn piston seals Replace the piston seals (see Section 4.5.10).

Worn seal-wash 
seals (if fitted, 
optional)

Replace the seal-wash seals (see Section 4.5.11).

Loose head nut, or 
piston ring not 
locked (in back or 
removal position).

Hand-tighten the head nut and ensure the piston 
ring is in the forward, locked position (see 
Section 4.5.13).

Loose inlet check 
valve

Tighten or replace the check valve (see 
Section 4.5.14).

Defective or worn 
face seals

Replace the face seals (see Section 4.5.10).

Seal-wash tubing 
not installed 
correctly

Connect seal-wash tubing correctly (see 
Section 2.3.4).

Solvent select 
valve not 
opening

Solvent reservoir 
is empty

Add filtered solvent to the reservoir, then use 
priming syringe to wet the tubing (see
Section 3.4.1).

Syringe not 
drawing 
solvent from 
reservoir A or 
B and appears 
to be drawing 
air

Loose fittings Inspect the fittings for leaks. Tighten fittings as 
needed.

Solenoid valve 
failure error 
message; valve 
not heard

Call Waters Technical Service (see Appendix D).

Worn syringe seal Examine syringe for leaks around seal. If seal is 
leaking, replace syringe using Syringe Replace-
ment wizard (see Section 4.5.3).

Table 5-10  Solvent Manager Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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5.6  Correcting Sample Manager Problems

Use Table 5-11 when you suspect that the problem is caused by a component of the sample 
management system. 

Erratic flow 
or pressure 
pulsations

Gas dissolved in 
solvent

Degas the solvent (see Section 3.2.1).

Air bubble in 
piston head

• Open the purge valve, attach a priming syringe, 
and pull solvent into the syringe to remove the 
bubble (see Section 3.4.1).

• Increase degassing time before making a run.

Dirty inlet check 
valves

Clean or replace inlet check valves (see 
Section 4.5.14).

Purge valve open 
or leaking

Close the purge valve (see Section 3.4.1).

Blocked solvent 
reservoir filter

Clean or replace the solvent reservoir filter (see 
Section 4.5.8).

Piston seal leaking Replace the piston seals (see Section 4.5.10).

Loose head nut, or 
piston ring not 
locked (in back or 
removal position).

Hand-tighten the head nut and ensure the piston 
ring is in the forward, locked position (see 
Section 4.5.13).

Table 5-11  Sample Manager Troubleshooting  

Symptom Possible Cause Corrective Action

Vials do not fit in holders or 
holders do not fit in 
carousel

Wrong vials Use only Alliance GPC 
2000 vials (see
Appendix B, Spare Parts 
and Accessories).

Obstructions or bent holders 
or damaged carousel

Clear obstructions; replace 
damaged holders or 
carousel.

Table 5-10  Solvent Manager Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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Vial holder does not fit into 
carousel

The holder is damaged Use a different vial holder.

The lower bearing is 
damaged

Inspect the bearing. If 
damaged, call Waters Tech-
nical Service (see 
Appendix D).

The carousel does not fit or 
lie flat on the tray, 
preventing the door from 
closing

The carousel is not posi-
tioned correctly due to 
debris on the tray

Remove the carousel, and 
then remove any obstruc-
tions or debris on the 
carousel and the tray. Install 
the carousel, matching the 
locating pins in the tray to 
the holes in the carousel.

Holes on the bottom of the 
carousel are blocked

Remove debris from holes 
or replace the carousel.

A locating pin on the tray is 
damaged

Inspect the locating pins. If 
damaged, call Waters Tech-
nical Service (see 
Appendix D).

Sample compartment door 
fails to shut completely; the 
carousel does not try to 
rotate.

Obstruction or contamina-
tion of the tray or carousel 

Look for obstructions and 
debris in the sample 
compartment and on the 
door. Clear obstructions and 
clean the carousel and the 
tray.

The door close switch or 
lever is out of adjustment or 
failed; defective carousel 
sensor

Call Waters Technical 
Service (see Appendix D).

Table 5-11  Sample Manager Troubleshooting (Continued) 

Symptom Possible Cause Corrective Action
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Carousel fails to register 
(but rotates up to three 
times); Missed Sawtooth 
Error or No Rumble Strips 
Present error message 
displayed

Obstruction or contamina-
tion of the tray or carousel 

Check for obstructions and 
debris in the sample 
compartment. Clear 
obstructions and clean the 
carousel and the tray.

Rumble strips on carousel 
dirty or blocked

Ensure that the rumble 
strips on the lower plate of 
the carousel (see 
Figure 3-29) are clean and 
allow light to pass through 
them.

Carousel tray out of align-
ment or fiber optics dirty, 
failed, or degraded

Call Waters Technical 
Service (see Appendix D).

Needle fails to travel down 
into wash station or to 
return up; no audible move-
ment and/or Did Not Reach 
Switch error message 
displayed

An obstruction blocking 
movement of the needle 
arm

Open the sample compart-
ment door, and examine the 
lower part of the needle 
travel range. Carefully 
remove any obstructions or 
debris. If you suspect debris 
above this area, call Waters 
Technical Service.

Failed switch, faulty motor, 
or faulty motor driver

Call Waters Technical 
Service (see Appendix D).

Table 5-11  Sample Manager Troubleshooting (Continued) 

Symptom Possible Cause Corrective Action
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Needle arm fails to swing 
between wash station and 
inject station; no audible 
movement and/or Did Not 
Reach Switch error message 
displayed

An obstruction blocking 
movement of the needle 
arm

Open the sample compart-
ment door, and examine the 
lower part of the needle 
travel range. Carefully 
remove any obstructions or 
debris. If you suspect debris 
above the lower part of the 
travel range, or around the 
motor, call Waters Tech-
nical Service (see 
Appendix D).

Failed switch, faulty motor, 
or faulty motor driver

Call Waters Technical 
Service (see Appendix D).

Needle fails to reach bottom 
switch in wash position

An obstruction blocking 
movement of the needle 
arm

Open the sample compart-
ment door and examine the 
lower part of the needle 
travel range. Then carefully 
remove any obstructions or 
debris. If you suspect debris 
above this area, call Waters 
Technical Service (see 
Appendix D).

Failed switch, faulty motor, 
or faulty motor driver

Call Waters Technical 
Service (see Appendix D).

Needle fails to reach bottom 
switch in wash position

Bent needle preventing 
entry into wash station

Use the Needle Mainte-
nance wizard to examine 
the needle and change the 
needle if bent (see 
Section 4.5.2).

Table 5-11  Sample Manager Troubleshooting (Continued) 

Symptom Possible Cause Corrective Action
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Needle fails to reach bottom 
switch in inject position

An obstruction blocks 
movement of the needle 
arm

Open the sample compart-
ment door and examine the 
lower part of the needle 
travel range, and then care-
fully remove any 
obstructions or debris. If 
you suspect debris above 
this area, call Waters Tech-
nical Service (see 
Appendix D).

Failed switch, faulty motor, 
or faulty motor driver

Call Waters Technical 
Service (see Appendix D).

Blocked filter in sample 
filter vial (if filtering)

Inspect filter in sample 
filter vial and change it if 
blocked (see Section 4.5.6). 
Examine the sample for 
excessive particulate; 
remove particulates matter 
(for example, by external 
filtration or low-speed 
centrifugation) before 
adding sample to sample 
filter vial.

Sample vial too high in vial 
holder

Inspect the bottom of the 
vial holder for debris, and 
then insert the vial and 
press it completely into the 
holder.

No fluid flowing down the 
needle wash waste tubing, 
even after a needle wash or 
injector purge

During normal startup 
process, air in the flow path 
is displaced by solvent, so 
no fluid initially flows at 
first

Wait for startup to finish.

Table 5-11  Sample Manager Troubleshooting (Continued) 

Symptom Possible Cause Corrective Action
Correcting Sample Manager Problems 175



No fluid flowing down the 
needle wash waste tubing 
and high vapor levels 
(vapor sensor LEDs are red)

If vapor levels remain high 
after needle wash has 
finished, the wash station or 
waste tubing may be 
blocked

Call Waters Technical 
Service (see Appendix D).

No fluid flowing down the 
needle wash waste tubing 
and high syringe pressure 
readings

Blockage between the 
needle and the syringe.

Call Waters Technical 
Service (see Appendix D).

Needle misses vial: injec-
tion requested but the vial 
septum has no puncture 
hole, or hole is in the cap 
instead of septum

Bent needle. The needle 
also fails to reach the lower 
switch when lowered into 
the wash station.

Use the Needle Mainte-
nance wizard to replace the 
needle (see Section 4.5.2).

Carousel needs homing Select Operations > Smart 
Reinit. 

Carousel tray out of 
alignment

Call Waters Technical 
Service (see Appendix D).

Bent needle Needle hitting bottom of 
vial

Use correct vials and 
holders and ensure that they 
are installed properly.

Sample (carousel) compart-
ment does not heat on 
request (Temperature LED 
stays yellow and does not 
turn green)

Sample (carousel) door not 
closed

Close the sample door 
completely.

Overtemp condition 
because the new set point 
you selected is lower than 
the current temperature

Wait for the compartment to 
cool. Control is regained 
when temperature drops to 
the specified range.

System appears normal and 
heaters are running at full 
power, but sample 
(carousel) compartment 
does not reach temperature 
set point

Failed overtemp switch 
(high-temperature thermal 
fuse failure)

Perform the OverTemp test 
(see Section 5.2.2).

Table 5-11  Sample Manager Troubleshooting (Continued) 
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Injector tower (in sample 
compartment) does not heat 
on request (Temperature 
LED stays yellow and does 
not turn green)

Overtemp condition 
because the new set point 
you selected is lower than 
the current temperature

Wait for the compartment to 
cool. Control is regained 
when temperature drops to 
the specified range.

System appears normal and 
heaters are running at full 
power, but injector tower 
(in sample compartment) 
does not reach temperature 
set point

Failed overtemp switch 
(high-temperature thermal 
fuse failure)

Perform the OverTemp test 
(see Section 5.2.2).

Vial mixer is not working 
(no audible response)

Failed mixer motor Call Waters Technical 
Service (see Appendix D).

Vial mixer has a 
high-pitched audible whine

Stalled mixer motor Determine whether the vial 
holder rotates freely in the 
carousel. Look for damage 
or obstructions around the 
mixer magnet (in the 
sample compartment), 
which can prevent rotation.

Excess or unusual noise 
when aspirating a sample

Needle arm is dirty or 
requires adjustment

Call Waters Technical 
Service (see Appendix D).

Injection valve does not 
switch between inject and 
load positions; Did Not 
Reach Switch error message 
displayed; injection chro-
matogram incorrect

Failed switch: You hear 
valve move (actuate) and 
Did Not Reach Switch error 
message displayed

Call Waters Technical 
Service (see Appendix D).

Failed motor: Valve cannot 
be heard to actuate and no 
Did Not Reach Switch error 
message displayed

Call Waters Technical 
Service (see Appendix D).

Frozen rotor cartridge; 
motor stalls

Call Waters Technical 
Service (see Appendix D).

Table 5-11  Sample Manager Troubleshooting (Continued) 

Symptom Possible Cause Corrective Action
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Syringe does not draw 
sample

Loose fitting between 
needle and syringe 

Look for leaks and/or low 
vacuum reading on the 
syringe pressure channel.

Blockage between needle 
and syringe

Look for high vacuum 
reading on the syringe pres-
sure channel, which can 
indicate a blockage. Call 
Waters Technical Service 
(see Appendix D).

Blocked needle vent Inspect vents for blockage 
and replace needle if 
blocked.

Worn syringe seal Examine syringe for leaks 
around seal. Replace 
syringe if needed (see 
Section 4.5.3).

Solenoid valve failure error 
message; valve not heard

Call Waters Technical 
Service (see Appendix D).

Unable to filter a sample 
filter vial, but needle punc-
tures vial

Too much particulate matter 
in bottom of sample filter 
vial prevents the filter ram 
from pressing completely 
down, so insufficient 
sample is filtered, and 
needle cannot reach sample 
to aspirate

Inspect filter in sample 
filter vial and change filter 
if blocked (see 
Section 4.5.6). Examine the 
sample for excessive partic-
ulates; remove particulate 
matter (for example, by 
external filtration or 
low-speed centrifugation) 
before adding sample to 
sample filter vial.

Leaks in the carousel drip 
tray and waste tubing

Blocked needle wash and/or 
waste tubing

Determine the cause of the 
leaks. Replace the tubing 
(see Section 4.5.15).

Table 5-11  Sample Manager Troubleshooting (Continued) 
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5.7  Correcting Detector Problems

5.7.1  Refractometer Problems
The most common source of a refractometer problem is a change in solution temperature 
or density caused by factors other than sample concentration, particularly these:

• Environmental factors – Even small changes in temperature or density can cause 
baseline drift. Ensure that the system has reached equilibration before running 
samples (see Section 3.4).

• Nonhomogeneous solution – The refractometer measures the difference in 
refraction between a pure reference solvent and a homogeneous sample solution 
within a chromatographic band. If the sample solution is not homogeneous, the light 
passing through the sample may be absorbed, scattered, or refracted unpredictably. 
This can result in shifts in retention time and broad, tailing peaks. Most common 
problems of this nature are due to improper solvent preparation (see Appendix C, 
Solvent Considerations).

5.7.2  Viscometer Problems

Consult Table 5-12 when you suspect that the viscometer has a problem. 

Table 5-12  Viscometer Hardware Troubleshooting

Symptom Possible Cause Corrective Action

Relative 
viscosity is 
noisy; P1 and 
P2 show 
excursions in 
the same 
direction

Solvent manager 
problem

See Section 5.5.

Leak outside the 
viscometer

• Look for increased vapor levels by 
right-clicking in the top or bottom plot (in the 
Plot menu), and then selecting Detector Vapor or 
Carousel Vapor.

• To enable the vapor sensors, see
Section 3.3.4.

• Inspect the analysis compartment for leaks, 
especially the area near the viscometer.
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5.8  Correcting Miscellaneous Problems

This section describes symptoms, causes, and corrective actions related to the onboard 
CPU, the user interface, and other system problems. For details about user interface 
problems and solutions, see the following topics in the Diagnostics and Troubleshooting 
book in the Alliance GPC 2000 Series System Help:

• User Diagnostics and Service Maintenance Dialog Box

• Status Code Summary

• General System Troubleshooting

• Login Troubleshooting

• Instrument Performance Troubleshooting

• Instrument Operation Troubleshooting

Relative 
viscosity is 
noisy; P1 and 
P2 show 
excursions in 
the opposite 
direction

Air trapped in 
viscometer lines

Purge the viscometer at least 30 minutes (see
Section 3.4.4).

Viscometer leak • Look for elevated vapor sensor readings in 
analysis compartment.

• Visually inspect the analysis compartment for 
leaks, especially near the viscometer.

P1 goes to full 
scale even 
with very low 
flow

First capillary is 
blocked

Call Waters Technical Service (see Appendix D).

Both P1 and 
P2 go to twice 
the normal 
pressure

Second capillary 
is blocked

Call Waters Technical Service (see Appendix D).

P1 goes to 
zero; P2 goes 
to twice the 
normal 
pressure

Third capillary is 
blocked

Call Waters Technical Service (see Appendix D).

Table 5-12  Viscometer Hardware Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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• Acquisition Troubleshooting

• File Storage Troubleshooting

• Viewer Troubleshooting

• Error Message Troubleshooting

Use Table 5-13 when you suspect that the problem is within the onboard CPU or the user 
interface. 

����
Attention: Waters recommends that you install only Waters-supplied software on the 
Alliance GPC 2000 Series system’s onboard CPU. Installation of other software may 
cause improper operation and/or poor performance of your GPC 2000 system.

Table 5-13  Miscellaneous Troubleshooting

Symptom Possible Cause Corrective Action

System does 
not power on

Power cord not 
connected 
properly

Examine the power cord connections.

No power at outlet Test the line voltage.

Power supply fuse 
blown

Call Waters Technical Service (see Appendix D).

Monitor 
screen is 
blank (power 
off)

Monitor not 
powered on

Power on the monitor.

Monitor cable not 
connected 
properly

Examine the monitor’s power cord and the connec-
tions to the onboard CPU.

Monitor is in a 
screen saver mode 
that displays a 
blank screen 

Move the mouse, or press an arrow key. You can 
change the screen saver (see Windows 2000 
documentation). 
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Monitor 
screen is blue 
(power on) 
but no 
messages or 
applications 
appear

Windows 2000 
problem

• Power-off the inner power button behind the 
sample compartment door; wait 10 seconds, and 
then power on.

• Examine the cable connections.

• If the problem is not solved, see the Windows 
2000 documentation.

• If the problem is not solved, reload the Empower 
software with GPC and/or GPCV software.

• If the problem is not solved, reload the Alliance 
GPC 2000 or GPCV 2000 software.

No response 
from 
keyboard or 
mouse

Keyboard cable or 
mouse cable not 
connected 
properly

Check the keyboard cable and the mouse cable 
connections to the onboard CPU.

Overtempera- 
ture error

Temperature too 
high; compart-
ment heater shut 
down

Perform the OverTemp test (see Section 5.2.2).

Fans not 
working

Power not on Power-on the system.

Problem with fan Call Waters Technical Service (see Appendix D).

Multiple, 
cascading 
error 
messages

The major 
subsystems need 
to be reinitialized.

Select Operations > Smart Reinit.

Slow CPU 
performance

Hard drive is 
almost full

• Archive (back up and delete) data files and logs 
(see Section 4.7.1).

• Ensure that only Waters-supplied software is 
installed on the onboard CPU. 

Table 5-13  Miscellaneous Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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Alliance or 
Windows 
2000 user 
interface not 
responding 

Cable not 
connected 
properly

Inspect the monitor, keyboard, and mouse cable 
connections to the onboard CPU.

Alliance system 
problem 

• Select Operations > Smart Reinit.

• If the problem is not solved, power-off the inner 
power button behind the sample compartment 
door; wait 10 seconds, and then power on.

Windows 2000 
problem

• See the Windows 2000 documentation.

• If the problem is not solved, reload the Empower 
software with GPC and/or GPCV software.

• Reload the Alliance GPC 2000 or GPCV 2000 
software.

Network or 
server not 
responding

Network problem • Power-off the inner power button behind the 
sample compartment door; wait 10 seconds, and 
then power-on.

• If the problem is not solved, examine the cable 
connections.

• If the problem is not solved, call your network 
expert.

Error message 
displays: 
“invalid 
temperature 
slew rate” or 
“too many 
injections per 
vial”.

Corrupt file Follow this procedure to delete the Config.NVO 
file:

1. Start > Programs > GPC2000 Chromatography 
> Shutdown GPC2000 Platform.

2. In Explorer, locate the Waters\GPC2000\Persist 
directory and delete the Config.NVO file.

3. Restart the application (Start > Programs > 
GPC2000 Chromatography > Start GPC2000 
Platform).

Table 5-13  Miscellaneous Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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Appendix A
System and Component 
Specifications

The following specifications apply to the Alliance GPC and GPCV 2000 system 
configurations as originally shipped.

• Physical (Table A-1)

• Environmental (Table A-2)

• Electrical (Table A-3)

• Solvent management system (Table A-4)

• Computer specifications (Table A-5)

• Sample management system (Table A-6)

• Minimum required sample volumes (Table A-7)

• Refractometer (Table A-8)

• Viscometer (Table A-9)

• I/O card (Table A-10)
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A.1  Physical Specifications

A.2  Environmental Specifications

Table A-1  Physical Specifications

Item Specification

Height

Depth

Width

Weight

24 in. (61 cm)

22 in. (56 cm)

37 in. (94 cm)

365 lb. (166 kg)

Wetted surface materials 316 stainless steel, ultra-high molecular weight poly-
ethylene (UHMWPE), sapphire, ruby, Tefzel® (ETFE), 
Teflon® (FEP and PTFE), polyetheretherketone 
(PEEK), Fluoroloy G, glass, Vespel®, 400 stainless 
steel, Kalrez®, quartz

Temperature ranges Solvent management compartment: ambient plus 5 to 
50 °C

Sample management (carousel) compartment: ambient 
plus 5 to 180 °C

Analysis (column/detector) compartment: ambient plus 
5 to 180 °C

Table A-2  Environmental Specifications

Item Specification

Operating temperature 
(ambient)

10 to 32 °C (50 to 90 °F)

Room temperature variation Less than 1.5 °C/hr. (long term) or 0.25 °C/min (short 
term) for best results

Relative humidity 20 to 80%, noncondensing

Acoustic noise <65 dB (A)
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A.3  Electrical Specifications

Solvent compatibility Compatible with most common GPC solvents, such as 
THF and TCB (see Appendix C). Solvents consistent 
with materials of construction. Salts and buffers can 
reduce seal life, especially at high pressures.

When buffers are used, the optional Seal Wash Kit is 
suggested.

Shipping and storage 
temperature

−40 to 65 °C

Shipping and storage humidity 20 to 80%, noncondensing

Table A-3   Electrical Specifications

Item Specification

Power requirements 100 to 240 VAC; 50/60 Hz; single phase; 20 A 
maximum; power transients and fluctuations should be 
minimized; grounded alternating current (AC) power 
source.

A single, dedicated electrical service outlet is recom-
mended. Note that a line conditioner or uninterruptible 
power supply (UPS) would enhance long-term input 
voltage stability. Main power cable equipped with a 
NEMA type 6-15 plug that is included.

Grounding The GPCV 2000 instrument, as well as any peripheral 
devices or instruments connected to it, must be 
connected to a properly grounded power outlet. The 
ground connection in all these outlets must be the same, 
and connect to a common point near the service panel 
and the system. Finally, consider using a line condi-
tioner or an uninterruptible power supply (UPS) for 
optimum long-term input voltage stability.

Table A-2  Environmental Specifications (Continued)

Item Specification
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A.4  Solvent Management System Specifications

Table A-4  Solvent Management System Specifications

Item Specification

Number of solvents Maximum of two in isocratic mode; programmable 
from three positions: solvent A, solvent B (and safety 
shut-off)

Solvent degassing Vacuum degas, dual channel, two chambers, <10 mL 
internal volume per chambera

a. Valid for 0.3 to 2 mL/min flow rate

Programmable flow rate range 0.000 and 0.010 to 10.000 mL/min in 0.001-mL/min 
increments

Compressibility compensation Automatic and continuous

Flow ramping 0.01 to 5.00 mL/min per minute

Maximum operating pressure 5000 psi (345 bar); programmable upper and lower 
limits

Flow precision ≤0.075% RSD absolute, without flow markers or soft-
ware correction, based on elution volume/retention 
time; 6 replicatesa

Flow accuracy ±1% or 10 µL/min, whichever is greatera
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A.5  Control Specifications

A.6  Sample Management System Specifications

Table A-5  Control Specifications

Item Specification

Onboard CPU 
(located on slide-out 
chasis, behind the 
solvent manager 
compartment door)

Pentium III processor, 600 MHz or greater

512 RAM

Data storage media (60-GB hard drive minimum, CD R/W, and 
1.44 MB floppy drives)

Serial card (PCI)

External monitor, keyboard, mouse

Parallel output port optionally connect Windows® 2000-compat-
ible printer

RJ45 network port (connects the system to a network)

Table A-6  Sample Management System Specifications

Item Specification

Number of sample 
vials

24 per carousel (standard)

40 per carousel (optional)

Sample vial sizes 4-mL, 7-mL (filtered), (10-mL is standard)

Number of sample 
injections

1 to 9 injections per sample vial, depending on loop, sample, and 
syringe sizes

Sample delivery 
precision

<1% RSD, based on peak area, six replicate injections

Sample carryover <0.1% between vials.

Injection accuracy Sample loops are factory calibrated to within ±1% of tagged 
value. Sample remaining in loop after sample run reinjected in 
sample vial.

Sample temperature 
control

Ambient plus 5 to 180 °C
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A.7  Minimum Required Sample Volumes

Injection volume 
range

200 µL, 300 µL, and 400 µL by replacing the sample loop 
supplied with the instrument

100 µL, 500 µL, and 1000 µL by replacing the sample loop 
supplied as an option

Filter vial filter 
porosity

0.5-µm or 2-µm

Table A-7  Minimum Required Sample Volumes for a Single Injection

Sample Loop (µL)
Volume in 4-mL 
Glass Vial (mL)

Volume in 7-mL 
Filter Vial (mL)

Volume in 10-mL 
Glass Vial (mL)

100 1.7 1.1 1.6

200 2.0 1.4 1.4

300 2.3 1.7 2.2

400 2.6 2.0 2.5

500 2.9 2.3 2.8

Table A-6  Sample Management System Specifications (Continued)

Item Specification
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A.8  Refractometer Specifications

A.9  Viscometer Specifications

Table A-8  Refractometer Specifications

Item Specification

Refractive index (RI) range 1.00 to 1.75 refractive index units (RIU) full scale

Measurement range −5 × 10−3 to +5 × 10−3 RIU

Noise <5 × 10−8 RIU with 1 mL/min solvent flowa

a. Ambient plus 5 to 160 °C (equilibrated). Drift depends on room temperature drift. For best results, room 
temperature variation should not exceed 1.5 oC/hr (long term) or 0.25oC/10 min (short term).

Drift <5 × 10−7 RIU/hour with 1 mL/min solvent flowa

Light source Light-emitting diode (LED) (880 nm)

Flow cell volume 10 µL

Cell pressure rating 100 psi; built-in pressure relief valve

Table A-9  Viscometer Specifications

Item Specification

Noise <5 × 10−5 relative viscosity units (RVU) with 1 mL/min solvent 
flowa

a. Ambient plus 5 to 160 °C (equilibrated)

Drift <1 × 10−4 relative viscosity units (RVU)/hour with 1 mL/min 
solvent flowa

Flow path from RI to 
viscometer

Serial; no splitting necessary

Viscometer 
electronics

Integrated into Alliance GPCV 2000 system using Digital Signal 
Processing (DSP)

Viscometer 
calibration

User programmable
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A.10  I/O Card Specifications

Table A-10  I/O Card Specifications

Signal Number Type Connector Specification

Event 
Inputs

2 Comparator Terminal 
Strip

Voltage range: +30V

High voltage: >3.0V +10%

Low voltage: <1.9 V+10%

Minimum pulse width: 10 
milliseconds

Event 
Outputs

2 Relay, SPST N.0, 
Contact closure

Terminal 
Strip

Maximum voltage: 70 V DC

Maximum current: 0.5A DC

Contact resistance: 0.2 ohms

Analog 
Outputs

4 Voltage Terminal 
Strip

Voltage range: −2 to 2 V

Minimum voltage: −2 V

Maximum voltage: 2 V
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Appendix B
Spare Parts and Accessories

The part number for the GPC 2000 2000 Series is 176806001; the part number for the 
GPCV 2000 system is 176806002. 

Recommended spare parts for the Alliance GPC 2000 Series system are presented in these 
tables along with their part numbers:

• Spare parts and accessories (Table B-1)

• Columns (Table B-3, Table B-4, and Table B-5)

• Startup Kit (Table B-6)

• Ventilation Kit (Table B-7)

• Maintenance Kit (Table B-8)

Parts not included in this appendix are not recommended for customer installation or 
replacement. A list of accessories, manufactured by other vendors, is provided for your 
convenience.

At the time of its publication, this manual contained the latest spare parts list. When part 
numbers change, or become available, the Waters web site will reflect those changes. 
Access the Waters web site, www.waters.com, and follow this path:

Support > Support Center > Connections Elite > Integrated Systems > GPC 2000 Series

Note: To log on to the Elite Support Center, you must enter your E-mail address and 
password.
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B.1  Spare Parts and Accessories

Table B-1  Spare Parts and Accessories

Item Part Number

Inlet check valve cartridge (2) WAT270941

Solvent inline filter (2-µm) WAT088084

Sample loops

20-µL

100-µL 

200-µL 

300-µL 

400-µL 

500-µL 

1000-µL 

WAT096224

WAT223720

700000794

700000845

700000846

700001017

700001018

Syringes

2.5-mL

5.0-mL

WAT077342

700000784

Carousel

40 position carousel (for use only with 4 mL glass vials) 700002136

For 10-mL vials

10-mL glass vials (100) 

Integral 20-mm seal and crimp cap with septum for 10-mL 
vials and filter vials (100)

10-mL caps for samples

Large vial holders (6)

20-mm cap with septa, 100 pk

186001420

600000138

186001421

28900174

700000851

Vapor sensor, organic, solvent (1) 363000100
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For 7-mL filter vials

Filter vial assembly (plunger, seal, and cup; 24 each)

Filter vial assembly (plunger, seal, and cup; 6 each)

Filters for sample filter vials:

• 0.5-µm (100)

• 2.0-µm (100)

Filter vial plunger seals (24)

Filter vial plunger assembly (6)

Filter vial cups (24)

Filter removal tool for sample filter vial 

20-mL crimping tool for 7-mL sample vials

Decapping pliers

Large vial holders (6)

600000186

600000228

600000163

600000164

600000230

600000229

600000231

700001027

700000847

700000852

600000227

For 4-mL vials

4-mL glass vials (48)

4-mL vial septa (144)

4-mL vial septa (1440)

Screw caps for 4-mL vials (48)

4-mL vial holders (6) (for 24-position carousel)

Large vial holders (6) (for 24-position carousel)

WAT072710

WAT072714

WAT073005

600000162

600000232

600000227

GPC high molecular weight tubing kit 700002468

Flow-through viscometer kit 700002314

GPC 2000 Enhancement Kit 700002334

Clear Tubing Assembly for Waste Manifold 700002313

Table B-1  Spare Parts and Accessories (Continued)

Item Part Number
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Seal-Wash Option Installation Kit (includes the following)

Seal-wash plunger seal (2)

Seal-wash tube seal (4)

Seal-wash face seal (2)

Pump solenoid

Ferrule, 1/8-in., Tefzel (2)

Compression screw, 1/8-in., PEEK (2)

Diffuser assembly 

Shrink marker, Pump Wash In

Tubing, 0.062 in. ID × 0.120 in. OD × 175 in. (444.5 cm)

Tubing, Teflon, awg 9 thin wall

Installation procedure

WAT270872

WAT270160

WAT270668

WAT271051

WAT270594

WAT046-01

WAT046-12

WAT007272

WAT270520

WAT270714

WAT024036

WAT271232

Mixing Reservoir

Kontes Ultra-Ware® Reservoir (5 liter) with three hole 
PTFE cap (1)

Magnetic stir bar, 1 1/4 in.

Kalrez O-ring, size 216 (1)

Polyethylene pan (25 x 22 x 13.5 cm) (1)

Stainless steel solvent filter (2)

Reservoir

Kontes Ultra-Ware Reservoir (5 liter) with graduations (1)

Kontes 3-port MP delivery cap (1)

Kontes number

953980-5002

Kontes 791190-0114

Kontes

758240-0216

Nalgene

7120-0010

WAT025531

Kontes number

953922-5002

Kontes number

953913-0000

Table B-1  Spare Parts and Accessories (Continued)

Item Part Number
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B.2  Styragel Columns

Table B-3 lists the Styragel columns that are packed in toluene. For Styragel columns 
packed in THF or DMF, refer to the Waters HPLC Columns and Supplies Catalog. The 
Styragel column abbreviations are defined in Table B-2. For organic separations, you can 
use three types of Styragel columns:

• Styragel HMW (20-µm particle size) – Use with shear-sensitive, ultra-high 
molecular weight polymer samples at temperatures between ambient and 180 °C. 
High-porosity, 10-µm fits accompany these columns.

• Styragel HT (0-µm particle size) – Use with mid-molecular to high-molecular 
weight samples at temperatures between ambient and 180 °C.

• Styragel HR (5-µm particle size) – Use with low-molecular to mid-molecular 
weight samples. These columns afford high resolution at temperatures between 
ambient and 80 °C.

Table B-2  Styragel Column Abbreviations

Abbreviation Definition

HR High Resolution

RT Room Temperature

HT High Temperature

AQ Aqueous

MB Mixed Bed

L Low Molecular Weight range

M Medium Molecular Weight range

L/M Low/Medium Molecular Weight 
range

H High Molecular Weight range
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Table B-3  Styragel Columns

Type
Effective Molecular 
Weight Range

Part Number 
(300 mm × 
7.8 mm ID In 
Toluene)

Part Number 
(300 mm × 
4.6 mm ID In 
Toluene)

HMW 2 (20-µm) 100 – 1 × 104 WAT054490 Not available

HMW 6E (20-µm) 5,000 – 2 × 107 WAT044203 WAT046815

HMW 7 (20-µm) 5 × 105 – 1 × 108 WAT044200 WAT046800

HT 2 (10-µm) 100 – 1 × 104 WAT054476 Not available

HT 3 (10-µm) 500 – 5 × 104 WAT044206 WAT045915

HT 4 (10-µm) 5,000 – 6 × 105 WAT044209 WAT045930

HT 5 (10-µm) 5 × 104 – 4 × 106 WAT044212 WAT045945

HT 6 (10-µm) 2 × 105 – 1 × 107 WAT044215 WAT045960

HT 6E (10-µm)a

a. Provided with the Startup Kit

5,000 – 1 × 107 WAT044218 WAT045975

HR 0.5 (5-µm)b

b. Use LS-compatible or preconditioned column(s) for optimal results in LS or viscometry. This minimizes de-
tector contamination by particulates that manifest themselves as signal noise.

10 – 1,000 WAT044230 WAT045830

HR 1 (5-µm) 100 – 5,000 WAT044233 WAT045845

HR 2 (5-µm) 500 – 2 × 104 WAT044236 WAT045860

HR 3 (5-µm) 500 – 3 × 104 WAT044221 WAT045875

HR 4 (5-µm) 5,000 – 6 × 105 WAT044224 WAT045890

HR 5 (5-µm) 5 × 104 – 4 × 106 WAT054464 Not available

HR 6 (5-µm) 2 × 105 – 1 × 107 WAT054470 Not available

HR 4E (5-µm) 50 – 1 × 105 WAT044239 WAT045800

HR 5E (5-µm) 2,000 – 4 × 106 WAT044227 WAT045815
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B.3  Ultrahydrogel Columns

Table B-4 lists Ultrahydrogel columns, which are packed in water (7.8 mm ID × 300 mm 
length). 

B.4  HSPgel Columns

Table B-5 lists HSPgel (high-speed GPC analysis) columns, which are packed in either 
THF or water (6.0 mm ID × 150 mm length).

Table B-4  Ultrahydrogel Columns

Type
Effective Molecular 
Weight Range

Part Number

120 200 – 5,000 WAT011520

250 1,000 – 8 × 105 WAT011525

500 5,000 – 3 × 105 WAT011530

1000 1 × 104 – 1 × 106 WAT011535

2000 5 × 104 – 7 × 106 WAT011540

Linear 200 – 7 × 106 WAT011545

DP 200 – 5,000 WAT011550

Table B-5  HSPgel Columns

Type Solvent
Effective Molecular Weight 
Rangea Part Number

HSPgel HR 1.0 THF 100 – 1000 186001741

HSPgel HR 2.0 THF 500 – 10,000 186001742

HSPgel HR 2.5 THF 1,000 – 20,000 186001743

HSPgel HR 3.0 THF 2,000 – 60,000 186001744

HSPgel HR 4.0 THF 10,000 – 400,000 186001745

HSPgel HR MB-L THF 500 – 700,000 186001746

HSPgel HR MB-M THF 1,000 – 4,000,000 186001747

HSPgel HR MB-H THF 5,000 – >10,000,000 186001748

HSPgel RT 1.0 THF 100 – 1,000 186001749
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HSPgel RT 2.0 THF 500 – 10,000 186001750

HSPgel RT 2.5 THF 1,000 – 20,000 186001751

HSPgel RT 3.0 THF 2,000 – 60,000 186001752

HSPgel RT 4.0 THF 10,000 – 400,000 186001753

HSPgel RT 5.0 THF 25,000 – 4,000,000 186001754

HSPgel RT 6.0 THF 50,000 – 10,000,000 186001755

HSPgel RT 7.0 THF 100,000 – >15,000,000 186001756

HSPgel RT MB-L THF 100 – 10,000 186001757

HSPgel RT MB-L/M THF 500 – 400,000 186001758

HSPgel RT MB-M THF 1,000 – 4,000,000 186001759

HSPgel RT MB-H THF 5,000 – >10,000,000 186001760

HSPgel AQ 2.5 H2O 500 – 2,000 186001785

HSPgel AQ 3.0 H2O 1,000 – 60,000 186001786

HSPgel AQ 4.0 H2O 10,000 – 400,000 186001787

HSPgel AQ 5.0 H2O 50,000 – 4,000,000b 186001788

HSPgel AQ 6.0 H2O 100,000 – 10,000,000b 186001789

HSPgel AQ MB-H H2O 500 – 10, 000, 000b 186001790

HSPgel HT 1.0 THF 100 – 1,000 186001761

HSPgel HT 2.0 THF 500 – 10,000 186001762

HSPgel HT 2.5 THF 1,000 – 20,000 186001763

HSPgel HT 3.0 THF 2,000 – 60,000 186001764

HSPgel HT 4.0 THF 10,000 – 400,000 186001765

HSPgel HT 5.0 THF 25,000 – 4,000,000 186001766

HSPgel HT 6.0 THF 50,000 – 10,000,000 186001767

HSPgel HT 7.0 THF 100,000 –> 15,000,000 186001768

HSPgel HT MB-L THF 100 – 1,000 186001769

HSPgel HT MB-L/M THF 500 – 400,000 186001770

HSPgel HT MB-M THF 1,000 – 4,000,000 186001771

Table B-5  HSPgel Columns (Continued)

Type Solvent
Effective Molecular Weight 
Rangea Part Number
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B.5  Startup Kit

The startup kit (part number 200000154) contains the parts needed to set up the system for 
operation. The startup kit list, supplied with the startup kit, provides a list of the parts 
included listed in Table B-6. 

HSPgel HT MB-H THF 5,000 –> 10,000,000 186001772

HSPgel HT 1.0 ODCB 100 – 1,000 186001773

HSPgel HT 2.0 ODCB 500 – 10,000 186001774

HSPgel HT 2.5 ODCB 1,000 – 20,000 186001775

HSPgel HT 3.0 ODCB 2,000 – 60,000 186001776

HSPgel HT40 ODCB 10,000 – 400,000 186001777

HSPgel HT 5.0 ODCB 25,000 – 4,000,000 186001778

HSPgel HT 6.0 ODCB 50,000 – 10,000,000 186001779

HSPgel HT 7.0 ODCB 100,000 –>15,000,000 186001780

HSPgel HT MB-L ODCB 100 – 1,000 186001781

HSPgel HT MB-L/M ODCB 500 – 400,000 186001782

HSPgel HT MB-M ODCB 1,000– 4,000,000 186001783

HSPgel HT MB-H ODCB 5,000 –> 10,000,000 186001784

a. MW ranges for HR and RT are based on polystyrene chain lengths and polyethylene oxide change lengths 
for AQ series.

b. Exclusion limits for AQ series are extrapolated from the highest MW PEO standard (~900, 000).

Table B-6  Startup Kit

Item Part Number

Alliance GPC 2000 Series System startup kit 200000154

Table B-5  HSPgel Columns (Continued)

Type Solvent
Effective Molecular Weight 
Rangea Part Number
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B.6  Ventilation Option Kit

The Ventilation Option Kit (part number 200000120) contains the parts to connect the 
Alliance GPC 2000 Series system to the ventilation system during bench top installation. 

B.7  Maintenance Kit

The maintenance kit (part number 201000111) contains the tool and replacement parts for 
the annual preventive maintenance program for the Alliance GPC 2000 Series system. 

Table B-7  Ventilation Option Kit

Item Part Number

Vent gate (sliding, adjustable) 700000973

Exhaust hose, 4-in. diameter × 10 ft. (3.0 m) WAT075181

Hose clamp (2) WAT075182

Table B-8  Maintenance Kit

Item Part Number

Seal insertion and removal tool WAT039803

Piston seals WAT270938

Solvent reservoir filters (2) WAT025531

Face seals (4) WAT270939

Solvent inline filter, 2-µm WAT088084

Pre-detector inline filter, 10-µm 700000938

Injection valve cartridge 700000853

Piston (plunger) for solvent manager (2) WAT271067

Sample needle 700000743

Syringe, 5-mL 700000784

Vapor sensor, organic, solvent (3) 363000100

Vapor sensor gasket 405000683

Vapor sensor mounting plate screws WAT081265
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Appendix C
Solvent Considerations

This appendix provides information about preparing and using solvents with the Alliance 
GPC 2000 Series system. 

Proper solvent preparation can prevent many chromatographic system problems. Most 
solvent-related problems can be prevented through degassing, filtration, use of 
high-quality solvents, proper plumbing, and avoiding immiscible solvent combinations.

C.1  Solvent Degassing

Solvent degassing prevents bubble formation (outgassing) and provides:

• Stable baselines and enhanced sensitivity

• Reproducible retention times for eluting peaks

• Reproducible injection volumes for quantitation

• Stable pump operation

The Alliance GPC 2000 Series system provides inline solvent degassing. Inline degassing 
removes gases from the solvent as the solvent passes through a gas-permeable membrane 
enclosed in a vacuum chamber. The vacuum in the chamber accelerates the rate at which 
the dissolved gas diffuses through the gas-permeable membrane. This method provides an 
automatic, continuous method of removing dissolved gases, and allows for efficient 
solvent changeover. 

Caution: To avoid chemical hazards, always observe safe laboratory practices when you 
operate the Alliance GPC 2000 Series system and when you handle solvents. Refer to 
the Material Safety Data Sheets for the solvents you use.
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Gas Solubility

The amount of gas that can dissolve in a given volume of liquid depends on:

• The chemical affinity of the gas for the liquid

• The temperature of the liquid

• The pressure applied to the liquid

Changes in the composition, temperature, or pressure of the solvent can lead to 
outgassing.

Effects of Intermolecular Forces

Nonpolar gases (N2, O2, CO2, He) are more soluble in nonpolar solvents than in polar 
solvents. Generally, a gas is most soluble in a solvent with intermolecular attractive forces 
similar to those in the gas (“like dissolves like”).

Effects of Temperature

If the heat of solution is exothermic, the solubility of the gas decreases when you heat the 
solvent. If the heat of solution is endothermic, the solubility of the gas increases when you 
heat the solvent. For example, the solubility of helium in water decreases with an increase 
in temperature, but the solubility of helium in benzene increases with an increase in 
temperature. 

Effects of Partial Pressure

The mass of gas dissolved in a given volume of solvent is proportional to the partial 
pressure of the gas in contact with the vapor phase of the solvent. If you decrease the 
partial pressure of the gas, the amount of that gas in solution also decreases.

C.2  Solvent Filtration

A solvent must always be filtered with a 0.5-µm (or smaller) filter before use (with filters 
in the solvent reservoirs). The removal of particles ensures reliable operation of the check 
valves, piston seals, and other components in the system. The use of a Solvent 
Clarification Kit is recommended.

Always filter solvents after mixing them, especially in the case of buffers. Insoluble 
impurities are a source of particulates. After filtration, store solvents in a closed, 
particulate-free bottle.
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After a solvent is filtered, it does not need to be filtered daily, provided that bacterial 
growth or a reaction that produces an insoluble product does not occur.  If a filtered 
solvent is unused for more than one week, it is good practice to filter it again before use. 
For recommendations on specific solvents, see Table C-2.

C.3  Solvent Quality

Clean solvents are necessary to obtain reproducible results and to operate your HPLC 
system with minimal instrument maintenance. Dirty solvents can cause baseline noise and 
drift, and can block solvent reservoir and inlet filters with particulate matter. Always use 
HPLC-grade solvents to ensure the best possible chromatographic results. Filter solvents 
through 0.5-µm filters before use. 

C.4  Flow Path Plumbing

Cavitation (formation of vapor bubbles in the solvent) occurs when solvent flow through 
the inlet pathway is restricted enough to cause a localized drop in solvent flow path 
pressure. The key to preventing cavitation is to avoid inlet restrictions. The most common 
causes of inlet restrictions are crimped inlet lines and plugged inlet filters. Inlet lines with 
tubing longer than 48 in. (120 cm) or with tubing of less than 0.085 in. (2 mm) ID may 
also cause cavitation.

Placing the solvent reservoirs at or below the pump level also promotes cavitation. Place 
reservoirs at least 4 in. (10 cm) above the pump level to help prevent cavitation. 

C.5  Solvent Miscibility 

Before you change solvents, refer to Table C-1 to determine the miscibility of the new 
solvent with the previous solvent. When you change solvents, keep in mind that:

• A change involving two miscible solvents may be made directly. 

����
Attention: To prevent damage to the system and to allow full system access, do not 
place any items on top of the system.
Solvent Quality 205



• A change involving two solvents that are not totally miscible (for example, 
chloroform and water) requires an intermediate solvent (such as methanol) that is 
miscible with both initial and final solvents.

• Temperature affects solvent miscibility. If you are running a high-temperature 
application, consider the effect of the higher temperature on solvent miscibility.

• Buffers dissolved in water may precipitate when mixed with organic solvents. 
Before you switch from a buffer to an organic solvent, flush the buffer out of the 
system with HPLC-grade water.

Using Miscibility Numbers (M Numbers)

Use M numbers to predict the miscibility of a liquid with a standard solvent (see 
Table C-1). A liquid is classified in the M-number system by testing its miscibility with a 
series of standard solvents. A correction term of 15 units is then either added or subtracted 
from the cutoff point for miscibility.

To predict the miscibility of two liquids, subtract the smaller M value from the larger M 
value.

• If the difference between the two M numbers is 15 or less, the two liquids are 
miscible in all proportions at 15 °C.

• A difference of 16 between the two M number values indicates that the liquids are 
miscible only in the temperature range of 25 to 75 °C, with 50 °C as the optimal 
temperature.

• If the difference between the two M number values is 17 or greater, the liquids are 
immiscible or their critical solution temperature is above 75 °C.

Some solvents are immiscible with solvents at both ends of the lipophilicity scale. These 
solvents are assigned two M numbers:

• The first number, which is always smaller than 16, indicates the degree of 
miscibility with highly lipophilic solvents. 

• The second number, which is always larger than 16, indicates the degree of 
miscibility with hydrophilic solvents. A large difference between the two M 
numbers indicates a limited range of miscibility. 

����
Attention: To prevent immiscibility and/or precipitation problems when switching 
between solvents, use an intermediate solvent that is miscible with both solvents.
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For example, some fluorocarbons are immiscible with the standard solvents and have 
M numbers of 0 and 32. Two liquids that each have two M numbers are usually miscible 
with each other. 

Table C-1  Solvent Characteristics

Polarity 
Index

Solvent
Viscosity [η] 
CP, 20 °C

Boiling Point 
at 1 atm (°C)

Miscibility (M) 
Number 

–0.3 n-decane 0.92 174.1 29

–0.4 Isooctane 0.50 99.2 29

 0.0 n-hexane 0.313 68.7 29

 0.0 Cyclohexane 0.98 80.7 28

 1.7 Butyl ether 0.70 142.2 26

 1.8 Triethylamine 0.38 89.5 26

 2.2 Isopropyl ether 0.33 68.3 ––

 2.3 Toluene 0.59 100.6 23

 2.4 p-xylene 0.70 138.0 24

 2.7 Orthodichlorobenzene 
(ODCB)

1.32 (25 °C) 180.48 21

 3.0 Benzene 0.65 80.1 21

 3.3 Benzyl ether 5.33 288.3 ––

 3.4 Methylene chloride 0.44 39.8 20

 3.7 Ethylene chloride 0.79 83.5 20

 3.9 Butyl alcohol 3.00 99.5 ––

 3.9 Butanol 3.01 117.5 15

 4.2 Tetrahydrofuran (THF) 0.55 66.0 17

 4.3 Ethyl acetate 0.47 77.1 19

 4.3 1-propanol 2.30 97.2 15

 4.3 2-propanol 2.35 117.7 15

 4.4 Methyl acetate 0.45 56.3 15, 17

 4.5 Methyl ethyl ketone 
(MEK)

0.43 80.0 17

 4.5 Cyclohexanone 2.24 155.7 28

 4.5 Nitrobenzene 2.03 210.8 14, 20
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C.6  Solvent Viscosity 

Generally, viscosity is not important when you operate your HPLC system with a single 
solvent or under low pressure. However, when you use highly viscous solvents, 
monitoring the pressure during the run can help prevent pressure buildup and the resulting 
column problems. 

 4.6 Benzonitrile 1.22 191.1 15, 19

 4.8 Dioxane 1.54 101.3 17

 5.2 Ethanol 1.20 78.3 14

 5.3 Pyridine 0.94 115.3 16

 5.3 Nitroethane 0.68 114.0 ––

 5.4 Acetone 0.32 56.3 15, 17

 5.5 Benzyl alcohol 5.80 205.5 13

 5.7 Methoxyethanol 1.72 124.6 13

 6.2 Acetonitrile 0.37 81.6 11, 17

 6.2 Acetic acid 1.26 117.9 14

 6.4 Dimethylformamide 
(DMF)

0.90 153.0 12

 6.5 Dimethyl acetamide 2.14 166.1 13

 6.5 Dimethylsulfoxide 
(DMSO)

2.24 189.0 9

 6.6 Methanol 0.60 64.7 12

 6.7 N-Methyl-2 pyrrolidone 
(NMP)

1.67 (25 °C) 202 13

 7.3 Formamide 3.76 210.5 3

 9.0 Water 1.00 100.0 ––

10.0 Trichlorobenzene (TCB) 1.89 213.0 ––

Hexafluoroisopropanol 
(HFIP)

1.02 (25 °C) 58.2

Table C-1  Solvent Characteristics (Continued)

Polarity 
Index

Solvent
Viscosity [η] 
CP, 20 °C

Boiling Point 
at 1 atm (°C)

Miscibility (M) 
Number 
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C.7  Using Buffers 

When you use aqueous buffers, adjust the pH, filter to remove insoluble material, then 
blend with organic modifier as appropriate. After you use a buffer, flush the buffer from 
the pump with at least 10 mL of HPLC-grade water. For shutdowns lasting more than one 
day, flush the pump with 20% methanol/water to prevent growth of microorganisms. 

C.8  Removing Buffered Solvent

If your system includes aqueous buffered solvent, remove the buffered solvent from the 
flow path at the end of the day or when the samples have finished running.

Note: To avoid damage to your columns, ensure that the flow path bypasses the columns. 

To remove buffered solvent from the flow path:

1. Remove the column set from the flow path:

a. Select Setup > Current Instrument Method to open the Current Instrument 
Method dialog box.

b. Click the Detector tab.

c. Click Column Bypass in the Column area, and then click OK.

d. Save the instrument method with a new name. 

2. Replace the buffered solvent with 100% HPLC-quality water, and then purge the 
viscometer for 20 minutes (Section 3.4.4, Purging the Sense-Tube Viscometer).

3. Purge the refractometer for 5 minutes (Section 3.4.3, Purging the Refractometer).

4. Purge the injector with 30 mL (Section 3.4.2, Purging the Injector).

5. Replace the seal-wash solvent with a solution of 80% methanol:20% water or a 
miscible solvent, then prime the seal-wash pump for 10 min. (select Operations > 
Seal Wash Prime).

6. Replace the 100% water (solvent reservoir) with a solution of 90% methanol:10% 
water, and then flush the system for 10 minutes (select Operations > Auto Wash 
Prime).

7. Restore the column set to the flow path:

a. Select Setup > Current Instrument Method to open the Current Instrument 
Method dialog box.
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b. Click the Detector tab.

c. Click Column Bypass in the Column area, and then click OK.

C.9  Solvent Settings

You can lower but must not raise the temperature and pressure limits for the solvents, as 
defined in the Mobile Phase A and Mobile Phase B pages in the Instrument Configuration 
Editor.

Table C-2 shows solvent compatibility with the solvent manager plunger seal that can be 
used in the Alliance GPC 2000 Series system.

Table C-2  Solvent Manager Plunger Seal and GPC Solvent Compatibility

Solvent / Plunger 
Seal 
Compatibility

Standard
Yellow

Standard
Yellow Seal 
with Seal 
Wash

Optional 
Alliance 
Clear-Seal

Optional
Alliance 
Clear-Seal 
with Seal 
Wash

Notes

Chloroform 
(CHCl3)

May be used Recommended May be 
used

Recom-
mended

Use seal wash. Seal 
wash solvent is 
CH3OH.

DMAC 
(Dimethylaceta-
mide)

Do not use Do not use Do not use Strongly 
recom-
mended

DMAC is typically 
used with LiBr or 
LiCl at 0.05 M. Use 
seal wash. Seal wash 
solvent is 50/50 
CH3OH/H20.

DMF (Dimethyl- 
formamide)

Do not use Do not use Do not use Strongly 
recom-
mended

Use with 0.05 M 
LiBr or LiCl. Use 
seal wash. Seal wash 
solvent is 50/50 
CH3OH/H20.

DMSO (Dimethyl 
sulfoxide)

May be used Recommended May be 
used

Recom-
mended

Use a seal wash. 
Seal wash solvent is 
CH3OH.
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HFIP (Hexafluoro- 
isopropanol)

Yes Yes

This is 
usually used 
with 0.05 M 
sodium trif-
luoroacetate 
or other 
salt.

Yes

Methylene chloride

(CH2Cl2)

May be used Recommended May be 
used

Recom-
mended

Use seal wash. Seal 
wash solvent is 
CH3OH.

NMP (N-Methyl-2 
pyrrolidone)

Do not use Do not use Do not use Strongly 
recom-
mended

NMP is typically 
used with LiBr or 
LiCl at 0.05 M. Use 
seal wash. Seal wash 
solvent is 50/50 
CH3OH/H20.

ODCB (Ortho- 
dichlorobenzene)

Yes No Yes

Note: Filter through 100- to 200-µm active silica in addition to the 0.5 or 
0.2-µm membrane filter. Suggested ramp rate: 0.5 mL/min/min.

TCB 
(Trichlorobenzene)

Yes No Yes

Note: If the TCB is treated with Santonox anti-oxidant, filter it through a 
bed of 100- to 200-µm activated silica gel and an 0.45-µm membrane filter. 
Suggested ramp rate: 0.5 mL/min/min. 

Note: The seal-wash seals are not compatible with trichlorobenzene (TCB).

Table C-2  Solvent Manager Plunger Seal and GPC Solvent Compatibility (Continued)

Solvent / Plunger 
Seal 
Compatibility

Standard
Yellow

Standard
Yellow Seal 
with Seal 
Wash

Optional 
Alliance 
Clear-Seal

Optional
Alliance 
Clear-Seal 
with Seal 
Wash

Notes
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THF 
(Tetrahydrofuran)

Recom-
mended

Strongly 
recommended

Recom-
mended

Strongly 
recom-
mended

Initial (dry) priming 
is improved by first 
priming with IPA or 
CH3OH. If using the 
seal wash option, use 
50/50 CH3OH/H20.

Note: If using unstabilized THF, ensure that the solvent is fresh. Previously 
opened bottles of THF can contain peroxide contaminants, which cause 
baseline drift.

 Caution: Peroxides are potentially explosive if concentrated, 
heated, or taken to dryness.

Toluene May be used May be used Recom-
mended

May be 
used

If using the seal 
wash option, use 
CH3OH as the seal 
wash solvent.

Water May be used Recommended May be 
used

Recom-
mended

Aqueous GPC appli-
cations usually use 
salts and/or buffers. 
Use seal wash. Seal 
wash solvent is 
20/80 CH3OH/H20.

Table C-2  Solvent Manager Plunger Seal and GPC Solvent Compatibility (Continued)

Solvent / Plunger 
Seal 
Compatibility

Standard
Yellow

Standard
Yellow Seal 
with Seal 
Wash

Optional 
Alliance 
Clear-Seal

Optional
Alliance 
Clear-Seal 
with Seal 
Wash

Notes
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Appendix D
Related Reference Material

D.1  References

For more information on GPC, GPCV, LS viscometry, polymers, HPLC, and Windows 
software, consult these sources:

• Alliance GPC 2000 Series System Help.

• Empower GPC, GPCV, and LS Software Help.

• Plastics and Polymers, A. Baptiste, Waters Corp., Milford, MA, 1998. Available 
through Connections University, a Waters Corp. course program.

• Polymer Handbook, J. Brandrup, E.H. Immergut: John Wiley & Sons, Publisher; 
Third edition, 1989.

• Data Reduction in Multidetector Size Exclusion Chromatography, Y. Brun; J. Liq. 
Chrom. & Rel. Technology, 21 (13), 1979 – 2015 (1998).

• Modern Size-Exclusion Liquid Chromatography, W.W. Yau, J.J. Kirkland, D.D. Bly, 
Wiley Press, 1979.

• R. Nielson, P. Alden, and J. Yang, “High-Speed Gel Permeation Chromtography,” 
American Laboratory, Vol. 36: 2004, pp. 34-44.

• Waters Web site for more information on GPC products:

www.waters.com\Applications\Polymer Analysis\Polymer Applications

• GPC 2000 System Overview & Start-Up Video, Waters Corp., 1999.

• Microsoft Windows 2000 Software Help and printed manuals. 

Related Documentation

Waters Licenses, Warranties, and Support: Provides software license and warranty 
information, describes training and extended support, and tells how Waters handles 
shipments, damages, claims, and returns.
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Printed Documentation

Waters Alliance GPC 2000 Series System Release Notes: A printed document that 
contains last-minute information about the product. Also provides supplementary 
information about specific Alliance GPC 2000 Series system software releases.

Styragel Column Care and User Manual for details on Styragel columns.

Ultrahydrogel Column Care and Use Manual for details on Ultrahydrogel columns.

HSPgel Columns for High Speed GPC Analysis Column Care and Use Manual for 
details on the HSPgel columns.

Online Documentation

Waters Alliance GPC 2000 Series System Help: A Help system that describes all system 
windows, menus, and dialog boxes. Also includes reference information and procedures 
for performing tasks using the system software. 

Documentation on the Web

Related product information and documentation can be found on the World Wide Web. 
Our address is http://www.waters.com.

D.2  Contacting Waters Technical Service

Customers in the USA and Canada should report diagnostic or parts replacement problems 
they cannot resolve to Waters Technical Service (800 252-2751). Others should phone 
their local Waters subsidiary or Waters corporate headquarters in Milford, Massachusetts 
(USA), or they may visit http://www.waters.com, and click Offices.

For complete information on reporting shipping damages and submitting claims, see 
Waters Safety Notices, Licenses, Warranties, and Support. 

You can correct many system problems using the information in Chapter 5 and the 
Troubleshooting Tables in the Alliance GPC 2000 Series System Help. If you cannot 
correct a condition for a Waters product, contact Waters Technical Service and have the 
following information available:

• Up-to-date normal operation log and test sample chromatogram for the method 

• Nature of symptom(s)

• Installed options and model, including presence or absence of a viscometer
214 Related Reference Material
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• System serial number (on the back of the system, or inside the sample 
compartment at the back-left bottom corner)

• Flow rate

• Operating pressure and temperature

• Solvent(s)

• Sizes of sample loop and syringe

• Types and serial numbers of columns

• Sample description

• Data system, including Empower software

• Non-Waters detection systems (if applicable)

• Version numbers of all software

• Initial survey of system problems

Capturing Service Data

If your local Waters service representative requires additional information, he or she may 
ask you to create and send a CD of your data files. GPC 2000 software includes a special 
utility called Capture Service Data that automatically captures the data files the service 
representative requires. When you run this utility, a folder is created on your desktop 
called “Service Diagnostic Data.” If a service personnel request data files, comply with the 
request by copying this folder onto a CD, and sending it to them for troubleshooting 
purposes.

Creating a Troubleshooting CD

1. Select Start > Programs > Gpc2000 Chromatography > Capture Service Data. 

The Capture Service Data window opens, displays a list of files that are being 
created, and closes automatically (Figure D-1). 
Contacting Waters Technical Service 215



Figure D-1  Capture Service Data

A desktop folder is automatically created called Service Diagnostic Data.

2. Open the solvent compartment door and insert a blank writable CD into the CD 
drive.

Note: Keep the solvent compartment door open. The CD drive opens automatically 
after CD replication.

3. To copy the folder to a CD, select Programs > Roxio CD Creator 5 > Applications > 
Easy CD Creator.

4. From the Select Source list, select Desktop, and then Service Diagnostic Data.

5. Click Add, and then click Record. The Record CD Setup dialog box appears.

6. Click Start Recording. The Record CD Progress dialog box appears and displays the 
progress of the CD data replication.

7. When the replication process is complete, click OK, and then close the Roxio Easy 
CD Creator window.

8. Remove the CD from the CD drive and close the solvent compartment door.
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Index

A
Accumulator piston

description  4, 6
maintaining  107
replacing  107, 137

Activated state, of event out signal  73
Agitate, sample mixing  79
AIA files  27
Alliance GPC 2000 Series system

Login window  63
priming and purging  83
software  3, 18
starting  62

Alliance GPCV 2000 Series system  1
Ambient temperature  37
Ambient vapor settings  78
Analog channel, configuring  71
Analog output signals  32, 55
Analysis compartment

cleaning  109
column capacity  11
configuring temperature ramp rate  67
description  32
door  48
identifying columns  69
temperature ramp rate  67
vapor sensor  34, 77, 78

Aqueous GPC separations  11
Aspirated sample  80
Aspiration

rate for samples  80
sample  8

Audio driver  18
Auto Pump Prime  88

Automatic pump priming. See Auto Pump 
Prime

Autozero
refractometer  12, 81

B
Backpressure

problems  170
system  4

Backup data  107, 143
Baseline

drift  157
noise  154, 157
stabilizing  96

Block instrument support  38
Blockages, flow path  164
Broad peaks  165
Buffers, removing  209
Button

bar  18
inner power  62
sample compartment door  92
stop flow  19

Bypass valve  8
Bypass valve, description  8

C
Cabling

correcting  155, 160, 162, 163
installing  53

Calculations
noise and drift  150
viscometry  16

Calibration
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system  108
viscometer  152

Capacity
columns  11
vial  91

Capping a vial  91
Carousel

capacity  90
description  7, 8
loading  93
temperature  79
vapor  78

Carousel mode  19
Carousel Temperature  79
Cavitation  205
CD-ROM drive  18
Certificate of Validation  40
Channel

analog  71
configuring  71
event input  72
event output  72
noise and drift  150
offset  71
scale  71

Check valve
description  4, 6
maintaining  107
replacing  107

Chromatograms, viewing  27
Chromatographic peaks, optimizing  160
Cleaning

analysis compartment  109
computer and monitor  110
drip tray  110
sample compartment  109
solvent compartment  110
system  108
waste container  108, 110

Clearances  37
Client/server systems  31
Collimating lens  12
Column

blockage  164, 165, 168, 169
contamination  155, 158
description  2
Diagnostics mode  23
holders  49
identifying  69
incorrect size or type  165
installing  47
maintaining  107
name  69
precautions  140
problems  141
Serial Number parameter  69
sizes  2
style parameter  69
use guidelines  140

Columns page  69
Communication panel  53
Compartments

locations  1
temperatures  79, 82

Computer
cleaning  110
drives  142
problems  180

Configuring
analog channels  71
electrical inputs and outputs  18
event input channels  72
event output channels  72
I/O card  70
injector  68
printer  65
sample loop size  68
solvent A  65
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Solvent management system  77
syringe size  68
temperature ramp rate of analysis 

compartment  67
Connecting

flow path components  43
peripheral devices  52
power  59
priming syringe  83
signal cables  52
waste tubing  46

Contacting Waters Technical Service  106, 
214

Controlling
flow rate  66, 77
maximum flow rate  66
mixer speed  79
refractometer  80
sample draw rate  80
temperature  79
temperature ramp rate  67
vapor sensors  78
viscometer  80

Conventions, documentation  xxiv
CPU problems  180
Creating

current instrument method  75
Sample Set  97
timed event list  73

Current instrument method  75
Current system status  64
Cycling equipment problems, correcting  

155, 156, 157, 160

D
Damage, inspecting for  39
Data management  107, 142
Data system  29
I

Degassing
inline degasser  6
selecting  67

Detection
description  10
refractometry  12
viscometry  15

Detector
autozeroing  12, 81
description  3
Diagnostics mode  23
light scattering  70
RI-specific problems  167
specifications  191
vapor settings  78
waste port  46

Detector page  80
Diagnostics

button  24
mode  19

Differential pressure transducers  15
Differential refractive index detector. See 

Refractometer
Dimensions, system  37
Disk drive  18
Dispensing

rate for samples  80
rate of solvent by syringe  68

Documentation conventions  xxiv
Double/shoulder peaks  165
Draw rate, syringe  69, 80
Drift

calculating  146, 150
Drip trays  35, 109, 110

E
Electromagnetic fields  38
Empower
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login  101
Empower software

description  29
logging in  101

Equilibrating
in Interactive mode  96
preparing for  62
system  96
time  103

Error messages  145, 183
Ethernet  18, 54
Event input channel

configuring  72
control signals  56

Event inputs and outputs  32
Event output channel

activated state  72
configuring  72
control signals  57
pulse width  73

Event Time dialog box  74
Event time, setting  74
Event type, selecting  72
Excess pressure, venting  12
Exhaust vent, connecting  41
External devices

configuring  70

F
Face seals, replacing  134
Files, backing up  142
Filter ram  8
Filter vials

assembling  91
components  90
replacing filter  107, 128

Filter/inject station  8
Filters  80

inline solvent  4, 7, 106, 129
pre-detector inline  107
solvent reservoir  44, 107, 130

Filtration rate  80
Flashing

status LED  62
Flat-topped peaks  166
Flow cell, refractometer  12
Flow path

flow cell  13
preparing  82
refractometer  13

Flow rate
limit  66
specifying  77
verifying  161

Fluid waste path  35, 109
Fluidic connections, making  43
Flushing

refractometer  12, 85
viscometer  86

Front view of system  2
Fronting peaks  166
Fume hood, system installation  34, 40

G
Gel permeation chromatography. See GPC
GPC

aqueous separation  11
description  1
purpose of manual  xv
software  3, 18, 29
solvents  1

GPC 2000 Node  63
Green status LED  62
Guidelines, column use  140
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H
Head Maintenance wizard  131
Head nut, removing  131
Heating, preparing for  62
High Pressure of solvent  67
High-temperature limits

carousel temperature  79
injector temperature  80, 82
inner sample compartment  80, 82
sample compartment  79

Humidity, relative  37

I
I/O card

analog out signal connections  56
configuring  70
description  18, 29, 32
event input signal connections  57
event output signal connections  58

I/O Card page  70
Immiscible solvents  205
Injection

data channel  143
per vial, problems  183
sample  9
volume  68

Injection valve
description  8
inject position  9
load position  8
problems  177
removing sample loop  127
replacing  128

Injector
configuring  68
high-temperature limit  80, 82
loop volume  68
I

low-temperature limit  80, 82
purging  84
temperature setpoint  82

Injector needle temperature  80
Inlet face seals, replacing  134
Inline degasser  4
Inline filter

blockage  164, 165, 168, 169
replacing  129

Inner power button  62
Inner sample compartment

high-temperature limit  80, 82
low-temperature limit  80, 82
temperature setpoint  82

Inspecting, shipping damage  39
Installation requirements  37
Installing

columns  47
keyboard  52
monitor  52
mouse  52
piston seal-wash option  51
printer driver  65
reserve bottle of solvent  44
tubing  46
vials  95
waste container  46

Instrument Configuration Editor  19
Instrument method  8, 75

modifying  76
Instrument Method Editor  75
Instrument support block  38
Intended use  xv
Interactive mode  64

description  18, 64
equilibrating  96

Invert channel  81
Invert Channel, setting  81
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J
J tube, removing  133

K
Keyboard, installing  52
Kits

maintenance  201
startup  201
ventilation option  201

L
Leaks

drip tray  178
piston head  170
troubleshooting  159
waste tubing  178

LED, refractometer light source  12
Left side panel

installing  47
removing  46

Light scattering detector
enabling  70

Light scattering parameters  80
Limit ramp rate  66
Loading

carousel  92
samples  8, 92

Log Book button  19
Login

Empower  101
GPC 2000 Series System  63

Long-term cyclic noise  155
Loop. See  Sample loop
Low Limit

carousel temperature  79
injector temperature  80, 82

inner sample compartment  80, 82
sample compartment  79

Low pressure of solvent  67
Low-pressure condition, stop monitoring  67

M
Maintenance

check valves  107
data management  107
frequency  106
pistons  107
required materials  105
safety and handling  105
sample needle  107
seal-wash seals  107
syringe and seal  107
wizards  24

Making
fluidic connections  42
power connections  59
signal connections  52

Manual Prime  83
Manual Priming wizard  83
Message Board  19, 26, 149
Messages  145
Method, instrument  75
Minimum sample volume  190
Miscibility

numbers  206
of solvents  205

Mix parameters  79
Mix/spin station  8
Mixer  79
M-numbers  206
Mobile phase

flushing with  209
incorrect  162
stabilizer  159
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Mobile phase A, configuring  65
Modifying

instrument method  76
sample set  100

Molecular weight, distribution  1
Monitor

cleaning  110
installing  52
powering on  62
problems  181

Monitoring
low-pressure condition  67
operating parameters  67, 78
pressure  67
vapor sensor readings  78

Mouse, installing  52
Multicapillary viscometer. See Viscometer
Multicapillary viscometry detector. See 

Viscometer

N
Needle Maintenance wizard  121
Needle wash

description  10
station  8
volume  46

Needle wash volume  80
Needle, replacing  119
Needle, vent  8
Negative peaks

invert channel  81
problems  166

Networking  3, 54
Noise

baseline  150
cyclic baseline  155
noncyclic baseline  154
refractometer baseline  152
I

viscometer baseline  152
Noise and Drift test  150
Noise spikes  159

O
Online Help  214
Opening

sample compartment door  93
Operating

Max Flow rate  66
system  3

Operating modes
Carousel  19
Diagnostics  19
Interactive  18
Sample Set  18
Viewer  19

Options, seal wash  67
Organic separations  11
Other solvents, using  82
Outlet face seals, replacing  134
Overheating

preventing  82
OverTemp test  151

P
Peak shape (no/abnormal)

broad (all peaks)  165
double/shoulder  165
flat-topped  166
fronting  166
negative (all peaks)  166
negative (one or more)  167
tailing  166

Peripheral devices
installing  52
powering on  62
Index 223



Photodiode, dual-element  12
Piston

assembly, removing  131
description  4
head, reinstalling  137
seal wash  51
seal, replacing  107, 134
seal-wash seal, replacing  135

Poiseuille’s law  16
Polymer chemists  xv
Power

button, inner  62
cord  59
outlet  59
requirements  38

Powering on
problems  181
procedure  62

Precautions for columns  140
Pre-detector inline filter, maintaining  107
Preparing

flow path  82, 83
for heating  62
for operation  61

Pressure
high pressure shutdown limit  67
low pressure shutdown limit  67
shutdown limits  67
transducers  15

Pressure relief valve  12
Primary piston

description  4, 6
maintaining  107
replacing  107, 137

Primary transducer  4, 7
Priming

description  4
seal wash  89
system  83

Priming syringe
connecting to purge valve  83
description  4

Printer driver, installing  65
Printer, configuring  65
Processor, description  18
Pulse width  73, 74
Pump priming  83
Purge valve

description  4, 7, 12
priming the system  83
problems  169

Purging
buffered mobile phase  209
injector  84
purge valve  4
refractometer  85
viscometer  86

R
Ram, filter  8
Ramp rate

flow  66
temperature  67

Ramp rate limit, temperature  67
Rate

flow  77
syringe draw  80

Red status LED  62, 64
Refractive index  12, 13
Refractometer

autozeroing  12, 81
description  1, 3, 10, 12
inverting channel  81
normal operation  13
parameters  80
problems  179
purging  12, 13, 14, 85
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specifications  191
troubleshooting  179

Relative humidity  37
Relative vapor reading  78, 114
Release Notes, description  214
Remote Alliance GPC 2000 Series system  

63
Removing

buffers  209
head nut and piston assembly  131
left side panel  46
pump head  131
vials  95

Replacing
accumulator piston  107
check valves  107
face seals  134
filter in sample filter vial  107, 128
inlet and outlet face seals  134
piston seals  107, 134
piston seal-wash seal  135
pistons  107, 137
pre-detector inline filter  107
primary piston  107
pump head seals  134
reservoir filters  130
sample loop  107, 126
sample needle  107, 119
seal-wash assembly  136
seal-wash seals  107
solvent inline filter  106, 129
solvent reservoir filter  107, 130
syringe  68
syringe and syringe seal  107
tube seals  135
tubing  107, 140
vapor sensors  112
vial filter  128

Requirements
I

installation  37
site  37

Reserve solvent, installing  44
Reservoir, solvent  205
Revising a sample set  100
RI. See Refractive index
Routine operating tasks  108, 116
Rumble strips, carousel  94
Running a sample set  100

S
Sample

aspirated  80
aspiration  8
degradation  162
disposing  80
filtering  7
heating  7
injecting  7, 9
loading  8
minimum volume  190
mixing  7
return to vial  80
RI difference  167
send to waste  80
spinning  7
viscosity  163
withdrawal  8

Sample carousel  7
Sample compartment

cleaning  109
components  8
description  7, 32
door  93
high-temperature limit  79
low-temperature limit  79
temperature setpoint  79
temperatures  79
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tray  94
vapor sensor  34, 77, 78

Sample compartment (inner), temperature  
80, 82

Sample compartment door
button, flashing  92
closing  95
description  8
opening  93

Sample draw rate  80
Sample drawing problems  177
Sample filter vial

assembling  91
replacing filter  107, 128

Sample loop
configuring  68
description  8
incorrect size  162
maintaining  107
replacing  126

Sample management system
description  2, 7
Diagnostics mode  23
purging  84
troubleshooting  171

Sample Manager tab  79
Sample needle

description  8
maintaining  107
problem  173, 174, 175
replacing  107, 119

Sample overfill loop  8
Sample set

contents  97
creating  97
method table  22
modifying  100
operations buttons  22
table  97

Sample Set Method Editor  19
Sample Set mode, description  18
Sample Set Mover  19, 101
Sample Set wizard  97
Sample vial

capacity  91
installing/removing  95
pre-injection options  8
sealing  91

Sealing sample vials  91
Seal-wash

description  5
priming  89
seals, replacing  107, 135
selecting  67
solvent  5
solvent, changing  108, 117

Selecting options
degassing  67
seal wash  67
solvent  4

Sending event output signals  57
Separation, description  10
Serial number

columns  69
system  40

Service Diagnostics  24
Setpoint temperature

carousel  79
injector  82
inner sample compartment  82
sample compartment  79

Setting
ambient vapor sensor  78
analysis compartment vapor sensor  78
carousel temperature  79
carousel vapor sensor  78
channel inversion  81
column temperature  82
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detector vapor sensor  78
injector temperature  80
inner sample compartment temperature  

80, 82
light scattering parameters  80
refractometer autozeroing  81
refractometer parameters  80
sample compartment  79
sample compartment vapor sensor  78
viscometer parameters  80

Short-term cyclic noise  155
Shutdown limit, vapor sensors  78
Shutting down the system  103
Side panel, left  46
Signal connections, making  52
Site requirements  37
Sizes

columns  2, 197
sample loop  194
syringe  68, 194
system dimensions  37

Slew rate  183
Solvent

blending problems  156
buffered  209
changing  88
configuring  65
filters  4, 44, 107, 129, 204
flow path  4, 5
grade  44
guidelines  203
HPLC-grade  43
miscibility  156, 205
preparation  44
quality  43
removing buffers  209
select valve  4
selecting  4, 77
stabilizer  159
I

venting  4
viscosity  208

Solvent compartment
cleaning  110
description  3
vapor sensor  34, 77

Solvent inline filter
description  4, 7
replacing  106, 129

Solvent management system
components  3
configuring  77
description  2
Diagnostics mode  23
flow path  5
functions  4
maintaining  132

Solvent Manager page  77
Solvent manager. See Solvent management 

system
Solvent mixer  79
Solvent name, selecting  82
Solvent reservoir filter

installing  44
replacing  107, 130

Solvent reservoirs, refilling  108
Solvent select valve  4
Solvent source, selecting  77
Solvent stabilizer  159
Solvent tubing, connecting  43
Solvents, identifying other  82
Spare parts  193
Specifications

detectors  191
electrical  187
physical  186
refractometer  191
sample management system  189
solvent management system  188
Index 227



viscometer  191
Speed, of aspiration/dispensing samples  80
Spill control  35, 109
Stabilizers, solvent  159
Start at line number (sample set)  101
Starting up  62
Static electricity  38
Status

indicator on screen  64
sample compartment door  92

Stop Flow button  19
Storage media, removeable  142
Styragel columns  2, 11, 197
Syringe

configuring  68
dispense rate  68
draw rate  69
function  8
home position  10
priming  4, 83
problems  170
replacing  68, 107
sample draw rate during sample 

aspiration  80
volume  68

syringe
specifying sample draw rate  80

Syringe draw rate  80
Syringe seal, replacing  107
Syringe solvent draw rate  69
System

cleaning  108
clearance  37
compartments  1
components  2
connecting to network  54
control  3
equilibration  96
front view  1

operating flowchart  61
preparing for operation  61
pressure transducer  7
priming the solvent management  83
shutdown  103
size  37
software  3
starting up  62
temperature control test  151
transducer  4

T
Tailing peaks  166
TCB  211
Technical Service, contacting  106, 214
Temperature

ambient  37
carousel  79
fluctuations, correcting  157, 158, 159, 

165
hardware limit check  34
injector needle  80
ramp rate limit  67
ramp rate, configuring  67
slew rate  183
software limit check  34
solvent effects on  33
system control  151
thermal fuse limit  34

Tests
noise and drift  150
OverTemp  151
temperature control  151

Thermal
monitoring  1
ramp rate limit  67
setpoint  79, 80, 82
stability  103
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Timed events  73
Transducer

primary  4
system  4

Tray, carousel  94
Trichlorobenzene. See TCB
Troubleshooting

assumptions  145
refractometer  179
sample management system  171
solvent management system  168
tables  154, 155, 157, 159, 160
viscometer  179

Tube seals, replacing  135
Tubing

connecting  42
correcting blockage  165
maintaining  107
replacing  140

U
Ultrahydrogel columns  2, 11, 199
Universal calibration techniques  1
USB port  18
User interface problems  180
User Maintenance and Service Diagnostics 

dialog box  24, 120, 131

V
Validation certification  40
Valve

bypass  8
check  4, 107
inject position  9
injection  8
purge  4, 83
solvent select  77
I

Vapor
detection  34, 77
sensors  1, 34, 77
venting  34

Vapor sensors
ambient air  78
analysis compartment  78
disabling  78
enabling  78
reading current level  78, 114
replacing  112
sample compartment  78
shutdown limit  78
verifying  114
warning limit  78

Vent gate  41
Vent needle  8
Ventilation  34, 37, 77
Ventilation Kit  202
Venting solvent  4
Venting waste container  47
Vial

capacities  91
caps  91
filter  91
holder  91
minimum sample volume  190
problems  171
sample  8, 91, 95
sample filter, replacing filter  107, 128
types  90

Video driver  18
Viewer window  19, 27, 29
Viscometer

calculations  16
description  1, 10, 15
Detector page  81
parameters  80
problems  179
Index 229



purging  86
specifications  191

Viscometer Purge dialog box  86
Viscosity, solvent  179
Visual inspection  145
Volume

minimum per vial  190
needle wash  80

W
Warning limit, vapor sensors  78
Wash station  8
Waste container

emptying and cleaning  108
installing  46

Waste ports  46
Waters Technical Service  106, 214
Withdrawal, sample  8
Wizards

Head Maintenance  131
Manual Pump Prime  83
Needle Maintenance  121
Sample Set  97

Y
Yellow status LED  62
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